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     [bookmark: pgfId-1068115]Preface 
      
      
 
     
 
 
    [bookmark: pgfId-1068116]Cisco Security Manager (Security Manager) enables you to manage security policies on Cisco devices in large, medium, or small networks. You can use shareable objects and policies in Security Manager to manage thousands of devices or only a few. Security Manager also supports multiple configuration views that are optimized for different use cases, supports the provisioning of many platform-specific settings, and provides device grouping capabilities. 
 
    [bookmark: pgfId-1036426]This guide does the following:
 
     
     	 [bookmark: pgfId-1027695]Lists hardware and software requirements for installing Security Manager and its related applications.
 
     	 [bookmark: pgfId-1027989]Explains important concepts about the software applications that you select for installation and the environment in which you install them.
 
     	 [bookmark: pgfId-1027702]Provides instructions for installing Security Manager server and Auto Update Server and for installing dedicated client software for Security Manager.
 
     	 [bookmark: pgfId-1027724]Describes what you must do after installation so that you can use your newly installed applications successfully.
 
     	 [bookmark: pgfId-1027982]Guides you in understanding and troubleshooting problems that might occur during, or as a result of, installation.
 
    
 
    [bookmark: pgfId-1021146]
 
     
      
    
 
    
 
    [bookmark: pgfId-1059822]Note Before you install the applications, we recommend that — for the most recent information — you read the release notes on Cisco.com that are most relevant to the actual software components you choose to install. The release notes might contain corrections or additions to this guide or provide other information that affects planning, preparation, installation, or deployment. See Product Documentation.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1010898]Audience
 
     [bookmark: pgfId-1010564]This document is for network and security personnel who install, configure, deploy, and manage security infrastructure.
 
    
 
     
      [bookmark: pgfId-1010567][bookmark: marker-1060177]Conventions
 
     [bookmark: pgfId-1010572]This document uses the following conventions:
 
     [bookmark: pgfId-1010610]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1051207]Item 
          
  
         	 
           
           [bookmark: pgfId-1051209]Convention 
          
  
        
 
         
         	[bookmark: pgfId-1051211]Commands and keywords
  
         	[bookmark: pgfId-1051213]boldface font
  
        
 
         
         	[bookmark: pgfId-1051215]Variables for which you supply values
  
         	[bookmark: pgfId-1051217]italic font
  
        
 
         
         	[bookmark: pgfId-1051219]Displayed session and system information
  
         	 
           
           [bookmark: pgfId-1051221] 
            screen font 
          
  
        
 
         
         	[bookmark: pgfId-1051223]Information you enter
  
         	 
           
           [bookmark: pgfId-1051225] 
            boldface screen font 
          
  
        
 
         
         	[bookmark: pgfId-1051227]Variables you enter
  
         	 
           
           [bookmark: pgfId-1051229] 
            italic screen  font 
          
  
        
 
         
         	[bookmark: pgfId-1051231]Menu items and button names
  
         	[bookmark: pgfId-1051233]boldface font
  
        
 
         
         	[bookmark: pgfId-1051235]Selecting a menu item in paragraphs
  
         	[bookmark: pgfId-1051237]Option > Network Preferences
  
        
 
         
         	[bookmark: pgfId-1051239]Selecting a menu item in tables
  
         	[bookmark: pgfId-1051241]Option > Network Preferences
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1010611]Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the publication. 
 
      
      
 
     
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1010614] 
      Caution Means 
      reader be careful. In this situation, you might do something that could result in equipment damage or loss of data. 
       
       
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1020587]Tip Means the following information will help you solve a problem. The tips information might not be troubleshooting or even an action, but could be useful information, similar to a Timesaver.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1041404][bookmark: 11818]Product Documentation
 
     [bookmark: pgfId-1062831]Cisco documentation and additional literature are available on Cisco.com. Table 1 describes available documentation for Cisco Security Manager and Auto Update Server in the reading order that we recommend.
 
     [bookmark: pgfId-1066632]
 
      
       
        
        [bookmark: pgfId-1066593]Table 1 [bookmark: 63999]Security Manager Documentation 
 
        
        
         
         	 
           
           [bookmark: pgfId-1066597]Document Title 
          
  
         	 
           
           [bookmark: pgfId-1066599]Available Formats 
          
  
        
 
         
         	[bookmark: pgfId-1066601]Release Notes for Cisco Security Manager
 [bookmark: pgfId-1066602]Also covers Auto Update Server.
  
         	[bookmark: pgfId-1066605]http://www.cisco.com/c/en/us/support/security/security-manager/products-release-notes-list.html
  
        
 
         
         	[bookmark: pgfId-1066607]Supported Devices and Software Versions for Cisco Security Manager
 [bookmark: pgfId-1066608]Includes support information for Auto Update Server.
  
         	[bookmark: pgfId-1066611]http://www.cisco.com/c/en/us/support/security/security-manager/products-device-support-tables-list.html
  
        
 
         
         	[bookmark: pgfId-1066613]Installation Guide for Cisco Security Manager
 [bookmark: pgfId-1066614](This guide)
  
         	[bookmark: pgfId-1066617]http://www.cisco.com/c/en/us/support/security/security-manager/products-installation-guides-list.html
  
        
 
         
         	[bookmark: pgfId-1066619]User Guide for Cisco Security Manager
  
         	[bookmark: pgfId-1066622]http://www.cisco.com/c/en/us/support/security/security-manager/products-user-guide-list.html
  
        
 
         
         	[bookmark: pgfId-1066624]User Guide for Auto Update Server
  
         	[bookmark: pgfId-1066627]http://www.cisco.com/c/en/us/support/security/security-manager/products-user-guide-list.html
  
        
 
         
         	[bookmark: pgfId-1066629]Context-sensitive online help
  
         	[bookmark: pgfId-1066631]Select an option in the GUI, then click Help.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1069435][bookmark: 86594][bookmark: 74565]Obtain Documentation and Submit a Service Request
 
     [bookmark: pgfId-1069436]For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service request, and gathering additional information, see What’s New in Cisco Product Documentation.
 
     [bookmark: pgfId-1069438]Toreceivenew and revised Ciscotechnical content directly to your desktop, you can subscribeto theWhat’s New in Cisco Product DocumentationRSS feed. The RSS feeds are a free service.
 
    
 
     
      [bookmark: pgfId-1069387]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1084098][bookmark: 26110][bookmark: marker-1084111]Overview 
      
      
 
     
 
 
    [bookmark: pgfId-1047791]This chapter contains the following sections:
 
     
     	 [bookmark: pgfId-1036925]Introduction to Component Applications
 
     	 [bookmark: pgfId-1079050]Introduction to Related Applications
 
    
 
   
 
    
     [bookmark: pgfId-1075341][bookmark: 27203]Introduction to Component Applications[bookmark: marker-1084043]
 
    [bookmark: pgfId-1039918]The Security Manager installer enables you to install certain applications and, when you do, requires that you install certain other applications. This section describes those applications and their interdependencies:
 
     
     	 [bookmark: pgfId-1050037]Common Services
 
     	 [bookmark: pgfId-1050158]Security Manager
 
     	 [bookmark: pgfId-1043576]Auto Update Server
 
    
 
     
      [bookmark: pgfId-1075917][bookmark: marker-1084048][bookmark: 89191]Common Services
 
     [bookmark: pgfId-1075947][bookmark: marker-1084053]Common Services 4.2.2 is bundled by default with Security Manager 4.9.
 
     [bookmark: pgfId-1075992]Common Services provides the framework for data storage, login, user role definitions, access privileges, security protocols, and navigation. It also provides the framework for installation, data management, event and message handling, and job and process management. Common Services supplies essential server-side components to Security Manager that include the following:
 
      
      	 [bookmark: pgfId-1075993]SSL libraries
 
      	 [bookmark: pgfId-1075994]An embedded SQL database
 
      	 [bookmark: pgfId-1075995]The Apache webserver
 
      	 [bookmark: pgfId-1075996]The Tomcat servlet engine
 
      	 [bookmark: pgfId-1075997]The CiscoWorks home page
 
      	 [bookmark: pgfId-1075998]Backup and restore functions
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1088817]Note Device and Credential Repository (DCR) functionality within Common Services is not supported in Security Manager 4.9. The Groups tab is also removed from the Common Services page in Security Manager 4.9.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1076072][bookmark: marker-1084067][bookmark: marker-1084071][bookmark: 39927]Security Manager
 
     [bookmark: pgfId-1076122]Cisco Security Manager is an enterprise-class management application designed to configure firewall, VPN, and intrusion prevention system (IPS) security services on Cisco network and security devices. Cisco Security Manager can be used in networks of all sizes—from small networks to large networks consisting of thousands of devices—by using policy-based management techniques. Cisco Security Manager works in conjunction with the Cisco Security Monitoring, Analysis, and Response System (MARS). Used together, these two products provide a comprehensive security management solution that addresses configuration management, security monitoring, analysis, and mitigation.
 . 
     
 
     [bookmark: pgfId-1076139]To use Security Manager, you must install server and client software. 
 
     [bookmark: pgfId-1076140]Security Manager offers the following features and capabilities:
 
      
      	 [bookmark: pgfId-1076141]Service-level and device-level provisioning of VPN, firewall, and intrusion prevention systems from one desktop
 
      	 [bookmark: pgfId-1076142]Device configuration rollback
 
      	 [bookmark: pgfId-1076143]Network visualization in the form of topology maps
 
      	 [bookmark: pgfId-1076144]Workflow mode
 
      	 [bookmark: pgfId-1076145]Predefined and user-defined FlexConfig service templates
 
      	 [bookmark: pgfId-1076146]Integrated inventory, credentials, grouping, and shared policy objects
 
      	 [bookmark: pgfId-1076147]Convenient cross-launch access to related applications: 
 
     
 
     [bookmark: pgfId-1082509] – When you install the server software, you also install read-only versions of the following device managers: Adaptive Security Device Manager (ASDM), PIX Device Manager (PDM), Security Device Manager (SDM), and IPS Device Manager (IDM)
 
     [bookmark: pgfId-1089920] – When you install the server software, you also install a cross-launch point to (but not actual installation of) Cisco Prime Security Manager. 
 
     [bookmark: pgfId-1081052] – You can add ASA and PIX devices from Security Manager to Auto Update Server (AUS).
 
      
      	 [bookmark: pgfId-1082536]Integrated monitoring of events generated by ASA and IPS devices. You can selectively monitor, view, and examine events from ASA and IPS devices by using the Event Viewer feature. 
 
     
 
    
 
     
      [bookmark: pgfId-1081055][bookmark: marker-1084123][bookmark: 41003]Auto Update Server
 
     [bookmark: pgfId-1076207]If you choose to install AUS, you can install it on the same server where you install Security Manager or on a different server, such as a server in your DMZ. AUS and Security Manager can share device inventory information and other data. AUS uses a browser-based user interface and requires Common Services.
 
     [bookmark: pgfId-1076208]AUS enables you to upgrade device configuration files and software images on PIX Security Appliance (PIX) and Adaptive Security Appliance (ASA) devices that use the auto update feature. AUS supports a pull model of configuration that you can use for device configuration, configuration updates, device OS updates, and periodic configuration verification. In addition, supported devices that use dynamic IP addresses in combination with the Auto Update feature can use AUS to upgrade their configuration files and pass device and status information.
 
     [bookmark: pgfId-1076209]AUS increases the scalability of your remote security networks, reduces the costs involved in maintaining a remote security network, and enables you to manage dynamically addressed remote firewalls.
 
     [bookmark: pgfId-1076210]For more information about AUS you can refer to the AUS documentation located at the Security Manager site: http://www.cisco.com/go/csmanager. 
 
    
 
   
 
    
     [bookmark: pgfId-1086058][bookmark: marker-1084138][bookmark: 60605][bookmark: 52372][bookmark: 37460]Introduction to Related Applications[bookmark: marker-1086057]
 
    [bookmark: pgfId-1075826]Other applications are available from Cisco that integrate with Security Manager to provide additional features and benefits: 
 
     
     	 [bookmark: pgfId-1076609] Cisco Security Monitoring Analysis and Response System (MARS) —Security Manager supports cross linkages between policies and events with MARS for firewall and IPS. Using the Security Manager client you highlight specific firewall rules or IPS signatures and request to see the events related to those rules or signatures. Using MARS you can select firewall or IPS events and request to see the matching rule or signature in Security Manager. These policy-event cross-linkages are especially useful for network connectivity troubleshooting, identifying unused rules, and signature tuning activities. The policy-event cross-linkage feature is explained in detail in the  User Guide for Cisco Security Manager . For more information about MARS you can visit  http://www.cisco.com/go/mars . 
 
     	 [bookmark: pgfId-1076665] Cisco Secure Access Control System (ACS) —You can optionally configure Security Manager to use ACS for authentication and authorization of Security Manager users. ACS supports defining custom user profiles for fine-grained role based authorization control and ability to restrict users to specific sets of devices. For details on configuring Security Manager and ACS integration, see Integrating Security Manager with Cisco Secure ACS. For more information about ACS, visit  http://www.cisco.com/go/acs .
 
     	 [bookmark: pgfId-1076774] Cisco Configuration Engine —Security Manager supports the use of the Cisco Configuration Engine as a mechanism for deploying device configurations. Security Manager deploys the delta configuration file to the Cisco Configuration Engine, where it is stored for later retrieval from the device. Devices such as Cisco IOS routers, PIX Firewalls, and ASA devices that use a Dynamic Host Configuration Protocol (DHCP) server, contact the Cisco Configuration Engine for configuration (and image) updates. You can also use Security Manager with Configuration Engine to manage devices that have static IP addresses. When using static IP addresses, you can discover the device from the network and then deploy configurations through Configuration Engine. For information about the Configuration Engine releases you can use with Security Manager, see the release notes for this version of the product at  http://www.cisco.com/c/en/us/support/security/security-manager/products-release-notes-list.html . For more information about the Configuration Engine, visit  http://www.cisco.com/c/en/us/products/cloud-systems-management/configuration-engine/index.html . 
 
    
 
   
 
    
     [bookmark: pgfId-1082142][bookmark: 26264]Effect of Enabling Event Management
 
    [bookmark: pgfId-1082155]If you enable Event Management on your Security Manager server, you cannot use that server for the following services: 
 
     
     	 [bookmark: pgfId-1082235]Syslog on CiscoWorks Common Services 
 
    
 
    [bookmark: pgfId-1083086]During the installation or upgrade of Security Manager, the Common Services syslog service port is changed from 514 to 49514. Later, if Security Manager is uninstalled, the port is not reverted to 514. Additional information regarding ports is available in Table 3-1 and in Table A-1. 
 
    [bookmark: pgfId-1083093]If the amount of RAM available to the operating system is insufficient, Event Viewer is disabled (see details in Table 3-3); however, the Common Services syslog service port is still changed.
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1099987][bookmark: 26110][bookmark: marker-1099986]Licensing for Security Manager 
      
      
 
     
 
 
    [bookmark: pgfId-1099988]With the information in this chapter, you can determine which license you need to install and use Cisco Security Manager 4.9. This chapter also has descriptions of the various licenses available, such as standard, professional, and evaluation. 
 
    [bookmark: pgfId-1091048]Other than a few notes, this chapter does not discuss license installation. Refer to Chapter 5, “Installing and Upgrading Server Applications” 
 
    [bookmark: pgfId-1096886]This chapter discusses device count, with the purpose of helping you determine which Security Manager server license you need. 
 
   
 
    
     [bookmark: pgfId-1112756][bookmark: 12697]License Types
 
    [bookmark: pgfId-1112757]The Cisco Security Manager has two base license types, Standard and Professional. Apart from the base licenses, Cisco Security Manager offers:
 
     
     	 [bookmark: pgfId-1116111]Base Licenses (Standard and Professional)
 
     	 [bookmark: pgfId-1117336]Standard-to-Professional Upgrade License
 
     	 [bookmark: pgfId-1116115]Incremental (“Add-on”) Licenses
 
     	 [bookmark: pgfId-1116355]API License
 
    
 
     
      [bookmark: pgfId-1116360][bookmark: 91878]Base Licenses (Standard and Professional)
 
     [bookmark: pgfId-1112818]Table 2-1 displays the list of the Standard and Professional base licenses available for Cisco Security Manager 4.9. 
 
      
       
        
        [bookmark: pgfId-1112768]Table 2-1 [bookmark: 77023]List of the Base Licenses Available 
 
        
        
         
         	 
           
           [bookmark: pgfId-1112774]License Name 
          
  
         	 
           
           [bookmark: pgfId-1112776]License Abbreviation 
          
  
         	 
           
           [bookmark: pgfId-1112778]Number of Devices that can be Managed (Refer to 
           Understanding Device Count for Purchasing License) 
          
  
        
 
         
         	[bookmark: pgfId-1112783]Standard-5
  
         	[bookmark: pgfId-1112785]ST5
  
         	[bookmark: pgfId-1112787]5
  
        
 
         
         	[bookmark: pgfId-1112789]Standard-10
  
         	[bookmark: pgfId-1112791]ST10
  
         	[bookmark: pgfId-1112793]10
  
        
 
         
         	[bookmark: pgfId-1112795]Standard-25
  
         	[bookmark: pgfId-1112797]ST25
  
         	[bookmark: pgfId-1112799]25
  
        
 
         
         	[bookmark: pgfId-1112801]Professional-50
  
         	[bookmark: pgfId-1112803]PRO50
  
         	[bookmark: pgfId-1112805]50
  
        
 
         
         	[bookmark: pgfId-1112807]Professional-100
  
         	[bookmark: pgfId-1112809]PRO100
  
         	[bookmark: pgfId-1112811]100
  
        
 
         
         	[bookmark: pgfId-1112813]Professional-250
  
         	[bookmark: pgfId-1112815]PRO250
  
         	[bookmark: pgfId-1112817]250
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1112822]Table 2-2 provides a comparison of Professional base versions with Standard base versions.
 
      
       
        
        [bookmark: pgfId-1112829]Table 2-2 [bookmark: 31374]Comparison of Professional Base Versions with Standard Base Versions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1112835]Feature 
          
  
         	 
           
           [bookmark: pgfId-1112837]Supported in Professional? 
          
  
         	 
           
           [bookmark: pgfId-1112839]Supported in Standard? 
          
  
        
 
         
         	[bookmark: pgfId-1112841]Support of incremental (“add-on”) device license packages in increments of 50, 100, and 250 devices
  
         	[bookmark: pgfId-1112843]Yes
  
         	[bookmark: pgfId-1112845]No
  
        
 
         
         	[bookmark: pgfId-1112847]Support for the management of Cisco Catalyst 6500 and 7600 Series switches and associated services modules
  
         	[bookmark: pgfId-1112849]Yes
  
         	[bookmark: pgfId-1112851]No
  
        
 
         
         	[bookmark: pgfId-1112853]Support for the management of firewall service modules
  
         	[bookmark: pgfId-1112855]Yes
  
         	[bookmark: pgfId-1112857]No
  
        
 
         
         	[bookmark: pgfId-1112859]Support for temporary licenses (licenses with an expiration date)
  
         	[bookmark: pgfId-1112861]Yes
  
         	[bookmark: pgfId-1112863]No (only permanent licenses are supported)
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1112865]To obtain a base license, you must have (or obtain) a Cisco.com user ID, and you must register your copy of the software on Cisco.com. When registering, you must provide the [bookmark: marker-1112866]Product Authorization Key (PAK) that is attached to the [bookmark: marker-1112867]Software License Claim Certificate inside the shipped software package: 
 
      
      	 [bookmark: pgfId-1112869]If you are a registered Cisco.com user, start at  http://www.cisco.com/go/license.  
 
      	 [bookmark: pgfId-1112871]If you are not a registered Cisco.com user, start at  http://tools.cisco.com/RPF/register/register.do.  
 
     
 
     [bookmark: pgfId-1112872]You must register Security Manager as soon as you can within the first 90 days and for the number of devices that you need to ensure uninterrupted use of the product. Each time you start the application, you are reminded of how many days remain on your evaluation license and you are prompted to upgrade during the evaluation period. At the end of the evaluation period, you cannot log in until you upgrade your license. 
 
     [bookmark: pgfId-1112873]After registration, the base software license is sent to the email address that you provided during registration. Keep the license in a secure location. 
 
    
 
     
      [bookmark: pgfId-1115050][bookmark: 21021]Standard-to-Professional Upgrade License 
 
     [bookmark: pgfId-1117507]When your needs have outgrown the capabilities of the Standard license, such as, to manage Catalyst security blades or when deployment grows beyond 25 devices, you need to upgrade to Cisco Security Manager Professional. You can purchase the Standard-to-Professional upgrade license. However, this upgrade license can be applied only if the base license is a Standard-25 (“ST25”) license. The orderable part ID (PID) for the Standard-to-Professional upgrade license is CSMSTPR-U-4.x-K9.
 
    
 
     
      [bookmark: pgfId-1115052][bookmark: 96185]Incremental (“Add-on”) Licenses 
 
     [bookmark: pgfId-1115053]If your base license is a Professional version (not a Standard version or the evaluation version), you can purchase incremental (“add-on”) licenses to increase the number of devices that you are allowed to manage. You can purchase as many incremental licenses as you wish. 
 
     [bookmark: pgfId-1115054]Incremental (“add-on”) licenses for previous versions are valid for the current version. For example, if you have a Professional-50 license for Security Manager 4.4, you can use a 4.3 incremental device license. 
 
     [bookmark: pgfId-1115055]Incremental licenses are available in increments of 50, 100, and 250 devices. 
 
    
 
     
      [bookmark: pgfId-1117430][bookmark: 26778]API License
 
     [bookmark: pgfId-1117431]Cisco Partners who want to use the API need to have an API license. There are two kinds of API licenses:
 
      
      	 [bookmark: pgfId-1117432]A developer license. This is a 90-day license that is to be used by developers to integrate their products with Security Manager. 
 
      	 [bookmark: pgfId-1117433]A production license. This license is required by the end customers who use certain third-party products. 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1117434]Note There is no API evaluation license. Both the developer license and the production license need to be ordered explicitly by Cisco Partners who want to use the API. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1117435]The orderable part ID (PID) for the Northbound API license is L-CSMPR-API.
 
    
 
     
      [bookmark: pgfId-1117650]Licensing and Deployment Scenarios 
 
    
 
     
      [bookmark: pgfId-1117651]Active/Active 
 
     [bookmark: pgfId-1117652]You are required to purchase two licenses of Cisco Security Manager in Active/Active setup.
 
    
 
     
      [bookmark: pgfId-1117653]Active and Standby 
 
     [bookmark: pgfId-1117654]A Cisco Security Manager license allows the use of Cisco Security Manager on a single server. A standby Cisco Security Manager server, such as one used in a high-availability or disaster recovery configuration, does not require a separate license if only one server is active at any one time. This is true even when high availability (HA) configuration is being used. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1117655]Note Users who use a standby server are responsible for manually restoring the database from their active server on a regular basis.
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1115060][bookmark: 80911]Licenses for Component Applications
 
    [bookmark: pgfId-1115061]Some component applications do not require a license file: 
 
     
     	 [bookmark: pgfId-1115063][bookmark: marker-1115062]Common Services. 
 
     	 [bookmark: pgfId-1115065][bookmark: marker-1115064]Auto Update Server. 
 
    
 
   
 
    
     [bookmark: pgfId-1113361][bookmark: 22190]Understanding Device Count for Purchasing License
 
    [bookmark: pgfId-1113362]Security Manager consumes one device count (of the number allowed by the license) when you add any of the following to the device inventory:
 
     
     	 [bookmark: pgfId-1113363]Each physical device
 
     	 [bookmark: pgfId-1113364]Each security context
 
     	 [bookmark: pgfId-1113365]Each added Cisco Catalyst 6500 Series services module
 
     	 [bookmark: pgfId-1113366]Each virtual sensor
 
    
 
    [bookmark: pgfId-1113367]Advanced Inspection and Prevention Security Services Modules (AIP-SSMs), IDS Network Modules, IPS Advanced Integration Modules (IPS AIM), and any other modules supported for devices other than the AIP-SSC 5 and the Catalyst 6500 or 7600 installed in the host device do not consume a device count; however, additional virtual sensors (added after the first sensor) do consume a device count. 
 
    [bookmark: pgfId-1113368]In the case of a Firewall Services Module (FWSM) or ASA device, the module itself consumes a device count and then consumes an additional device count for each additional security context. For example, an FWSM with two security contexts would consume three device counts: one for the module, one for the admin context, and one for the second security context. 
 
    [bookmark: pgfId-1113369]Unmanaged devices are a special case. In Security Manager you can add unmanaged devices to the device inventory. An unmanaged device is a device for which you have deselected Manage in Cisco Security Manager in the device properties. An unmanaged device does not consume a device count. 
 
    [bookmark: pgfId-1114401]Another class of unmanaged device is an object that is added to a topology map. You can use the Map > Add Map Object command to add different types of objects on the map such as network clouds, firewalls, hosts, networks, and routers. These objects do not appear in the device inventory and do not consume a device count. 
 
    [bookmark: pgfId-1114402]To determine your device count, which you will need to do to determine which Security Manager server license you need, refer to Table 2-3. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1113375]Tip For the purpose of determining which Security Manager server license you need, devices are counted for Security Manager 4.9 in the same way that they were for previous versions of Cisco Security Manager. 
 
     
     
 
    
 
    
 
     
     [bookmark: pgfId-1113387]Device 
    
 
     
     [bookmark: pgfId-1113389]Mode (also called Context) 
    
 
     
     [bookmark: pgfId-1113391]Device Count (also called License Count or simply License) 
    
 
     
     [bookmark: pgfId-1113393]Comments 
    
 
    [bookmark: pgfId-1117760]Standalone Firewall Devices
 
    [bookmark: pgfId-1117768]Any standalone firewall device 
 
    [bookmark: pgfId-1117770]Single-context mode 
 
    [bookmark: pgfId-1117772]1
 
    [bookmark: pgfId-1117778]Multi-context mode 
 
    [bookmark: pgfId-1117780]c, where c is the context count other than the system context 
 
    [bookmark: pgfId-1117887]Any standalone firewall blade 
 
    [bookmark: pgfId-1117889]Single-context mode 
 
    [bookmark: pgfId-1117895]Any standalone firewall blade 
 
    [bookmark: pgfId-1117897]Multi-context mode 
 
    [bookmark: pgfId-1117899]c, where c is the context count other than the system context 
 
    [bookmark: pgfId-1117901]Example: 
 
    [bookmark: pgfId-1117904]Please refer to “Example for any Standalone Firewall Blade in Multi-context Mode” below this table. 
 
    [bookmark: pgfId-1117907]Firewalls in Failover Configuration
 
    [bookmark: pgfId-1117915]Any firewall in failover configuration
 
    [bookmark: pgfId-1117917]Single-context mode 
 
    [bookmark: pgfId-1117923]Any firewall in failover configuration
 
    [bookmark: pgfId-1117925]Multi-context mode 
 
    [bookmark: pgfId-1113459]Standalone IPS devices
 
    [bookmark: pgfId-1113467]Any standalone IPS device 
 
    [bookmark: pgfId-1113473]Additional virtual sensors (added after the first sensor) consume 1 license each. 
 
    [bookmark: pgfId-1113475]Non-standalone IPS devices
 
    [bookmark: pgfId-1113487]n, where n is the virtual sensor count and includes virtual sensor vs0 
 
    [bookmark: pgfId-1113489]IPS modules, IPS blades, and IPS virtual machines are discovered independently in Security Manager. 
 
    [bookmark: pgfId-1113490]IPS virtual machines are used in Cisco ASA-5500 Series Adaptive Security Appliances, which are 5512-X, 5515-X, 5525-X, 5545-X, and 5555-X. 
 
    [bookmark: pgfId-1113544]IPS Modules or Virtual Machines that are part of an ASA Failover Configuration
 
    [bookmark: pgfId-1113556]n, where n is the virtual sensor count and includes virtual sensor vs0 
 
    [bookmark: pgfId-1113558]Additional virtual sensors (added after the first sensor) consume 1 license each. 
 
    [bookmark: pgfId-1113560]Licenses Related to ASA Load Balancing Clusters
 
    [bookmark: pgfId-1113568]Each ASA load balance cluster
 
    [bookmark: pgfId-1113570]Single-context mode 
 
    [bookmark: pgfId-1113572]N, where N is the number of nodes in the single-context ASA cluster 
 
    [bookmark: pgfId-1113574]System & Admin context represents 1 context
 
    [bookmark: pgfId-1113576]Each ASA load balance cluster
 
    [bookmark: pgfId-1113578]Multi-context mode 
 
    [bookmark: pgfId-1113580]N * c, where N is the number of nodes in the multi-context ASA cluster and c is the context count
 
    [bookmark: pgfId-1113586]See also Example for Licenses Related to ASA Load Balancing Clusters. 
 
    [bookmark: pgfId-1118032]Excluded Devices 
 
    [bookmark: pgfId-1118027]0
 
    [bookmark: pgfId-1118028]However, additional virtual sensors (added after the first sensor) consume 1 license each.
 
   
 
    
     [bookmark: pgfId-1113590][bookmark: 38942]Example for any Standalone Firewall Blade in Multi-context Mode 
 
    [bookmark: pgfId-1113591]This subsection gives an example of context that will be useful in understanding device count. 
 
    [bookmark: pgfId-1113592]The following command was run in system context on a firewall with two security contexts—admin and ctx1: 
 
     
     [bookmark: pgfId-1113593]r41-appinfra-arsenal# sh context 
    
 
     
     [bookmark: pgfId-1113594]Context Name Class Interfaces Mode URL 
    
 
     
     [bookmark: pgfId-1113595]*admin default GigabitEthernet3/2, Routed disk0:/admin.cfg 
    
 
     
     [bookmark: pgfId-1113596]Management0/0  
    
 
     
     [bookmark: pgfId-1113597]ctx1 default Routed disk0:/ctx1.cfg 
    
 
     
     [bookmark: pgfId-1113598] 
    
 
     
     [bookmark: pgfId-1113599]Total active Security Contexts: 2 
    
 
     
     [bookmark: pgfId-1113600]r41-appinfra-arsenal# sh context count 
    
 
     
     [bookmark: pgfId-1113601] 
    
 
     
     [bookmark: pgfId-1113602]Total active Security Contexts: 2  
    
 
   
 
    
     [bookmark: pgfId-1113604][bookmark: 79022]Example for Licenses Related to ASA Load Balancing Clusters
 
    [bookmark: pgfId-1113605]This subsection gives an example of the device count for an ASA load balancing cluster in multi-context mode. 
 
     
     [bookmark: pgfId-1113606]3 Nodes with 4 security contexts each: License Count = 3 * 5 = 15.  
    
 
   
 
    
     [bookmark: pgfId-1075341][bookmark: 79403]Determining Which License You Need
 
    [bookmark: pgfId-1090274]The license that you need depends upon whether you are performing a new installation or upgrading from one of several previous versions:
 
     
     	 [bookmark: pgfId-1090491]New Installation of Security Manager 4.9
 
     	 [bookmark: pgfId-1090493]Upgrade from Security Manager 4.x
 
    
 
     
      [bookmark: pgfId-1090474][bookmark: 29154]New Installation of Security Manager 4.9 
 
     [bookmark: pgfId-1114466]A new installation of Cisco Security Manager 4.9 requires the purchase of the appropriate Cisco Security Manager 4.9 license.
 
    
 
     
      [bookmark: pgfId-1114469][bookmark: 78079]Upgrade from Security Manager 4.x
 
      
      	 [bookmark: pgfId-1110657]If you have a valid SAS contract, you can upgrade to any latest version of Cisco Security Manager at no additional cost. The current license will be recognized and retained by the Security Manager installation program, so you are not required to apply for license during upgrade from Security Manager 4.x to Security Manager 4.9.
 
      	 [bookmark: pgfId-1118633]Users without SAS contracts must either purchase a SAS contract or purchase a valid Security Manager 4.9 license.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1118634]Note With a SAS contract, users can upgrade to the latest version for free.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1091375]90-day Evaluation License 
 
     [bookmark: pgfId-1090053]If you provide no license during installation, the resulting installation will be an evaluation version. You can also select Evaluation Only during installation. Refer to Installing Security Manager Server, Common Services, and AUS. 
 
     [bookmark: pgfId-1090214]The evaluation license is limited to 50 devices. 
 
     [bookmark: pgfId-1089974]The evaluation license provides the same privileges as the Professional Edition licenses, except that you cannot apply incremental licenses to the evaluation version. 
 
    
 
     
      [bookmark: pgfId-1114416]Choosing the Right License when you are a New 4.x Customer 
 
     [bookmark: pgfId-1111922]A typical scenario for a new 4.x Cisco Security Manager customer and the licensing options are explained as follows:
 
     [bookmark: pgfId-1111529] 1. [BASE] Selection of CSM Base Product Version 
 
     [bookmark: pgfId-1111275] a. Based on the number of devices you need to manage using Cisco Security Manager (after accounting for future growth prospects), obtain 
 
      
      	 [bookmark: pgfId-1117192]CSMST5-4.x-K9/CSMST10-4.x-K/ CSMST25-4.x-K9 for networks of 5, 10, 25 or less devices respectively.
 
      	 [bookmark: pgfId-1111791]CSMPR50-4.x-K9/CSMPR100-4.x-K9/CSMPR250-4.x-K9 for larger networks. In addition, consider [INCREMENTAL] licenses.
 
     
 
     [bookmark: pgfId-1116858] b. If you need to manage Catalyst 6500 or FWSM/IDSM switch blades, choose CSMPR-50-4.x-K9.
 
     [bookmark: pgfId-1118120] c. If you obtained a standard license, but later needed to manage Catalyst switches or switch blades, or needed to manage more than 25 devices, obtain CSMSTPR-U-4.x-K9 to upgrade to the PRO version of the product.
 
     [bookmark: pgfId-1116623] d. If you already purchased a PRO license, but later needed to manage more than 50 devices, obtain the incremental license of 4.x.
 
     [bookmark: pgfId-1111284] 2. [INCREMENTAL] Incremental licenses allow you to manage more devices. Based on the size of the network you need to manage, obtain:
 
     [bookmark: pgfId-1111286] a. CSMPR-LIC-50/CSMPR-LIC-100/CSMPR-LIC-250 to add management of 50, 100, 250 additional devices respectively.
 
     [bookmark: pgfId-1111289] b. For larger networks, 
 
      
      	 [bookmark: pgfId-1111290]Purchase multiple units of [INCREMENTAL] licenses if you are looking for installing these on the same Cisco Security Manager server 
 
      	 [bookmark: pgfId-1111292]Purchase [BASE] licenses and/or [INCREMENTAL] licenses if you are looking for installing multiple Cisco Security Manager servers to obtain better performance.
 
     
 
     [bookmark: pgfId-1111294] 3. [SUPPORT] In addition to the [BASE] and [INCREMENTAL] licenses, you will have to purchase equivalent SAS contracts. Having a SAS contract will enable you to upgrade to any latest version of Cisco Security Manager without any additional cost.
 
    
 
     
      [bookmark: pgfId-1111939]Choosing the Right License when you are an Existing 4.x Customer 
 
     [bookmark: pgfId-1116908]A typical scenario for an existing 4.x Cisco Security Manager customer and the licensing options are explained as follows:
 
     [bookmark: pgfId-1116909] 1. [BASE] To upgrade from CSM 4.x Standard to CSM 4.x PRO, purchase the CSMSTPR-U-4.x-K9 and then add incremental as you grow
 
     [bookmark: pgfId-1111380] 2. [INCREMENTAL] Any existing incremental licenses you already own will also be applicable for the latest Cisco Security Manager version. You do not need to obtain new incremental licenses to manage same number of devices. If you intend to enable event management for larger networks, you may need to consider deploying multiple Cisco Security Manager servers. This involves obtaining additional [BASE] product licenses.
 
     [bookmark: pgfId-1112119] 3. [SUPPORT] CSM 4.x support contracts will continue to support CSM 4.9. 
 
    
 
   
 
    
     [bookmark: pgfId-1104345][bookmark: 77076]Installing a License for Security Manager or Component Applications
 
    [bookmark: pgfId-1087701]During the installation of Security Manager, you are asked for license information. Refer to Installing Security Manager Server, Common Services, and AUS. 
 
    [bookmark: pgfId-1088109]During the installation of Common Services and AUS, you are not asked for license information. [bookmark: marker-1088298]Common Services does not require a license file. [bookmark: marker-1088300]Auto Update Server does not require a license file. 
 
   
 
    
     [bookmark: pgfId-1086445][bookmark: 50101]Updating a License for Security Manager or Component Applications
 
    [bookmark: pgfId-1088056]To learn how to update a license file for Security Manager or a component application, see Updating Security Manager. 
 
   
 
    
     [bookmark: pgfId-1086392][bookmark: 16851]Additional Documentation on Licensing
 
    [bookmark: pgfId-1087586][bookmark: marker-1087585]For complete information on the types of licenses available and the various supported upgrade paths, as well as information about the Cisco Software Application Support service agreement contracts that you can purchase, see the product bulletin for the most recent major release of Security Manager at http://www.cisco.com/en/US/products/ps6498/prod_bulletins_list.html. 
 
   
 
    
     [bookmark: pgfId-1086394][bookmark: 40335]Getting Help with Licensing
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1102491][bookmark: 82373]Requirements and Dependencies[bookmark: marker-1102490] 
      
      
 
     
 
 
    [bookmark: pgfId-1102336]You can install and use Security Manager as a standalone product or in combination with several other Cisco Security Management Suite applications, including optional applications that you can select in the Security Manager installer or download from Cisco.com. Requirements for installation and operation vary in relation to the presence of other software on the server and according to the way that you use Security Manager.
 
     
      
    
 
    
 
    [bookmark: pgfId-1095365]Tip We recommend that you synchronize the date and time settings on all your management servers and all the managed devices in your network. One method is to use an NTP server. Synchronization is important if you want to correlate and analyze log file information from your network.[bookmark: marker-1095905]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1095367]The sections in this chapter describe requirements and dependencies for installing server applications such as Security Manager, Auto Update Server, and Security Manager client software:
 
     
     	 [bookmark: pgfId-1052619]Required Services and Ports
 
     	 [bookmark: pgfId-1105840]Windows Firewall Configuration Script
 
     	 [bookmark: pgfId-1051392]Server Requirements and Recommendations
 
     	 [bookmark: pgfId-1060444]Client Requirements
 
    
 
   
 
    
     [bookmark: pgfId-1060450][bookmark: 24624]Required Services and Ports[bookmark: marker-1095824]
 
     
      
    
 
    
 
    [bookmark: pgfId-1113051]Note Security Manager will use predefined and dynamic ports for its internal operation. Port scanners might block those ports and will not let Security Manager to execute those processes. Therefore port scanners such as Qualys should not be enabled. If enabled, it may result in a Security Manager process crash issue which in turn may require a complete reinstallation of Security Manager.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1113043]You must ensure that required ports are enabled and available for use by Security Manager and its associated applications on your server so that the server can communicate with clients and servers running associated applications.
 
    [bookmark: pgfId-1091701]The ports that need to be open depend on whether you are using CiscoWorks for AAA or an external server (such as ACS), and whether you are configuring Security Manager to interact with certain other applications:
 
     
     	 [bookmark: pgfId-1053707] Basic Required Ports — Table 3-1  lists the basic ports that must be opened, assuming that you have not customized your configuration to use non-default ports. If you are using CiscoWorks for AAA (user authorization) services, and you do not use any of the optional applications, these should be the only ports you need to open.
 
    
 
    [bookmark: pgfId-1087509]
 
     
      
       
       [bookmark: pgfId-1087571]Table 3-1 [bookmark: 32104]Basic Required Ports to Open on the Security Manager Server 
 
       
       
        
        	 
          
          [bookmark: pgfId-1087579]Communication 
         
  
        	 
          
          [bookmark: pgfId-1087581]Service 
         
  
        	 
          
          [bookmark: pgfId-1087583]Protocol 
         
  
        	 
          
          [bookmark: pgfId-1087585]Port 
         
  
        	 
          
          [bookmark: pgfId-1093938]In 
         
  
        	 
          
          [bookmark: pgfId-1093964]Out 
         
  
       
 
        
        	[bookmark: pgfId-1087587]Security Manager Client to the Security Manager Server.
  
        	[bookmark: pgfId-1087589]HTTP, HTTPS
  
        	[bookmark: pgfId-1087591]TCP
  
        	[bookmark: pgfId-1087593]1741/443
  
        	[bookmark: pgfId-1093940]X
  
        	[bookmark: pgfId-1093966]—
  
       
 
        
        	[bookmark: pgfId-1093602]Security Manager Client to device managers included in the product (such as ASDM).
  
        	[bookmark: pgfId-1093604]HTTPS
  
        	[bookmark: pgfId-1093606]TCP
  
        	[bookmark: pgfId-1093608]443
  
        	[bookmark: pgfId-1093942]X
  
        	[bookmark: pgfId-1093968]—
  
       
 
        
        	 [bookmark: pgfId-1094007]Security Manager to Cisco.com for IPS signature and engine update downloads.
  
        	[bookmark: pgfId-1094009]HTTP
  
        	[bookmark: pgfId-1094011]TCP
  
        	[bookmark: pgfId-1094013]80
  
        	[bookmark: pgfId-1094015]—
  
        	[bookmark: pgfId-1094017]X
  
       
 
        
        	[bookmark: pgfId-1094045]HTTPS
  
        	[bookmark: pgfId-1094047]TCP
  
        	[bookmark: pgfId-1094049]443
  
        	[bookmark: pgfId-1094051]—
  
        	[bookmark: pgfId-1094053]X
  
       
 
        
        	 [bookmark: pgfId-1087603]Security Manager Server to Devices.
 [bookmark: pgfId-1093145]Tip HTTPS and SSH ports are required, but open the Telnet port only if you use Telnet as the transport protocol for one or more devices. Because Telnet transmits passwords in clear text, we recommend that you never use Telnet, and that you do not open the Telnet port.  
        	[bookmark: pgfId-1087605]HTTPS
  
        	[bookmark: pgfId-1087607]TCP
  
        	[bookmark: pgfId-1087609]443
  
        	[bookmark: pgfId-1093944]—
  
        	[bookmark: pgfId-1093970]X
  
       
 
        
        	[bookmark: pgfId-1093192]SSH
  
        	[bookmark: pgfId-1093194]TCP
  
        	[bookmark: pgfId-1093196]22
  
        	[bookmark: pgfId-1093946]—
  
        	[bookmark: pgfId-1093972]X
  
       
 
        
        	[bookmark: pgfId-1093208]Telnet
  
        	[bookmark: pgfId-1093210]TCP
  
        	[bookmark: pgfId-1093212]23
  
        	[bookmark: pgfId-1093948]—
  
        	[bookmark: pgfId-1093974]X
  
       
 
        
        	[bookmark: pgfId-1093310]Security Manager Server to Device for configuration rollback operations on IOS devices.
  
        	[bookmark: pgfId-1093312]TFTP
  
        	[bookmark: pgfId-1093314]UDP
  
        	[bookmark: pgfId-1093316]69
  
        	[bookmark: pgfId-1093950]X
  
        	[bookmark: pgfId-1093976]X
  
       
 
        
        	[bookmark: pgfId-1093221]Security Manager to an e-mail server.
 [bookmark: pgfId-1093334]This port is required only if you configure e-mail notification settings for any of the various functions that can provide these notifications.
  
        	[bookmark: pgfId-1093223]SMTP
  
        	[bookmark: pgfId-1093225]TCP
  
        	[bookmark: pgfId-1093227]25
  
        	[bookmark: pgfId-1093952]—
  
        	[bookmark: pgfId-1093978]X
  
       
 
        
        	[bookmark: pgfId-1094205]Syslog service used by the Security Manager Event Viewer.
  
        	[bookmark: pgfId-1094207]Syslog
  
        	[bookmark: pgfId-1094209]UDP
  
        	[bookmark: pgfId-1094211]514
  
        	[bookmark: pgfId-1094213]X
  
        	[bookmark: pgfId-1094215]—
  
       
 
        
        	[bookmark: pgfId-1105612]Health and Performance Monitor
  
        	[bookmark: pgfId-1105614]HTTP, HTTPS
  
        	[bookmark: pgfId-1105616]TCP
  
        	[bookmark: pgfId-1105618]2012 and 4444
  
        	[bookmark: pgfId-1105620]X
  
        	 
          
           
            
            [bookmark: pgfId-1093735]Table 3-2 [bookmark: 24595]Ports Required for Optional Server Applications 
 
            
            
             
             	 
               
               [bookmark: pgfId-1093747]Communication 
              
  
             	 
               
               [bookmark: pgfId-1093749]Service 
              
  
             	 
               
               [bookmark: pgfId-1093751]Protocol 
              
  
             	 
               
               [bookmark: pgfId-1093753]Port 
              
  
             	 
               
               [bookmark: pgfId-1093755]In 
              
  
             	 
               
               [bookmark: pgfId-1093757]Out 
              
  
            
 
             
             	[bookmark: pgfId-1093759]Security Manager Server to and from CS-MARS.
  
             	[bookmark: pgfId-1093761]HTTPS
  
             	[bookmark: pgfId-1093763]TCP
  
             	[bookmark: pgfId-1093765]443
  
             	[bookmark: pgfId-1093767]X
  
             	[bookmark: pgfId-1093769]X
  
            
 
             
             	[bookmark: pgfId-1093771]Security Manager Server to Cisco Secure Access Control Server (ACS).
  
             	[bookmark: pgfId-1093773]HTTP, HTTPS
  
             	[bookmark: pgfId-1093775]TCP
  
             	 
               
               	 [bookmark: pgfId-1093777]2002
 
               	 [bookmark: pgfId-1093778]If port restriction is enabled on the ACS server, allow all ports in the range for HTTP/HTTPS communication.
 
               	 [bookmark: pgfId-1093779]If port restriction is disabled, allow all HTTP/HTTPS traffic between the Security Manager server and ACS.
 
              
  
             	[bookmark: pgfId-1093781]—
  
             	[bookmark: pgfId-1093783]X
  
            
 
             
             	[bookmark: pgfId-1093785]Security Manager Server to an External AAA Server (configurable in a non-ACS mode).
  
             	[bookmark: pgfId-1093787]RADIUS
LDAP
Kerberos
  
             	[bookmark: pgfId-1093789]TCP
  
             	[bookmark: pgfId-1093791]1645, 1646, 1812(new), 389, 636 (SSL), 88
  
             	[bookmark: pgfId-1093793]—
  
             	[bookmark: pgfId-1093795]X
  
            
 
             
             	[bookmark: pgfId-1093797]Security Manager Server to Configuration Engine.
  
             	[bookmark: pgfId-1093799]HTTPS
  
             	[bookmark: pgfId-1093801]TCP
  
             	[bookmark: pgfId-1093803]443
  
             	[bookmark: pgfId-1093805]—
  
             	[bookmark: pgfId-1093807]X
  
            
 
             
             	[bookmark: pgfId-1093809]Security Manager Server to AUS.
  
             	[bookmark: pgfId-1093811]HTTPS
  
             	[bookmark: pgfId-1093813]TCP
  
             	[bookmark: pgfId-1093815]443
  
             	[bookmark: pgfId-1093817]—
  
             	[bookmark: pgfId-1093819]X
  
            
 
             
             	[bookmark: pgfId-1093821]Device to AUS. Used to retrieve images and configurations.
  
             	[bookmark: pgfId-1093823]HTTP
  
             	[bookmark: pgfId-1093825]TCP
  
             	[bookmark: pgfId-1093827]1751
  
             	[bookmark: pgfId-1093829]X
  
             	[bookmark: pgfId-1093831]—
  
            
 
             
             	[bookmark: pgfId-1093833]Security Manager Server to TMS Server.
  
             	[bookmark: pgfId-1093835]FTP
  
             	[bookmark: pgfId-1093837]TCP
  
             	[bookmark: pgfId-1093839]21
  
             	[bookmark: pgfId-1093841]—
  
             	[bookmark: pgfId-1093843]X
  
            
 
             
             	[bookmark: pgfId-1093845]Internet browser running on a client system to the browser interface on the Security Manager or AUS server.
  
             	[bookmark: pgfId-1093847]HTTP, HTTPS
  
             	[bookmark: pgfId-1093849]TCP
  
             	[bookmark: pgfId-1093851]1741/443
  
             	[bookmark: pgfId-1093853]X
  
             	[bookmark: pgfId-1093855]—
  
            
 
            
          
 
         
 
          
           [bookmark: pgfId-1030818][bookmark: 52206]Windows Firewall Configuration Script 
 
          [bookmark: pgfId-1105833]Beginning with Version 4.4, Security Manager included a Windows Firewall configuration script in the server installer. This script automates the process of opening and closing the ports necessary for Windows Firewall to work correctly and securely; its purpose is to harden your Security Manager server. 
 
          [bookmark: pgfId-1105894]At the time of installation, this script is copied to NMSROOT but not executed. You can run this script manually to configure Windows Firewall on your Security Manager server; doing so will secure the server by blocking unnecessary ports. [NMSROOT is the path to the Security Manager installation directory. The default is C:\Program Files (x86)\CSCOpx.] 
 
          [bookmark: pgfId-1105911]This script opens only those “IN” ports that are needed for Security Manager to perform its tasks. Hence the “Firewall.txt” file has the ports that are the bare minimum for Security Manager. If, later, you discover that you want some other port to be open, you can do that. 
 
          [bookmark: pgfId-1105917]To run the Windows Firewall script, follow this procedure: 
 
          
 
          [bookmark: pgfId-1105925]Step 1 Make sure Powershell scripts can run unrestricted: 
 
          [bookmark: pgfId-1105933] a. Open the Powershell Command Line Tool. 
 
          [bookmark: pgfId-1105943] b. Execute the command “Set-ExecutionPolicy Unrestricted” 
 
          [bookmark: pgfId-1105948]Step 2 In NMSROOT, open a command prompt and execute firewall.bat: 
 
          [bookmark: pgfId-1105974] a. Output will appear in the folder NMSROOT/log. 
 
          [bookmark: pgfId-1105975] b. Windows.FW_Config.wfw is the backup of the Windows Firewall configuration before executing the script.
 
          [bookmark: pgfId-1105976] c. initialfirewallsettings.txt lists the ports that were open BEFORE running the script. 
 
          [bookmark: pgfId-1105956] d. finalfirewallsettings.txt lists the ports that are open AFTER running the script. 
 
          [bookmark: pgfId-1106022]Step 3 Enable Windows Firewall and use private network settings: Control Panel > Windows Firewall > Turn Windows Firewall on or off > [General tab] > On. 
 
          [bookmark: pgfId-1106038]Step 4 Disable Powershell scripts for security:
 
          [bookmark: pgfId-1106047] a. Open the Powershell Command Line Tool. 
 
          [bookmark: pgfId-1106065] b. Execute the command “Set-ExecutionPolicy Restricted” 
 
          [bookmark: pgfId-1106074]Step 5 [optional] Verify added firewall rules by using Windows Firewall with Advanced Security (not available in Windows 2008 Enterprise Server (Service Pack 2)—64-bit) 
 
          [bookmark: pgfId-1110001]
 
           
           
 
          
 
          
 
         
 
          
           [bookmark: pgfId-1105816][bookmark: 21456]Server Requirements and Recommendations[bookmark: marker-1095833]
 
           
            
          
 
          
 
          [bookmark: pgfId-1099806]Note Cisco is only responsible for licensing of the pre-installed Operating System that accompanies the Cisco Unified Computing System(UCS) bundle (which has Cisco Security Manger pre-installed). Customers upgrading their Operating System while migrating to Cisco Security Manager 4.9 or later, must buy the appropriate Windows license.
 
           
           
 
          
 
          
 
          [bookmark: pgfId-1113603]Unless otherwise noted, this section applies to all applications (Security Manager and Auto Update Server). 
 
          [bookmark: pgfId-1099833]To install Security Manager, you must be an Administrator or a user with local administrator rights; this also applies if you are installing the client only. 
 
          [bookmark: pgfId-1113586]We recommend that you install Security Manager on a dedicated server in a controlled environment. For additional best practices and related guidance, see Chapter4, “Preparing a Server for Installation” 
 
          [bookmark: pgfId-1113590]Recommended Server
 
          [bookmark: pgfId-1113591]Cisco recommends that you install Security Manager on a Cisco UCS C220 M3 server with the components described in Table 3-3. More information on Cisco UCS (Unified Computing System) is available at http://www.cisco.com/go/ucs.
 
          [bookmark: pgfId-1092168]Installation Practices to Avoid:[bookmark: marker-1095845] 
 
           
           	 [bookmark: pgfId-1095855]Do not install any application on a primary or backup domain controller. Cisco does not support any use of Common Services on a Windows domain controller.[bookmark: marker-1095864]
 
           	 [bookmark: pgfId-1095858]Do not install any application in an encrypted directory. Common Services does not support directory encryption.[bookmark: marker-1095857]
 
           	 [bookmark: pgfId-1113207]Do not install any application if Terminal Services is enabled in Application mode. In such a case, you must disable Terminal Services, then restart the server before you install. Common Services supports only the Remote Administration mode for Terminal Services.[bookmark: marker-1113208]
 
          
 
          [bookmark: pgfId-1113330]
 
           
            
             
             [bookmark: pgfId-1113215]Table 3-3 [bookmark: 76225]Server Hardware Requirements and Recommendations 
 
             
             
              
              	 
                
                [bookmark: pgfId-1113219]Component 
               
  
              	 
                
                [bookmark: pgfId-1113221]Description 
               
  
             
 
              
              	[bookmark: pgfId-1113223]Operating System
  
              	[bookmark: pgfId-1113225]One of the following: 
 
                
                	 [bookmark: pgfId-1113226]Microsoft Windows Server 2012 R2 Standard—64-bit 
 
                	 [bookmark: pgfId-1113227]Microsoft Windows Server 2012 Standard—64-bit 
 
                	 [bookmark: pgfId-1113228]Microsoft Windows Server 2012 R2 Datacenter—64-bit 
 
                	 [bookmark: pgfId-1113229]Microsoft Windows Server 2012 Datacenter—64-bit 
 
               
 [bookmark: pgfId-1113230]English and Japanese are the only supported languages. For complete information, see Understanding Regional and Language Options and Related Settings. 
 [bookmark: pgfId-1113234]Microsoft ODBC Driver Manager 3.510 or later is also required so that your server can work with Sybase database files. To confirm the installed ODBC version, find and right-click ODBC32.DLL, then select Properties from the shortcut menu. The file version is listed under the Version tab. 
  
             
 
              
              	[bookmark: pgfId-1113236]System Hardware
  
              	 
                
                	 [bookmark: pgfId-1113238]Processor: Intel Quadcore Xeon 5600 Series or above 
 
                	 [bookmark: pgfId-1113239]Color monitor with at least 1280 x 1024 resolution and a video card capable of 16-bit colors. For AUS-only servers, you can get by with 1024 x 768 resolution. 
 
                	 [bookmark: pgfId-1113240]DVD-ROM drive. 
 
                	 [bookmark: pgfId-1113241]1 Gbps network adapter. 
 
                	 [bookmark: pgfId-1113242]Keyboard. 
 
                	 [bookmark: pgfId-1113243]Mouse. 
 
               
  
             
 
              
              	[bookmark: pgfId-1113245]Memory (RAM)
  
              	[bookmark: pgfId-1113247]16 GB is the minimum needed to use all features of Security Manager. With less memory, features such as Event Management and Report Management are affected. 
 [bookmark: pgfId-1113248]In particular, if the amount of RAM available to the operating system is less than 8 GB, Event Management and Report Manager are disabled during installation. 
 [bookmark: pgfId-1113249]If the memory available to the OS is between 8 and 12 GB, you can turn off Event Management and Report Management, presuming that you do not plan to use them. Configuration Management will be usable in such systems. 
 
                
                 
               
 
               
 [bookmark: pgfId-1113250]Tip To turn off Event Management, follow this path: Configuration Manager > Tools > Security Manager Administration > Event Management > Enable Event Management > [clear checkbox]. 
 
                
                
 
               

 
                
                 
               
 
               
 [bookmark: pgfId-1113251]Tip To turn off Report Management, simply close the Report Manager application. 
 
                
                
 
               

 [bookmark: pgfId-1113252]Although not recommended, you can enable Event Management and Report Management for low memory systems from the Security Manager client after completing the installation (select Tools > Security Manager Administration > Event Management). Keep in mind that enabling Event Management and Report Management on a system with low memory can severely affect the performance of the entire application. 
 [bookmark: pgfId-1113253]If you install AUS on a separate server, the following minimum applies: 
 
                
                	 [bookmark: pgfId-1113254]AUS-only server—4 GB. We recommend more than 4 GB.
 
               
  
             
 
              
              	[bookmark: pgfId-1113256]File system
  
              	[bookmark: pgfId-1113258]NTFS. 
  
             
 
              
              	[bookmark: pgfId-1113260]Disk Optimization
  
              	[bookmark: pgfId-1113262]Diskeeper 2010 Server. This is a recommendation, not a requirement. Disk optimization can improve performance if the cause of poor performance is disk fragmentation. 
  
             
 
              
              	[bookmark: pgfId-1113264]Hard drive space
  
              	[bookmark: pgfId-1113266]Use a suitable combination of HDDs in a RAID configuration to achieve the disk space required, which is as follows: 
 
                
                	 [bookmark: pgfId-1113267]100 GB for the OS partition is recommended by Cisco. 
 
                	 [bookmark: pgfId-1113268]150 GB for the application (Security Manager) partition is recommended by Cisco. The  minimum free disk space required for the Security Manager installation alone is 7 GB. If this is not met, then the installation will be aborted. 
 
               
 [bookmark: pgfId-1113269]Note Cisco strongly recommends installing the OS and application on separate partitions. 
 ) and Veritas documentation for further details. 
 
                
                	 [bookmark: pgfId-1113272]An additional 1.0 TB for log storage for the Event Viewer on a separate partition: This is a requirement, but ONLY if you plan to use Event Viewer. Cisco recommends creating this separate partition on a directly attached storage device. 
 
                	 [bookmark: pgfId-1113273]An additional 1.0 TB or more: This is a requirement, but ONLY if you plan to enable Event Archival. Event Archival functionality creates a secondary storage of events when log storage is required beyond primary storage capacity (for long term preservation etc.). The Secondary Event Store size is required to be bigger than the configured primary storage size, so an additional 1.0 TB or more of disk space is required to use Event Archival. Both primary & secondary event stores can be on a SAN but it is recommended to create the primary store partition on a directly attached storage (DAS) for optimum performance. For more information on SAN storage, see Using SAN Storage
 
               
 [bookmark: pgfId-1113277]Cisco recommends RAID 10 for better performance. RAID 5 can be used if desired. 
 [bookmark: pgfId-1113278]Tips
 
                
                	 [bookmark: pgfId-1113279]A sustained 10,000 events per second (EPS) consumes about 86 GB of compressed disk space per day. Log rollover happens when 90% of the disk space allocated for event store (primary/secondary) is filled. Smaller disk size causes quicker rollovers. Based on your expected EPS rate and rollover requirements, you can increase or decrease the minimum disk size when using Event Management. 
 
               
  
             
 
              
              	[bookmark: pgfId-1113281]IP address
  
              	[bookmark: pgfId-1113283]One static IP address. Dynamic addresses are not supported.
 [bookmark: pgfId-1113284]Tip Security Manager can have multiple network interface cards (NICs) but teaming of multiple NICs for load balancing is not recommended.  
             
 
              
              	[bookmark: pgfId-1113286]Virtual Memory (Paging File)
  
              	[bookmark: pgfId-1113288]1.5 x installed memory. This is a recommendation from Microsoft for Windows platforms. It is not a Cisco requirement. Memory paging is necessitated only if the installed RAM on the system is insufficient to handle the load. 
 [bookmark: pgfId-1113289]Caution: 
 [bookmark: pgfId-1113290]A special consideration applies if you are using Windows Server 2012 or 2012 R2 (Standard or Datacenter)—64-bit. 
 [bookmark: pgfId-1113291]If you choose to automatically manage paging file size, the installation of Security Manager might fail with an error message recommending you to configure the virtual memory before running the installation program. 
 [bookmark: pgfId-1113292]To successfully install Security Manager, follow these steps: 
 [bookmark: pgfId-1113293] 1. Deselect (clear) the checkbox “Automatically manage paging file size for all drives”. (The navigation path to this checkbox is Control Panel > System> Advanced System Settings > Performance > Settings > Advanced tab> Virtual Memory > Change.)
 [bookmark: pgfId-1113294] 2. Create the paging file with a minimum size of 4 GB. 
The paging file value is configured based on the swap size. The default values of the paging configuration are 10240 and 16384 respectively.
 [bookmark: pgfId-1113295] 3. Start installing Security Manager. 
  
             
 
              
              	[bookmark: pgfId-1113297]Antivirus
  
              	[bookmark: pgfId-1113299]Real-time protection disabled. This is a recommendation, not a requirement. The system can have an anti-virus application installed, but Cisco recommends disabling real-time protection because it causes a performance penalty. The user can choose to run a quick scan which is scheduled to run at times when there is not much load on the server. 
 [bookmark: pgfId-1113300]Note It is mandatory to exclude the NMSROOT directory and the eventing folder from scanning.
  
             
 
              
              	[bookmark: pgfId-1113303][bookmark: marker-1113302]Browser
  
              	[bookmark: pgfId-1113305]One of the following: 
 
                
                	 [bookmark: pgfId-1113306]Internet Explorer 8.x, 9.x, 10.x, or 11.x, but only in Compatibility View 
 
               
 [bookmark: pgfId-1113307]Note When using Internet Explorer (any version) to download the client, ensure that the following setting is correct: Internet Explorer > Tools > Internet Options > Advanced > Security > clear the “Do not save encrypted pages to disk” checkbox. If this setting is not correct (i.e., the checkbox is checked), attempts to download the client will fail. 
 [bookmark: pgfId-1113308]Tip To use Compatibility View in Internet Explorer, navigate to Tools > Compatibility View Settings, and add the Security Manager server as a “website to be displayed in Compatibility View.” 
                
                	 [bookmark: pgfId-1113309]Firefox 15.0.1 and above supported and recommended 
 
               
  
             
 
              
              	[bookmark: pgfId-1113312]Java[bookmark: marker-1113311] Plug-in
  
              	[bookmark: pgfId-1113314]There is no requirement to have JRE installed. It is required to have Java scripts enabled in the web browser.
  
             
 
              
              	[bookmark: pgfId-1113316]Optional Virtualization Software[bookmark: marker-1113317]
  
              	[bookmark: pgfId-1113319]You can, optionally, install the application on a system running the following versions of VMware: ESX 4.1 and ESXi versions up to ESXi 5.5. 
 [bookmark: pgfId-1113320]You should allocate at least the same amount of memory to the virtual machine you use with Security Manager as you would for a non-virtualized server. Use of recent generation CPUs with technology designed to improve virtualization performance is recommended (for example, Intel-VT or AMD-V CPUs). 
 [bookmark: pgfId-1113321]Tip Allocate two or more CPUs to the VM image. Some processes, such as system backup, can take an unreasonably long time to complete if you use one CPU.  
             
 
              
              	[bookmark: pgfId-1113323]High Availability Support (HA Support)
  
              	[bookmark: pgfId-1113325]One of the following:
 
                
                	 [bookmark: pgfId-1113326]Veritas Storage Foundation 5.1 SP1
 
                	 [bookmark: pgfId-1113327]Veritas Storage Foundation 6.0.1
 
                	 [bookmark: pgfId-1113328]Veritas Storage Foundation 6.0.2
 
                	 [bookmark: pgfId-1113329]Veritas Storage Foundation 6.1
 
               
  
             
 
             
           
 
          
 
           
            [bookmark: pgfId-1113332][bookmark: 11507]Understanding Regional and Language Options and Related Settings
 
           [bookmark: pgfId-1094650]Security Manager supports only the U.S. English and Japanese versions of Windows. From the Start Menu, open the Control Panel for Windows, open the panel where you configure region and language settings, then set the default locale. (We do not support English as the language in any Japanese version of Windows.) 
 
            
             
           
 
           
 
           [bookmark: pgfId-1105701]Tip For a detailed procedure, refer to How to Set the Locale for the Windows Default User Template to U.S. English. 
 
            
            
 
           
 
           
 
            
             
           
 
           
 
           [bookmark: pgfId-1105643]Note You must change the default system locale to U.S. English before installing Security Manager; changing the default system locale and rebooting the server does not change the default profile. It is not sufficient for the current user only to have the proper settings; this is because Security Manager creates a new account (“casuser”) that runs all Security Manager server processes. 
 
            
            
 
           
 
           
 
           [bookmark: pgfId-1096583]In addition, the Regional and Language Options in the server operating system must be set correctly. Also, peripheral devices such as keyboards that use other languages can affect the way Security Manager functions. 
 
           [bookmark: pgfId-1094683]The following list contains the Regional and Language Options and related settings that you must adhere to in order to successfully install Security Manager: 
 
            
            	 [bookmark: pgfId-1094684]The server locale must be U.S. English or Japanese. 
 
            	 [bookmark: pgfId-1094695]You must avoid using peripheral devices such as keyboards that use other languages; these devices must not even be connected to the server. 
 
            	 [bookmark: pgfId-1094706]You must take care not to disturb the server settings while using a non-console RDP session to the server; connecting to the server by using a non-console RDP can lead to the locale of the RDP client machine being applied to the server. 
 
            	 [bookmark: pgfId-1102535]You must check the Regional and Language Options and verify that the language selected for non-Unicode programs is English (United States); the path to that selection is Control Panel > Regional and Language Options > Advanced > Language for non-Unicode Programs. 
 
            	 [bookmark: pgfId-1102536]You must ensure that the system locale in the Windows Registry is in a supported language. In order to change it, follow this procedure: 
 
           
 
           [bookmark: pgfId-1102622] 1. In a command window, execute one of the following commands: regedit.exe or regedt32.exe. 
 
           [bookmark: pgfId-1102660] 2. Make sure that the localname is supported. The following example is for U.S. English: 
 
           [bookmark: pgfId-1102678]\HKEY_USERS\.DEFAULT\Control Panel\International 
 
           [bookmark: pgfId-1102665]and change LocaleName to en-US
 
            
             
           
 
           
 
           [bookmark: pgfId-1102537]Note Paths and file names are restricted to characters in the English alphabet. Japanese characters are not supported for paths or file names. When selecting files on a Windows Japanese OS system, the usual file separator character \ is supported, although you should be aware that it might appear as the Yen symbol (U+00A5). 
 
            
            
 
           
 
           
 
          
 
           
            [bookmark: pgfId-1098163][bookmark: 46946]Using SAN Storage[bookmark: marker-1098347]
 
           [bookmark: pgfId-1098167]You can use SAN storage with Security Manager provided that the storage has acceptable I/O rates and capacity. The following are the main items within Security Manager that require storage, and the storage options that you have in addition to using disk storage that is directly installed in the server:
 
            
            	 [bookmark: pgfId-1098170]Security Manager installation folder (CSCOpx and subfolders)—The application is best installed on a local drive. However, the folder can be direct attached storage (DAS) or block-based SAN storage (FC, FCoE, iSCSI). The high-availability configuration for Security Manager, described in  High Availability Installation Guide for Cisco Security Manager , requires a shared cluster volume.
 
            	 [bookmark: pgfId-1098199]Primary storage for the Event Manager service—If you use Event Viewer to monitor events, you must specify a primary storage location. The primary storage can be direct attached storage (DAS) or block storage (SAN protocol: FC, FCoE, iSCSI) mapped as a local drive.
 
            	 [bookmark: pgfId-1098224]Extended storage for the Event Manager service—Any extended storage location is expected to be on SAN storage. The extended storage should be direct attached storage (DAS) or block storage (SAN protocol: FC, FCoE, iSCSI) mapped as a local drive.
 
           
 
           [bookmark: pgfId-1098271]Tips
 
            
            	 [bookmark: pgfId-1098302]CIFS and NFS are not supported. 
 
            	 [bookmark: pgfId-1098331]The supported network storage types are also supported in VMware configurations. 
 
           
 
          
 
           
            [bookmark: pgfId-1101966]Requirement for iSCSI Volumes 
 
           [bookmark: pgfId-1101967]iSCSI volumes using a software initiator may not be available when Security Manager services are about to start after a system reboot. It may take some time for them to be properly initialized. 
 
           [bookmark: pgfId-1101968]If Security Manager services have not started, then you need to configure dependency and service startup settings for them (the Security Manager services). 
 
           [bookmark: pgfId-1101969]To configure dependency and startup settings, follow this procedure: 
 
           
 
           [bookmark: pgfId-1101970]Step 1 Execute the following commands in a Windows command prompt to change the startup type of the Cisco Security Manager Daemon Manager, syslog, and tftp services to “Delayed auto start”: 
 
           [bookmark: pgfId-1101971]sc config CRMDmgtd start= delayed-auto
 
           [bookmark: pgfId-1101972]sc config crmlog start= delayed-auto
 
           [bookmark: pgfId-1101973]sc config crmtftp start= delayed-auto
 
           [bookmark: pgfId-1101975]Step 2 Set the dependency of Microsoft iSCSi to the Cisco Security Manager Daemon Manager service by executing the following command: 
 
           [bookmark: pgfId-1101976]sc config CRMDmgtd depend= MSiSCSI 
 
            
             
           
 
           
 
           [bookmark: pgfId-1101977]Tip In these commands, the option name includes the equals sign. A space is required between the equals sign and the value. 
 
            
            
 
           
 
           
 
           [bookmark: pgfId-1101978]Step 3 Verify the dependency settings of the Cisco Security Manager Daemon Manager service by executing the following command. It should display the iSCSI initiator dependency setting as “DEPENDENCIES : MSiSCSI” 
 
           [bookmark: pgfId-1101979]sc qc CRMDmgtd 
 
           [bookmark: pgfId-1110170]
 
            
            
 
           
 
           
 
          
 
         
 
          
           [bookmark: pgfId-1098202][bookmark: 24183]Client Requirements[bookmark: marker-1098201]
 
          [bookmark: pgfId-1083782]Table 3-4 describes Security Manager Client requirements and restrictions.
 
           
            
          
 
          
 
          [bookmark: pgfId-1105725]Note The date and time formats that you select for the client must be the same as those used by your server machine. If they are not, Device View in Security Manager may not load properly. 
 
           
           
 
          
 
          
 
          [bookmark: pgfId-1083893]
 
           
            
             
             [bookmark: pgfId-1092438]Table 3-4 [bookmark: 45893]Client Requirements and Restrictions 
 
             
             
              
              	 
                
                [bookmark: pgfId-1092442]Component 
               
  
              	 
                
                [bookmark: pgfId-1092444]Requirement 
               
  
             
 
              
              	[bookmark: pgfId-1092446]System hardware
  
              	 
                
                	 [bookmark: pgfId-1093033]One CPU with a minimum speed of 2 GHz.
 
                	 [bookmark: pgfId-1093034]Color monitor with at least 1280 x 1024 resolution and a video card capable of 16-bit colors.
 
                	 [bookmark: pgfId-1093035]Keyboard.
 
                	 [bookmark: pgfId-1092451]Mouse.
 
               
  
             
 
              
              	[bookmark: pgfId-1092454]Operating System[bookmark: marker-1092453]
  
              	[bookmark: pgfId-1108475]One of the following: 
 
                
                	 [bookmark: pgfId-1109817]Microsoft Windows Server 2008 R2—64-bit
 
                	 [bookmark: pgfId-1112076]Microsoft Windows 7
 
                	 [bookmark: pgfId-1113557]Microsoft Windows 8—64-bit and 32-bit
 
                	 [bookmark: pgfId-1112035]Microsoft Windows 8.1 Enterprise Edition—64-bit and 32-bit
 
                	 [bookmark: pgfId-1110177]Microsoft Windows Server 2012 R2 Standard—64-bit 
 
                	 [bookmark: pgfId-1108480]Microsoft Windows Server 2012 Standard—64-bit 
 
                	 [bookmark: pgfId-1110196]Microsoft Windows Server 2012 R2 Datacenter—64-bit 
 
                	 [bookmark: pgfId-1108481]Microsoft Windows Server 2012 Datacenter—64-bit 
 
               
 [bookmark: pgfId-1092464]Note Security Manager supports only the U.S. English and Japanese versions of Windows. From the Start Menu, open the Control Panel for Windows, open the panel where you configure region and language settings, then set the default locale. (We do not support English as the language in any Japanese version of Windows.) 
  
             
 
              
              	[bookmark: pgfId-1092468][bookmark: marker-1095891]Memory (RAM)
  
              	[bookmark: pgfId-1102065]For 32 bit systems: 
 
                
                	 [bookmark: pgfId-1102066]Minimum: 2 GB 
 
                	 [bookmark: pgfId-1102077]Recommended: > 2 GB 
 
               
 [bookmark: pgfId-1102083]For 64 bit systems: 
 
                
                	 [bookmark: pgfId-1102063]Minimum: 4 GB 
 
                	 [bookmark: pgfId-1102085]Recommended: > 4 GB. 
 
               
  
             
 
              
              	[bookmark: pgfId-1092472]Virtual Memory (Paging File)
  
              	[bookmark: pgfId-1109463]512 MB. 
 [bookmark: pgfId-1110238]Caution: 
 [bookmark: pgfId-1110239]You must deselect (clear) the checkbox “Automatically manage paging file size for all drives”. (The navigation path to this checkbox is Control Panel > System > Advanced System Settings > Performance > Settings > Advanced tab> Virtual Memory > Change.) 
The paging file value is configured based on the swap size. The default values of the paging configuration are 10240 and 16384 respectively
 [bookmark: pgfId-1109479]Caution: 
 [bookmark: pgfId-1109480]A special consideration applies if you are using Windows Server 2012 or 2012 R2 (Standard or Datacenter)—64-bit. You need to be aware of this consideration if your server has two independent partitions (e.g., C: and F:). 
 [bookmark: pgfId-1109481]If you follow these steps, the installation will fail: 
 [bookmark: pgfId-1109482] 1. Uncheck (clear the checkbox for) “Automatically manage paging file size for all drives.” 
 [bookmark: pgfId-1109483] 2. On your non-system partition (e.g., F:), create the paging file. 
 [bookmark: pgfId-1109484] 3. On your system partition (e.g., C:), retain the option to automatically manage paging file size. 
 [bookmark: pgfId-1109485] 4. Start installing Security Manager. 
 [bookmark: pgfId-1109473]The installer quits with an error message stating not to use a system-managed paging file size.
  
             
 
              
              	[bookmark: pgfId-1092476]Hard Drive Space
  
              	[bookmark: pgfId-1092478]10 GB free disk space. 
  
             
 
              
              	[bookmark: pgfId-1095323]Browser[bookmark: marker-1095322]
  
              	[bookmark: pgfId-1107973]One of the following: 
 
                
                	 [bookmark: pgfId-1107974]Internet Explorer 8.x, 9.x, 10.x, or 11.x, but only in Compatibility View 
 
               
 [bookmark: pgfId-1107975]Note When using Internet Explorer (any version) to download the client, ensure that the following setting is correct: Internet Explorer > Tools > Internet Options > Advanced > Security > clear the “Do not save encrypted pages to disk” checkbox. If this setting is not correct (i.e., the checkbox is checked), attempts to download the client will fail. 
 [bookmark: pgfId-1109635]Tip To use Compatibility View in Internet Explorer, navigate to Tools > Compatibility View Settings, and add the Security Manager server as a “website to be displayed in Compatibility View.” 
                
                	 [bookmark: pgfId-1107976]Firefox 15.0.1 and above supported and recommended 
 
               
  
             
 
              
              	[bookmark: pgfId-1092489]Java[bookmark: marker-1092488] Plug-in
  
              	[bookmark: pgfId-1101051]There is no requirement to have JRE installed. It is required to have Java scripts enabled in the web browser. 
 [bookmark: pgfId-1101052]The Security Manager client includes an embedded and completely isolated version of Java (JRE 1.7.x). This Java version does not interfere with your browser settings or with other Java-based applications. 
  
             
 
              
              	[bookmark: pgfId-1097289]Windows user account
  
              	[bookmark: pgfId-1097291]You must log into the workstation with a Windows user account that has Administrator privileges to use the Security Manager client.
 [bookmark: pgfId-1097303]Although some features of the client might work with lesser privileges, only Administrator users are fully supported.
  
             
 
             
           
 
          
 
         
 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-1063829][bookmark: 47771]Preparing a Server for Installation[bookmark: marker-1065822] 
      
      
 
     
 
 
    [bookmark: pgfId-1042691]After you verify that the target server meets the requirements described in “Requirements and Dependencies,” you can use these checklists to prepare and optimize your server for installation:
 
     
     	 [bookmark: pgfId-1043420]Best Practices for Enhanced Server Performance and Security
 
     	 [bookmark: pgfId-1043452]Readiness Checklist for Installation
 
    
 
   
 
    
     [bookmark: pgfId-1030682][bookmark: 55079]Best Practices for Enhanced Server Performance and Security[bookmark: marker-1065831]
 
    [bookmark: pgfId-1066644]A framework of best practices, recommendations, and other preparatory tasks can enable your Security Manager server to run faster and more reliably. 
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1066645] 
     Caution We do not make any assurances that completing the tasks in this checklist improves the performance of every server. Nonetheless, if you choose not to complete these tasks, Security Manager might not operate as designed. 
      
      
 
     
 
    
 
     
      
       
        
        	[bookmark: pgfId-1049610]
 
          
          [image: ] 
         
  
        	 
          
          [bookmark: pgfId-1049612]Task 
         
  
       
 
        
        	[bookmark: pgfId-1049617]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1049619] 1. Find and organize the installer applications for any recommended updates, patches, service packs, hot fixes, and security software to install on the server.
  
       
 
        
        	[bookmark: pgfId-1049624]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1049626] 2. Upgrade the server BIOS if an upgrade is available.
  
       
 
        
        	[bookmark: pgfId-1049631]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1069021] 3. Cisco recommends that you do not install any other product on the Security Manager Server.
 [bookmark: pgfId-1069022]If you plan to install Security Manager on a server that you have used for any other purpose, first back up all important server data, then use a boot CD or DVD to wipe all data from the server. 
 [bookmark: pgfId-1069023]We do not support installation or coexistence on one server of Security Manager 4.9 and any release of Common Services earlier than 4.2.2. Nor do we support coexistence with any third-party software or other Cisco software, unless we state explicitly otherwise in this guide or at http://www.cisco.com/go/csmanager.
  
       
 
        
        	[bookmark: pgfId-1069036]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1069042] 4. Security Manager can have multiple network interface cards (NICs) but teaming of multiple NICs for load balancing is not recommended.
  
       
 
        
        	[bookmark: pgfId-1049638]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1049640] 5. Perform a clean installation of only the baseline server OS, without any manufacturer customizations for server management.
  
       
 
        
        	[bookmark: pgfId-1049645]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1049647] 6. Install any required OS service packs and OS patches on the target server. To check which service packs or updates are required for the version of Windows that you use, select Start > Run, then enter wupdmgr.
 [bookmark: pgfId-1069074]Note Back up your Security Manager Server and stop Security Manager services before any patches or Windows updates are applied. Cisco recommends that you apply patches and Windows updates during the maintenance window, when Security Manager is not running.
  
       
 
        
        	[bookmark: pgfId-1049652]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1049654] 7. Install any recommended updates for drivers and firmware on the target server.
  
       
 
        
        	[bookmark: pgfId-1049659]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1049661] 8. Scan the system for malware. To secure the target server and its OS, scan the system for viruses, Trojan horses, spyware, key-loggers, and other malware, then mitigate all related problems that you find. 
  
       
 
        
        	[bookmark: pgfId-1049666]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1049668] 9. Resolve security product conflicts.[bookmark: marker-1050009][bookmark: 28214] Study and work to resolve any known incompatibilities or limitations among your security tools, such as popup blockers, antivirus scanners, and similar products from other companies. When you understand the conflicts and interactions among those products, decide which of them to install, uninstall, or disable temporarily, and consider whether you must follow a sequence. 
  
       
 
        
        	[bookmark: pgfId-1049676]
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        	[bookmark: pgfId-1049678] 10. “Harden” user accounts. To protect the target server against brute force attacks, disable the guest user account, rename the administrator user account, and remove as many other user accounts as is practical in your administrative environment. 
  
       
 
        
        	[bookmark: pgfId-1049683]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1049685] 11. Use a strong password for the administrator user account and any other user accounts that remain. A strong password has at least eight characters and contains numbers, letters (both uppercase and lowercase), and symbols.
 .  
       
 
        
        	[bookmark: pgfId-1049698]
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        	[bookmark: pgfId-1049700] 12. Remove unused, unneeded, and incompatible applications. For example: 
 
          
          	 [bookmark: pgfId-1051212]Microsoft Internet Information Server (IIS) is not compatible with Security Manager. If IIS is installed, you must uninstall it before you install Security Manager.[bookmark: marker-1064653]
 
          	 [bookmark: pgfId-1051228]We do not support the coexistence of Security Manager with any third-party software or other Cisco software (including any CiscoWorks-branded “solution” or “bundle,” such as the [bookmark: marker-1054449]LAN Management Solution (LMS)), unless we state explicitly otherwise in this guide or at  http://www.cisco.com/go/csmanager . We do support the installation of Security Manager and AUS on the same server, but we recommend that configuration only for very small networks.
 
          	 [bookmark: pgfId-1054430]We do not support the installation or coexistence of this version of Security Manager on a server with any release of Common Services earlier than 4.2.2. 
 
          	 [bookmark: pgfId-1051497]We do not support the coexistence of Security Manager on a server with any CD-ONE components (including CiscoView Device Manager) that you do not receive when you purchase Security Manager.
 
          	 [bookmark: pgfId-1052651]We do not support the coexistence of Security Manager on the same server with Cisco Secure ACS for Windows.
 
          	 [bookmark: pgfId-1052919]We do not support the coexistence of Security Manager on the same server with the full version of Cisco IPS Event Viewer.
 
         
  
       
 
        
        	[bookmark: pgfId-1049707]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1053377] 13. Disable unused and unneeded services. At a minimum, Windows requires the following services to run: DNS Client, Event Log, Plug & Play, Protected Storage, and Security Accounts Manager.[bookmark: marker-1064671]
 [bookmark: pgfId-1050701]Check your software and server hardware documentation to learn if your particular server requires any other services.
  
       
 
        
        	[bookmark: pgfId-1049716]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1066673] 14. Disable all network protocols except TCP and UDP. Any protocol can be used to gain access to your server. Limiting the network protocols limits the access points to your server.
  
       
 
        
        	[bookmark: pgfId-1066678]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1066682] 15. Disable IPv6. Cisco Security Manager does not support IPv6. IPv6 is the default protocol used by Windows Server 2008. 
  
       
 
        
        	[bookmark: pgfId-1049723]
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        	[bookmark: pgfId-1049725] 16. Avoid creating network shares. If you must create a network share, secure the shared resources with strong passwords. 
 [bookmark: pgfId-1049726]Note We strongly discourage network shares. We recommend that you disable NETBIOS completely.
  
       
 
        
        	[bookmark: pgfId-1049731]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1053383] 17. Configure server boot settings. Set a zero-second startup time, set Windows to load by default, and enable automatic reboot in cases of system failure. 
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1043342][bookmark: 22229]Readiness Checklist for Installation[bookmark: marker-1065843]
 
    [bookmark: pgfId-1043783]You must complete the following tasks before you install Security Manager.
 
    [bookmark: pgfId-1043837] 
 
     
      
       
        
        	[bookmark: pgfId-1065140]
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          [bookmark: pgfId-1065142]Readiness Factor 
         
  
       
 
        
        	[bookmark: pgfId-1065147]
 
          
          [image: ] 
         
  
        	 
          
           
         
 
         
 
          
          [bookmark: pgfId-1065149]Caution A server can be vulnerable to attack when you uninstall or disable security applications. 
           
           
 
          
 
         
 [bookmark: pgfId-1069088] 1. Disable security applications temporarily.[bookmark: marker-1065150] For example, you must temporarily disable any antivirus software on the target server before you install Security Manager. Installation cannot run while these programs are active. 
 [bookmark: pgfId-1069089]Note Re-enable your antivirus software after installation, but you must exclude the NMSROOT directory and the eventing folder from scanning as long as Security Manager is installed on the server.
  
       
 
        
        	[bookmark: pgfId-1065156]
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        	[bookmark: pgfId-1065158]Tip You will invalidate the SSL certificate on your server if you set the server date and time outside the range of time in which the SSL certificate is valid. If the server SSL certificate is invalid, the DCRServer process cannot start.[bookmark: marker-1065159] [bookmark: pgfId-1065160] 2. Carefully consider the date and time settings that you apply to your server. Ideally, use an NTP server to synchronize the server date and time settings with those of the devices you expect to manage. Also, if you use Security Manager in conjunction with a Cisco Security Monitoring, Analysis, and Response System (Cisco Security MARS) appliance, the NTP server that you use should be the same one that your Cisco Security MARS appliance uses. Synchronized times are especially important in Cisco Security MARS because timestamp information is essential to accurately reconstruct what transpires on your network.[bookmark: marker-1065864]
 .[bookmark: marker-1065163]  
       
 
        
        	[bookmark: pgfId-1065168]
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        	[bookmark: pgfId-1069104] 3. Confirm that required services and ports are enabled and available for use by Security Manager. Security Manager uses predefined and dynamic ports for its internal operation. Port scanners might block those ports and will not let Security Manager to execute those processes. Therefore port scanners like Qualys should not be enabled. If enabled, it may result in a Security Manager process crash issue which in turn may require a complete reinstallation of Security Manager. See Required Services and Ports, page 3-1.
  
       
 
        
        	[bookmark: pgfId-1065178]
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        	[bookmark: pgfId-1065180] 4. If Terminal Services is enabled in Application Mode, disable Terminal Services and reboot the server. Installation of Security Manager on a system with Terminal Services enabled in Application Mode is not supported. Terminal Services enabled in Remote Administration Mode is supported. 
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1065188] 5. Disable any domain controller service (primary or backup) that is running.
  
       
 
        
        	[bookmark: pgfId-1065193]
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        	[bookmark: pgfId-1065195] 6. Confirm that the target directory for installation is not encrypted. Any attempt to install Security Manager in an encrypted directory will fail.
  
       
 
        
        	[bookmark: pgfId-1065200]
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        	[bookmark: pgfId-1065202] 7. If you are performing a fresh installation, you should place your license file on the target server before installation. You will be prompted to select this file during installation.
 [bookmark: pgfId-1066615]Note The path to the license file must not contain special characters such as the ampersand (&).
  
       
 
        
        	[bookmark: pgfId-1065207]
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        	[bookmark: pgfId-1065209] 8. If you have not done so already, uninstall IIS. It is not compatible with Security Manager.
  
       
 
        
        	[bookmark: pgfId-1065214]
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        	[bookmark: pgfId-1065216] 9. Disable every active instance of Sybase on your server, including Cisco Secure ACS for Windows if it is present. You can choose whether to re-enable or restart Sybase after you install Security Manager, but remember we do not support the coexistence of Security Manager on the same server with Cisco Secure ACS for Windows.[bookmark: marker-1065217]
  
       
 
        
        	[bookmark: pgfId-1065222]
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        	[bookmark: pgfId-1065224] 10. If the Cisco Security Manager client is already installed on the server, the client needs to be stopped. This condition is checked during installation. 
  
       
 
        
        	[bookmark: pgfId-1065226]
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        	[bookmark: pgfId-1065238] 11. Disable FIPS-compliant encryption. Federal Information Processing Standard (FIPS)-compliant encryption algorithms sometimes are enabled for group security policy on Windows Server 2008. When FIPS compliance is turned on, the SSL authentication may fail on CiscoWorks Server. You should disable FIPS compliance for CiscoWorks to work properly. 
 [bookmark: pgfId-1065239]Procedure
 [bookmark: pgfId-1065516]To enable or disable FIPS on Windows Server 2008, follow these steps:
 [bookmark: pgfId-1065240] a. Go to Start > Administrative Tools > Local Security Policy. The Local Security Policy window appears.
 [bookmark: pgfId-1065242] b. Click Local Polices > Security Options.
 [bookmark: pgfId-1065243] c. Select System cryptography: Use FIPS compliant algorithms for encryption, hashing, and signing.
 [bookmark: pgfId-1065244] d. Right-click the selected policy and click Properties.
 [bookmark: pgfId-1065245] e. Select Enabled or Disabled to enable or disable FIPS compliant algorithms.
 [bookmark: pgfId-1065281] f. Click Apply.
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        	[bookmark: pgfId-1066259] 12. Disable Internet Explorer Enhanced Security Configuration (IE ESC). This needs to be done because client download is prevented by IE ESC. 
 [bookmark: pgfId-1066260]Procedure
 [bookmark: pgfId-1066261]To disable IE ESC on the server where you are preparing to install Security Manager, follow these steps: 
 [bookmark: pgfId-1066262] a. In Windows, open Server Manager. You can do this by right-clicking Computer and then clicking Manage. 
 [bookmark: pgfId-1066263] b. Under Security Information, click Configure IE ESC and then turn off IE ESC. 
  
       
 
        
        	[bookmark: pgfId-1069123]
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        	[bookmark: pgfId-1069129] 13. Disable port scanner software. Security Manager uses predefined and dynamic ports for its internal operation. Port Scanners might block these ports and will not allow Security Manager to execute those processes.Therefore port scanners like Qualys should not be enabled. If enabled, it may result in a Security Manager process crash which in turn may require a complete reinstallation of Security Manager.
  
       
 
       
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1050709][bookmark: 40063]Installing and Upgrading Server Applications[bookmark: marker-1074717] 
      
      
 
     
 
 
    [bookmark: pgfId-1053035]This chapter explains how to install the Security Manager server software and other server applications, namely CiscoWorks Common Services and AUS.
 
     
     	 [bookmark: pgfId-1053709]Understanding the Required Server User Accounts
 
     	 [bookmark: pgfId-1053746]Using Remote Desktop Connection or VNC To Install Server Applications
 
     	 [bookmark: pgfId-1053757]Installing Security Manager Server, Common Services, and AUS
 
     	 [bookmark: pgfId-1065599]Upgrading Server Applications
 
     	 [bookmark: pgfId-1069291]Migrating Security Manager to a New Computer or Operating System
 
     	 [bookmark: pgfId-1065603]Updating Security Manager
 
     	 [bookmark: pgfId-1056752]Obtaining Service Packs and Point Patches
 
     	 [bookmark: pgfId-1061446]Uninstalling Server Applications
 
     	 [bookmark: pgfId-1075171]Downgrading Server Applications
 
    
 
   
 
    
     [bookmark: pgfId-1101400][bookmark: 81254]Understanding the Required Server User Accounts[bookmark: marker-1101399]
 
    [bookmark: pgfId-1101401]CiscoWorks Common Services and Security Manager use a multilevel security system that allows access to certain features only to users who have the required authorization. For this reason, there are three predefined user accounts that are created on any system on which you install an application that runs on top of Common Services: 
 
     
     	 [bookmark: pgfId-1080171] admin [bookmark: marker-1080170] — The admin user account is equivalent to a Windows administrator and provides access to all Common Services, Security Manager, and other application tasks. You must enter the password during installation. You can use this account to initially log in to the server and to create other user accounts for normal day-to-day use of the applications.
 
     	 [bookmark: pgfId-1053822] casuser [bookmark: marker-1053821] — The casuser user account is equivalent to a Windows administrator and provides access to all Common Services and Security Manager tasks. You do not normally use this account directly. 
 
    
 
    [bookmark: pgfId-1067754]Do not modify casuser (the default service account) or directory permissions that are established during the installation of the product. Doing so can lead to problems with your being able to do the following: 
 
    [bookmark: pgfId-1067756] – Logging in to the web server 
 
    [bookmark: pgfId-1067757] – Logging in to the client 
 
    [bookmark: pgfId-1109490] – Performing successful backups of all databases 
 
    [bookmark: pgfId-1109491]The following five permissions are assigned and set, automatically, at the time of Security Manager installation:
 
    [bookmark: pgfId-1109642] – Access this computer from network - casusers
 
    [bookmark: pgfId-1109643] – Deny access to this computer from network - casuser
 
    [bookmark: pgfId-1109644] – Deny logon locally - casuser
 
    [bookmark: pgfId-1109645] – Log on as batch job - casuser, casusers
 
    [bookmark: pgfId-1109627] – Log on as a service – casuser
 
     
     	 [bookmark: pgfId-1109493]  [bookmark: marker-1109492] System Identity — The system identity user account is equivalent to a Windows administrator and provides access to all Common Services and Security Manager tasks. This account does not have a fixed name; you can create the account using whatever name fits your needs. If you create the account in Common Services, you must assign it system administrator privileges; if you use Cisco Secure Access Control Server (ACS) for user authentication, you must assign it all privileges. 
 
    
 
    [bookmark: pgfId-1053944]If you install Cisco Security Management suite applications on separate servers (the recommended approach), you must create the same system identity user account on all servers within the multi-server setup. Communication among your servers relies on a trust model that uses certificates and shared secrets. The system identity user is considered the trustworthy account by other servers in the multi-server setup and therefore facilitates communication between servers that are part of a domain.
 
    [bookmark: pgfId-1053828]You can create as many additional user accounts as needed. Each user should have a unique account. To create these additional accounts, you must have system administrator authority (for example, using the admin account). When you create a user account, you must assign it a role, and this role defines what the user can do in the applications, even to the extent of what the user can see. For more information on the various types of available permissions, and how to use ACS for controlling access to the applications, see Chapter8, “Managing User Accounts”
 
   
 
    
     [bookmark: pgfId-1054222][bookmark: 64594]Using Remote Desktop Connection or VNC To Install Server Applications[bookmark: marker-1074734] 
 
    [bookmark: pgfId-1054536]We recommend that you install server applications when you are logged directly in to the server. 
 
    [bookmark: pgfId-1054549]However, if you must perform a remote installation (logging in through another workstation), consider the following tips:
 
     
     	 [bookmark: pgfId-1054251]Do not attempt to install the software from a remote disk. The software installer must either be on the product DVD running on a DVD drive in the server, or the program must reside on a directly connected disk drive. The installation might appear to succeed from a remote disk, but it does not actually succeed. 
 
     	 [bookmark: pgfId-1054661]You can use Virtual Network Computing (VNC) to install the software. 
 
     	 [bookmark: pgfId-1058434]You can use Remote Desktop Connection to install the software. If you use Remote Desktop Connection, Cisco recommends using a Remote Desktop Protocol console session and not a non-console session. 
 
    
 
   
 
    
     [bookmark: pgfId-1053727][bookmark: 40199]Installing Security Manager Server, Common Services, and AUS[bookmark: marker-1074747]
 
    [bookmark: pgfId-1054896]The main Security Manager installation program can install the following applications: 
 
     
      
    
 
    
 
    [bookmark: pgfId-1108294]Note You cannot install the Cisco Security Manager bundle on a standalone Auto Update Server (AUS) installation. To install the Security Manager bundle, you must first uninstall AUS and then proceed to install the Security Manager bundle. 
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-1054901]CiscoWorks Common Services 4.2.2—This is the foundation software that is required by the server applications. Beginning with Security Manager 4.4, the CiscoWorks Common Services check box no longer appears on the component selection page; installation of Common Services is selected by default. 
 
     	 [bookmark: pgfId-1054908]Cisco Security Manager 4.9—This is the main server software for Security Manager. 
 
     	 [bookmark: pgfId-1054923]Auto Update Server 4.9—This is a web-based interface for upgrading device configuration files and software images on PIX firewalls and Adaptive Security Appliances (ASA) that use the auto update feature.
 
     	 [bookmark: pgfId-1054924]Cisco Security Manager client 4.9—The client software for interacting with the Security Manager server. You can install this on the same computer as the server, but you should not use this setup as the regular way of using Security Manager. For more information on recommended client installation and setup, see Chapter6, “Installing and Configuring the Client” 
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1091713]Tip Beginning with Security Manager 4.4, AUS and the Security Manager client are installed in parallel to improve installation time.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1091706]Use the following procedure to install or re-install these applications. If you are upgrading from a previous version of any of these applications, before proceeding, see Upgrading Server Applications.
 
    [bookmark: pgfId-1054822]Before You Begin
 
     
     	 [bookmark: pgfId-1083172]Refer to the  “Licensing”  chapter of this installation guide
 
     	 [bookmark: pgfId-1081068]If you are installing the product as an upgrade to an existing version of the application that is already installed on the server, run a backup as described in Backing Up the Database for Remote Upgrades. Ensure that the backup completes successfully, and that your existing applications are functioning normally before installing an upgrade.
 
     	 [bookmark: pgfId-1081308]When installing a permanent license for Security Manager, you must stage the license file on a disk that is local to your Security Manager server. The license file must be on the server to select it during installation, because Security Manager does not see mapped drives if you use it to browse directories on your server. (Windows imposes this limitation, which serves to improve Security Manager performance and security.) Do not place the file in any folder in which you will install the product. 
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1081315]Note The path to the license file must not contain special characters such as the ampersand (&).
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-1081312]Ensure that you go through the Readiness Checklist for Installation.
 
     	 [bookmark: pgfId-1055045]Ensure that the server meets the requirements listed in  Server Requirements and Recommendations, page 3-4 .
 
     	 [bookmark: pgfId-1066188]We recommend that you install Security Manager on a dedicated server in a controlled environment. Installing other software applications can interfere with the normal operation of Security Manager and is not supported.
 
     	 [bookmark: pgfId-1066193]Do not change the system time after installing Common Services. Such changes might affect the working of some time-dependent features.
 
     	 [bookmark: pgfId-1055334]If you want to use Cisco Secure Access Control Server (ACS) to provide AAA services for user access to Security Manager or AUS, wait until you install the applications before you configure Common Services to use ACS. For information on configuring ACS control, see Integrating Security Manager with Cisco Secure ACS.[bookmark: marker-1061674]
 
    
 
    [bookmark: pgfId-1055338]If you install Security Manager or AUS after configuring Common Services to use ACS, you are told during installation that the application that you are installing requires new tasks to be registered with ACS. Select Yes if you have not already registered the application (on this or another server) with ACS. If you have already registered the application, if you select Yes, you lose any customized user roles configured in ACS for the application, so you should select No. All Security Manager and AUS servers that use the same ACS server share user roles.
 
    [bookmark: pgfId-1067943]Procedure
 
    [bookmark: pgfId-1067944]To install Security Manager Server, Common Services, AUS, or more than one of these applications using the main Security Manager installation program, follow these steps:
 
    
 
    [bookmark: pgfId-1067945]Step 1 Obtain or locate the installation program. You can do any of the following:
 
     
     	 [bookmark: pgfId-1055151]Insert the Security Manager installation DVD into the server’s DVD drive. If the installation application does not automatically start, run the  Setup.exe file in the  csm  <version>  _win_server folder.
 
     	 [bookmark: pgfId-1055152]Log in to your Cisco.com account and go to the Security Manager home page at  http://www.cisco.com/go/csmanager . Click  Download Software and download the compressed installation file for Security Manager.
 
    
 
    [bookmark: pgfId-1055252] – Using your choice of file compression utilities, such as WinZip or the Compressed (zipped) Folders Extraction Wizard, which is provided with operating systems supported by Security Manager 4.9, extract all the files in the compressed software installation file to a temporary directory. Use a directory that does not have an excessively long path name; for instance, “C:\CSM” is a better choice than “C:\Cisco_Security_Manager\server\installation_directory.” Start the installation program, Setup.exe, which normally unzips to the same directory as the compressed file.
 
    [bookmark: pgfId-1055298] – If an error message states that the file contents cannot be unpacked, we recommend that you empty the Temp directory, scan for viruses, delete the C:\Program Files (x86)\Common Files\InstallShield directory, then reboot and retry.
 
    [bookmark: pgfId-1055461]Step 2 Follow the installation wizard instructions. During installation, you are asked for the following information:
 
     
      
      	 [bookmark: pgfId-1055447]Backup location—If some version of Common Services, Security Manager, or AUS is already installed, the installation program allows you to perform a database backup during the installation. If you elect to perform the backup, select the location to use for the backup. However, it is typically better practice to perform a backup before starting the installation. 
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1090072]Note The location that you select to use for the backup must be outside NMSROOT. The location NMSROOT is the path to the Security Manager installation directory. The default is C:\Program Files (x86)\CSCOpx. In particular, note that NMSROOT\backup must not be used for the backup. 
 
     
     
 
    
 
    
 
     
      
      	 [bookmark: pgfId-1092062]Destination folder—The folder in which you want to install the application. Accept the default unless you have a compelling reason to install it elsewhere. If you specify a folder other than the default folder, make sure that it does not contain any files and that it has fewer than 256 characters in its pathname. Also, if you specify a folder other than the default folder, the path must not contain any special characters. 
 The Windows Server 2012 R2 disables 8dot3 name generation on non-system drives, therefore user cannot select the Program Files (x86) folder on non-system drive paths. As a result, after setting the 8dot3 notation, the user must restart the server. Short names will not be created for existing folders after you enable 8dot3 naming on the specific drive; you must remove and recreate the folders, after a restart in order to force the short names to be created. If the existing folder was not empty, make sure that you select a new folder to proceed with installation.
 
      	 [bookmark: pgfId-1091927]Applications—The applications you want to install—Security Manager, AUS, or both. CiscoWorks Common Services 4.2.2 is installed automatically when you install Security Manager or AUS.
 
      	 [bookmark: pgfId-1055563]License information—Select one of the following: 
 
     
 
    
 
    [bookmark: pgfId-1055378] – License File Location—Enter the full pathname of the license file or click Browse to find it. You can specify the permanent license file if you have previously staged it on the server. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1081179]Note The path to the license file must not contain special characters such as the ampersand (&).
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1055379] – Evaluation Only—Enables the free 90-day evaluation period. 
 
     
      
      	 [bookmark: pgfId-1055620]Admin password—The password for the  admin user account, at least 5 characters. For more information on this and the system identity and casuser accounts, see Understanding the Required Server User Accounts.
 
      	 [bookmark: pgfId-1055651]System Identity user—The username and password for the account you want to use as the system identity user. When installing Cisco Security Management Suite applications on multiple servers, use the same system identity user account on all servers. 
 
      	 [bookmark: pgfId-1055673]Create casuser—Whether to create the casuser account on new installations. You must create this user account. 
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1090225]Note If you have security policies on password complexity restrictions, this account creation may not succeed. In such cases, you need to manually create the casuser account (see further instructions for the casuser password in Table A-3, Causes and Workarounds for LiaisonServlet Error). 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1055701]Step 3 After the installation is complete, restart the server if it does not restart automatically.
 
    [bookmark: pgfId-1103888]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1056268][bookmark: 25804][bookmark: 10859][bookmark: 59159]Upgrading Server Applications[bookmark: marker-1074777]
 
    [bookmark: pgfId-1055852]Application upgrade refers to the process of installing a newer version of an application while preserving the data from the older version. There are three types of upgrade paths:
 
     
     	 [bookmark: pgfId-1056778][bookmark: marker-1067001]Local—You simply install the newer version on the same server that is running the old version without first uninstalling the old version. Your existing data is maintained and available in the newly installed version. Keep the following in mind when doing local upgrades:
 
    
 
    [bookmark: pgfId-1069856] – Before you use this method, ensure that all applications that you are upgrading are functioning correctly. Also, perform a backup of the database and ensure that it completes successfully before installing the upgraded applications.
 
    [bookmark: pgfId-1100942] – You cannot use this method if you are also upgrading the operating system on the server, for example, upgrading from Microsoft Windows Server 2008 R2 with SP1 Enterprise—64-bit to Microsoft Windows Server 2012 Standard—64-bit. If you are performing a Security Manager upgrade while also performing an operating system upgrade, use the remote backup/restore upgrade method instead. If you are upgrading the operating system while maintaining the same Security Manager release, follow the procedure described in Migrating Security Manager to a New Computer or Operating System. 
 
    [bookmark: pgfId-1092231] – An error message will pop up if there is any database migration error; this will be at a point where installation can be taken forward without stopping. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1088856]Note During local upgrade, the installer checks to see if Performance Monitor or Resource Manager Essentials is installed. If one or both of them are found, the installer exits with an error message stating that Performance Monitor or Resource Manager Essentials (or both) needs to be uninstalled.
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-1056830][bookmark: marker-1067002]Remote ([bookmark: marker-1067003]backup/restore)—You install the newer version on a clean server (one that does not have the older application installed) and you then restore the database from a backup created from the older version. Use this procedure if you want to install on a new server or if you prefer to clean off your server before doing an installation (in which case you create the backup before uninstalling the application).
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1058229]Note Before creating a backup of a server that is running the Security Manager server application, you must ensure that all pending data is committed. See Ensuring Security Manager Pending Data is Submitted and Approved.
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-1056867][bookmark: marker-1067004]Indirect—If you have an older version of the application that is not supported for local or remote upgrade, you must perform a two-step process. First, you upgrade to a version that is supported for local or remote upgrade, then you perform the local or remote upgrade. Download the interim version from Cisco.com.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1099880]Note A special note applies to all indirect upgrades with event management enabled (Configuration Manager > Tools > Security Manager Administration... > Event Management > [Event Management group] > Enable Event Management. Under these conditions, a detailed view of an event (Launch > Event Viewer > Event Details > Details) will throw an error. The root cause of this error is restoring an old version of the event database followed by loading the event data. To work around this problem, identify all of your old partitions (the ones containing event data generated before your indirect upgrade) and move them to the secondary partition (“Extended Data Store Location” in the Security Manager GUI at Configuration Manager > Tools > Security Manager Administration... > Event Management). 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1062866]If your version is not listed for indirect upgrade in the following table, you need to do three or more interim upgrade steps if you want to preserve your older data. For example, to upgrade from Security Manager 3.0.x, you need to upgrade to 3.2.2, and then follow the indirect upgrade path to upgrade from 3.2.2 to 4.9.
 
    [bookmark: pgfId-1078634]Table 5-1 explains the software versions that are supported for each upgrade path.
 
     
      
       
       [bookmark: pgfId-1082484]Table 5-1 [bookmark: 66663]Application Upgrade Paths 
 
       
       
        
        	 
          
          [bookmark: pgfId-1082492]Upgrade Path 
         
  
        	 
          
          [bookmark: pgfId-1082494]Applications 
         
  
        	 
          
          [bookmark: pgfId-1082496]Supported Older Versions 
         
  
        	 
          
          [bookmark: pgfId-1082498]Upgrade Procedure 
         
  
       
 
        
        	 [bookmark: pgfId-1082500]Local 
  
        	 [bookmark: pgfId-1082502]Security Manager 4.9
 [bookmark: pgfId-1082503]Auto Update Server 4.9
  
        	 [bookmark: pgfId-1082505]4.7 and 4.8
  
        	 [bookmark: pgfId-1082509] 1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and Approved.
 [bookmark: pgfId-1082513] 2. Then, install the software; see Installing Security Manager Server, Common Services, and AUS.
 [bookmark: pgfId-1082515] 3. Finally, make any required post-upgrade changes; see Making Required Changes After Upgrade.
  
       
 
        
       
 
        
        	 [bookmark: pgfId-1082558]Remote 
  
        	 [bookmark: pgfId-1082560]Security Manager 4.9
 [bookmark: pgfId-1082561]Auto Update Server 4.9
  
        	 [bookmark: pgfId-1089001]4.7 and 4.8
  
        	 [bookmark: pgfId-1090289] 1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and Approved.
 [bookmark: pgfId-1090277] 2. Back up the database; see Backing Up the Database for Remote Upgrades.
 [bookmark: pgfId-1082569] 3. Install the application, see:
 [bookmark: pgfId-1082572]Installing Security Manager Server, Common Services, and AUS
 [bookmark: pgfId-1082582] 4. If necessary, transfer the database backup to the server.
 [bookmark: pgfId-1082585] 5. Recover the database; see Restoring the Server Database.
 [bookmark: pgfId-1082587] 6. Finally, make any required post-upgrade changes; see Making Required Changes After Upgrade.
  
       
 
        
       
 
        
       
 
        
        	[bookmark: pgfId-1104246]Indirect 
  
        	[bookmark: pgfId-1104248]Security Manager 4.9
  
        	[bookmark: pgfId-1104250]4.5, 4.6
  
        	[bookmark: pgfId-1104254] 1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and Approved 
 [bookmark: pgfId-1104256] 2. Next, upgrade to 4.7, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.6. 
 [bookmark: pgfId-1104258] 3. Finally, upgrade to 4.9 and carefully follow the data migration instructions in this installation guide’s chapter on upgrade for 4.9.
  
       
 
        
        	[bookmark: pgfId-1104264]Indirect 
  
        	[bookmark: pgfId-1104266]Security Manager 4.9
  
        	[bookmark: pgfId-1104268]4.1, 4.2, 4.3
  
        	[bookmark: pgfId-1104272] 1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and Approved 
 [bookmark: pgfId-1104274] 2. Next, upgrade to 4.4, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.4.
 [bookmark: pgfId-1104276] 3. Next, upgrade to 4.6, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.6.
 [bookmark: pgfId-1107922] 4. Next, upgrade to 4.7, being careful to follow the data migration instruction in the installation guide’s chapter on upgrade for 4.7.
 [bookmark: pgfId-1104278] 5. Finally, upgrade to 4.9 and carefully follow the data migration instructions in this installation guide’s chapter on upgrade for 4.9. 
  
       
 
        
        	[bookmark: pgfId-1104482]Indirect 
  
        	[bookmark: pgfId-1104484]Security Manager 4.9
  
        	[bookmark: pgfId-1104486]4.0, 4.0.1
  
        	[bookmark: pgfId-1104490] 1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and Approved 
 [bookmark: pgfId-1104492] 2. Next, upgrade to 4.3, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.3. 
 [bookmark: pgfId-1104494] 3. Next, upgrade to 4.5, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.5.
 [bookmark: pgfId-1104496] 4. Next, upgrade to 4.6, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.6.
 [bookmark: pgfId-1108068] 5. Next, upgrade to 4.7, being careful to follow the data migration instruction in the installation guide’s chapter on upgrade for 4.7.
 [bookmark: pgfId-1104498] 6. Finally, upgrade to 4.9 and carefully follow the data migration instructions in this installation guide’s chapter on upgrade for 4.9.
  
       
 
        
        	[bookmark: pgfId-1082608]Indirect 
  
        	[bookmark: pgfId-1082610]Security Manager 4.9
  
        	[bookmark: pgfId-1082612]3.3.x
  
        	[bookmark: pgfId-1097334] 1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and Approved.
 [bookmark: pgfId-1103228] 2. Next, perform a remote upgrade to 4.2, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.2. 
 [bookmark: pgfId-1104088] 3. Next, upgrade to 4.4, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.4.
 [bookmark: pgfId-1104090] 4. Next, upgrade to 4.6, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.6.
 [bookmark: pgfId-1108093] 5. Next, upgrade to 4.7, being careful to follow the data migration instruction in the installation guide’s chapter on upgrade for 4.7.
 [bookmark: pgfId-1104092] 6. Finally, upgrade to 4.9 and carefully follow the data migration instructions in this installation guide’s chapter on upgrade for 4.9. 
  
       
 
        
        	[bookmark: pgfId-1096866]Indirect 
  
        	[bookmark: pgfId-1096868]Security Manager 4.9
  
        	[bookmark: pgfId-1096870]3.2.x (3.2.2 only)
  
        	[bookmark: pgfId-1096874] 1. Commit any pending data; see Ensuring Security Manager Pending Data is Submitted and Approved.
 [bookmark: pgfId-1103158] 2. Next, upgrade to 4.0, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.0.
 [bookmark: pgfId-1104628] 3. Next, upgrade to 4.3, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.3. 
 [bookmark: pgfId-1104630] 4. Next, upgrade to 4.5, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.5.
 [bookmark: pgfId-1104632] 5. Next, upgrade to 4.6, being careful to follow the data migration instructions in the installation guide’s chapter on upgrade for 4.6.
 [bookmark: pgfId-1108116] 6. Next, upgrade to 4.7, being careful to follow the data migration instruction in the installation guide’s chapter on upgrade for 4.7.
 [bookmark: pgfId-1110011] 7. Finally, upgrade to 4.9 and carefully follow the data migration instructions in this installation guide’s chapter on upgrade for 4.9.
  
       
 
       
     
 
    
 
     
      [bookmark: pgfId-1111517][bookmark: 58702]Ensuring Security Manager Pending Data is Submitted and Approved[bookmark: marker-1111516]
 
     [bookmark: pgfId-1110514]Before you can successfully upgrade Security Manager, you must ensure that the existing Security Manager database does not contain any pending data, which is data that has not been committed to the database. You cannot restore a database from an earlier version of Security Manager if it has pending data; you can only restore a database that has pending data on a system running the same version as the backup. 
 
     [bookmark: pgfId-1058583]Each user must submit or discard changes. If you are using Workflow mode with an approver, these submissions must also be approved. You might want to also perform a deployment after all data is committed so that all device configurations are synchronized with the Security Manager database.
 
      
      	 [bookmark: pgfId-1058542]In non-Workflow mode: 
 
     
 
     [bookmark: pgfId-1058543] – To commit changes, select File > Submit.
 
     [bookmark: pgfId-1058544] – To discard uncommitted changes, select File > Discard.
 
     [bookmark: pgfId-1058548] – If you need to commit or discard changes for another user, you can take over that user’s session. To take over a session, select Tools > Security Manager Administration > Take Over User Session, select the session, then click Take Over Session.
 
      
      	 [bookmark: pgfId-1058549]In Workflow mode:
 
     
 
     [bookmark: pgfId-1058550] – To commit and approve changes, select Tools > Activity Manager. From the Activity Manager window, select an activity and click Approve. If you are using an activity approver, click Submit and have the approver approve the activity.
 
     [bookmark: pgfId-1058552] – To discard uncommitted changes, select Tools > Activity Manager. From the Activity Manager window, select the activity, then click Discard. Only an activity in the Edit or Edit Open state can be discarded.
 
    
 
     
      [bookmark: pgfId-1057091]Restoring Changes that You Made to Property Files 
 
     [bookmark: pgfId-1068364]All Security Manager installations have some [bookmark: marker-1068591]property files that contain data that you usually change during use:
 
      
      	 [bookmark: pgfId-1068366] $NMSROOT \MDC\athena\config\csm.properties
 
      	 [bookmark: pgfId-1068368] $NMSROOT \MDC\athena\config\DCS.properties
 
      	 [bookmark: pgfId-1068370] $NMSROOT \MDC\athena\config\taskmgr.prop 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1068475]Tip $NMSROOT is the full pathname of the Common Services installation directory [the default is C:\Program Files (x86)\CSCOpx].
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1068375]If you run an upgrade or install a service pack on your current installation, Security Manager does the following:
 
      
      	 [bookmark: pgfId-1068377]Installs new files in association with the upgrade or service pack.
 
      	 [bookmark: pgfId-1068379]Compares the new files with the files that you modified during use.
 
      	 [bookmark: pgfId-1068341]Warns you if the new files are different from the files that you changed during use. If they are, Security Manager does the following:
 
     
 
     [bookmark: pgfId-1068556] – Stores the files that you changed during use, naming them <filename>.org. 
 
     [bookmark: pgfId-1068570] – Stores diff files for your convenience, naming them <filename>.diff.
 
     [bookmark: pgfId-1068743]If you receive a warning about new files being different from the files that you modified during use, use the information in <filename>.org and <filename>.diff to restore the changes that you made to property files before upgrade or service pack installation.
 
    
 
     
      [bookmark: pgfId-1105266]Editing the csm.properties File After a Remote Upgrade
 
     [bookmark: pgfId-1105345]After a remote upgrade, you must edit the csm.properties file to include newly added properties. Follow these steps:
 
     
 
     [bookmark: pgfId-1105488]Step 1 From $NMSROOT\MDC\athena\config\ subdirectory, open csm.properties in a text editor, such as Notepad.
 
     [bookmark: pgfId-1105558]($NMSROOT is the full pathname of the Common Services installation directory [the default is C:\Program Files (x86)\CSCOpx])
 
     [bookmark: pgfId-1105584]Step 2 Add the following content to the end of the csm.properties file. 
 
     [bookmark: pgfId-1105674]##
 
     [bookmark: pgfId-1105675]# Customize Activity Report Generation
 
     [bookmark: pgfId-1105676]##
 
     [bookmark: pgfId-1105677]# Report generation timeout in minutes
 
     [bookmark: pgfId-1105678]# Set to 10 minutes by default
 
     [bookmark: pgfId-1105679]#generate_activity_report_timeout=10
 
     [bookmark: pgfId-1105680]# Generate PDF Report
 
     [bookmark: pgfId-1105681]#generate_activity_pdf_report=true
 
     [bookmark: pgfId-1105682]# Generate HTML Report
 
     [bookmark: pgfId-1105683]#generate_activity_html_report=false
 
     [bookmark: pgfId-1105684]#
 
     [bookmark: pgfId-1105685]#CSCup28957::This will allow user to exclude the list of operation rows in all applicable policies from activity change report. 
 
     [bookmark: pgfId-1105686]#excluded operations should be in comma separated and if it is empty or commented then it will include all operations.
 
     [bookmark: pgfId-1105687]#excluded operations::Add,Delete,Modify,Move,ReOrder,Assign,UnAssign. These names should not be modified.
 
     [bookmark: pgfId-1105688]#By default it is empty,if we need to exclude operation then add required excluded operation.
 
     [bookmark: pgfId-1105689]#ex: 1.ActChangeReport.excludedOperations=ReOrder, 2.ActChangeReport.excludedOperations=Add,ReOrder , 3.ActChangeReport.excludedOperations=Add,Modify,Move,ReOrder
 
     [bookmark: pgfId-1105657]ActChangeReport.excludedOperations=
 
      
       
     
 
     
 
     [bookmark: pgfId-1107118]Note The above lines of code are commented by default. If you want to use the default values or modify the values of a particular property in the file, you must first uncomment the given line of code. For example, if you want Security Manager to generate Activity Reports in PDF format, you must change the given property as follows:
 
     [bookmark: pgfId-1107163]# Generate PDF Report
 
     [bookmark: pgfId-1107119]generate_activity_pdf_report=true
 
     [bookmark: pgfId-1107120]Step 3 Save, and then close, the edited file.
 
     [bookmark: pgfId-1107408]Step 4 Restart the Cisco Security Manager Daemon Manager service from Start > Programs > Administrative Tools > Services.
 
    
 
     
      [bookmark: pgfId-1068328][bookmark: 24442]Backing Up the Database for Remote Upgrades[bookmark: marker-1074799]
 
     [bookmark: pgfId-1058726]CiscoWorks Common Services manages the database for all server applications, and it is the Common Services backup/restore utilities that are used for backing up and restoring the database. Thus, when you create a backup, you are creating a backup for all CiscoWorks applications installed on the server. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1096729]Note Beginning with Security Manager 4.4, a new attribute, PURGE_DBBACKUP_LOG, has been added to the backup.properties file; it has a default value of 20, meaning that backups will be purged after 20 days. If this new attribute is set to NIL, then backups will not be purged. The dbbackup.log is created with a timestamp format of dbbackup_[YYYY-MM-DD_HH-mm-ss].log. At any point of time, a minimum of 5 dbbackup.log files will be maintained irrespective of purge configuration. 
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1096730]Note To back up the database, the Short Date format should be either M/d/YYYY or M/d/yy. To change the Short Date format to either M/d/YYYY or M/d/yy, select Start > Control Panel > Region and Language > Formats > Short Date, and then change the Short Date format to either M/d/YYYY or M/d/yy. 
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1096731]Tip The backup procedure backs up the database only. If you need to back up the event data store, use the data store copy steps described in Migrating Security Manager to a New Computer or Operating System.
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-1058860]Step 1 If you are backing up a server that is running Security Manager, you can get to the backup page using a shortcut in the Security Manager client: Tools > Backup. Also, ensure that pending data is committed (see Ensuring Security Manager Pending Data is Submitted and Approved).
 
     [bookmark: pgfId-1062353]For servers that are not running Security Manager, to get to the backup page: 
 
     [bookmark: pgfId-1062356] a. Log in to the Cisco Security Management Server desktop on the server (see Logging In to Server Applications Using a Web Browser).
 
     [bookmark: pgfId-1062358] b. Click the Server Administration panel. Then select Server > Admin > Backup.
 
     [bookmark: pgfId-1058753]Step 2 Select Immediate for Frequency, complete the other fields as desired, and click Apply to back up your data.
 
     [bookmark: pgfId-1062635]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1062669][bookmark: 23222]Backing Up the Server Database By Using the CLI[bookmark: marker-1074804]
 
     [bookmark: pgfId-1062670]The procedure in this section describes how to back up the server database by executing a script from the Windows command line on the server. 
 
     [bookmark: pgfId-1064609]While backing up the database, both Common Services and Security Manager processes will be shut down and restarted. Because Security Manager can take several minutes to fully restart, users might be able to start their client before the restart is complete. If this happens, they might see the message “error loading page” in device policy windows. 
 
     [bookmark: pgfId-1064582]A single backup script is used to back up all applications installed on a CiscoWorks server; you cannot back up individual applications. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1070146]Tip The backup command backs up the database only. If you need to back up the event data store, use the data store copy steps described in Migrating Security Manager to a New Computer or Operating System.
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-1064585]Step 1 Ensure that pending data is committed (see Ensuring Security Manager Pending Data is Submitted and Approved). 
 
     [bookmark: pgfId-1090500]Step 2 At a command prompt, enter net stop crmdmgtd to stop all processes. 
 
     [bookmark: pgfId-1064657]Step 3 Back up the database by entering the following command: 
 
     [bookmark: pgfId-1064041]$NMSROOT\bin\perl $NMSROOT\bin\backup.pl backup_directory [log_filename [email=email_address [number_of_generations [compress]]]]
 
     [bookmark: pgfId-1062677]where: 
 
      
      	 [bookmark: pgfId-1062678]$NMSROOT—The full pathname of the Common Services installation directory [the default is C:\Program Files (x86)\CSCOpx]. 
 
      	 [bookmark: pgfId-1062680] backup_directory —The directory where you want to create the backup. For example, C:\Backups. 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1097590]Note The location that you select to use for the backup must be outside NMSROOT. The location NMSROOT is the path to the Security Manager installation directory. The default is C:\Program Files (x86)\CSCOpx. In particular, note that NMSROOT\backup must not be used for the backup. 
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1097591]Note The backup directory should not contain any special characters. 
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1097592] log_filename —(Optional) The log file for messages generated during backup. Include the path if you want it created somewhere other than the current directory. For example, C:\BackupLogs. If you do not specify a name, the log is  $NMSROOT \log\dbbackup.log. 
 
      	 [bookmark: pgfId-1064249] email=  email_address —(Optional) The email address where you want notifications sent. If you do not want to specify an email address, but you need to specify a subsequent parameter, enter  email without the equal size or address. You must configure SMTP settings in CiscoWorks Common Services to enable notifications. 
 
      	 [bookmark: pgfId-1064278] number_of_generations —(Optional) The maximum number of backup generations to keep in the backup directory. When the maximum is reached, old backups are deleted. The default is 0, which does not limit the number of generations kept. 
 
      	 [bookmark: pgfId-1064299] compress —(Optional) Whether you want the backup file to be compressed. If you do not enter this keyword, the backup is not compressed if VMS_FILEBACKUP_COMPRESS=NO is specified in the backup.properties file. Otherwise, the backup is still compressed. We recommend compressing backups. 
 
     
 
     [bookmark: pgfId-1064459]For example, the command shown below assumes that you are in the directory containing the perl and backup.pl commands. (When you are in that directory, though, you must still specify the entire path of perl and backup.pl, fully qualified in the DOS 8.1 format with no spaces.) 
 
     [bookmark: pgfId-1090642]The command shown below creates a compressed backup and log file in the backups directory and sends notifications to admin@domain.com. 
 
     [bookmark: pgfId-1090583]When you use the backup.pl command, you must specify a backup generation if you want to include the compress parameter. 
 
     [bookmark: pgfId-1090774]If you specify any parameter after the log file parameter, you must include values for all preceding parameters. 
 
     [bookmark: pgfId-1090806]In this example, $NMSROOT is D:\CSM, not the default value of C:\Program Files (x86)\CSCOpx. 
 
     [bookmark: pgfId-1064460]D:\CSM\bin\perl D:\CSM\bin\backup.pl C:\backups C:\backups\backup.log email=admin@domain.com 0 compress 
 
     [bookmark: pgfId-1064566]Step 4 Examine the log file to verify that the database was backed up. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1115477]Note If Security Manager restarts unexpectedly during the database backup process, the backup is interrupted and a backup lock file backup.lock is created in the NMSROOT directory. Delete the backup.lock file to proceed with backup.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1090499]Step 5 At a command prompt, enter net start crmdmgtd to restart all processes. 
 
     [bookmark: pgfId-1064569]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1062642][bookmark: 82775]Restoring the Server Database[bookmark: marker-1074809]
 
     [bookmark: pgfId-1062639]You can restore your database by running a script from the command line. You have to shut down and restart CiscoWorks while restoring data. This procedure describes how you can restore the backed up database on your server. A single backup and restore facility exists to back up and restore all applications installed on a CiscoWorks server; you cannot back up or restore individual applications. 
 
     [bookmark: pgfId-1059796]If you install the applications on multiple servers, ensure that you recover the database backup that contains data appropriate for the installed applications.
 
     [bookmark: pgfId-1070178]Tips
 
      
      	 [bookmark: pgfId-1068006]You can restore backups taken from previous releases of the application if the backup is from a version supported for direct local inline upgrade to this version of the application. For information on which versions are supported for upgrade, see Upgrading Server Applications.
 
      	 [bookmark: pgfId-1070203]The restore command restores the database only. If you need to restore the event data store, use the data store copy steps described in Migrating Security Manager to a New Computer or Operating System.
 
     
 
     [bookmark: pgfId-1068022]Procedure
 
     
 
     [bookmark: pgfId-1069338]Step 1 Stop all processes by entering the following at the command line: 
 
     [bookmark: pgfId-1069339]net stop crmdmgtd 
 
     [bookmark: pgfId-1069340]Step 2 Restore the database by entering the following command: 
 
     [bookmark: pgfId-1067569]$NMSROOT\bin\perl $NMSROOT\bin\restorebackup.pl [-t temporary_directory]
[-gen generationNumber] -d backup_directory [-h]
 
     [bookmark: pgfId-1067570]where: 
 
      
      	 [bookmark: pgfId-1067571]$NMSROOT—The full pathname of the Common Services installation directory [the default is C:\Program Files (x86)\CSCOpx]. 
 
      	 [bookmark: pgfId-1059735] -t  temporary_directory —(Optional) This is the directory or folder used by the restore program to store its temporary files. By default this directory is  $NMSROOT \tempBackupData. 
 
      	 [bookmark: pgfId-1068076] -gen  generationNumber —(Optional) The backup generation number you want to recover. By default, it is the latest generation. If generations 1 through 5 exist, 5 will be the latest. 
 
      	 [bookmark: pgfId-1068077] -d  backup_directory —The backup directory that contains the backup to restore. 
 
      	 [bookmark: pgfId-1059738] -h —(Optional) Provides help. When used with  -d  BackupDirectory , help shows the correct syntax along with available suites and generations. 
 
     
 
     [bookmark: pgfId-1085377]For example, to restore the most recent version from the c:\var\backup directory, enter the following command (note that this is for a 64-bit OS): 
 
     [bookmark: pgfId-1059740]C:\Progra~2\CSCOpx\bin\perl C:\Progra~2\CSCOpx\bin\restorebackup.pl -d C:\var\backup 
 
     [bookmark: pgfId-1059742]Step 3 Examine the log file, NMSROOT\log\restorebackup.log, to verify that the database was restored.
 
     [bookmark: pgfId-1059743]Step 4 Restart the system by entering:
 
     [bookmark: pgfId-1059744]net start crmdmgtd 
 
     [bookmark: pgfId-1059745]Step 5 If you restore a database that was backed up prior to installing a Security Manager service pack, you must reapply the service pack after restoring the database.
 
     [bookmark: pgfId-1059746]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1063082][bookmark: 27836]Making Required Changes After Upgrade[bookmark: marker-1074814]
 
     [bookmark: pgfId-1063102]Sometimes an application upgrade changes how particular types of information is handled in a way that requires that you make some manual changes. After upgrading to this version of the product, consider the following list of required changes and perform any that apply to your situation:
 
      
       
     
 
     
 
     [bookmark: pgfId-1104815]Note Please also refer to the Important Notes section of the release notes for this release for other important considerations that might apply to your installation of Security Manager after upgrade.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1063121]If you upgrade from any version earlier than 3.3.1, you must rediscover the inventory on any ASA 5580 device that includes a 4-port GigabitEthernet Fiber interface card (hardware type: i82571EB 4F). Inventory rediscovery overcomes a bug from previous releases that prevented changing speed nonnegotiate settings on the device. To rediscover inventory, right-click the device in Device view in the Security Manager client and select  Discover Policies on Device , then select  Live Device discovery and only the  Inventory check box in the Policies to Discover group. Rediscovery replaces the Interfaces policy on the device.
 
      	 [bookmark: pgfId-1065111]If you upgrade from 3.3.1 or lower versions, and you managed Cisco ASR 1000 Series Aggregation Services Routers that used unsupported shared port adapters (SPA), you should rediscover policies on those devices so that Security Manager can discover the SPAs that were supported starting with version 4.0. Newly supported SPAs include all Ethernet (all speeds), Serial, ATM, and Packet over Sonet (POS) shared port adapters (SPA), but not services SPAs. Rediscovery is required if you configured ATM, PVC, or dialer related policies in the device CLI.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1101025][bookmark: 25783]Migrating Security Manager to a New Computer or Operating System
 
     
      
    
 
    
 
    [bookmark: pgfId-1115882]Note Cisco is only responsible for licensing of the pre-installed Operating System that accompanies the Cisco Unified Computing System(UCS) bundle (which has Cisco Security Manger pre-installed). Customers upgrading their Operating System while migrating to Cisco Security Manager 4.9 or later, must buy the appropriate Windows license.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1115873]Certain circumstances might require you to move Security Manager to a new server. This move might be to a new physical machine, or you might want to perform a major upgrade to the operating system on the server (such as moving from Microsoft Windows Server 2008 R2 with SP1 Enterprise—64-bit to Microsoft Windows Server 2012 Standard—64-bit or to Microsoft Windows Server 2012 Datacenter—64-bit). 
 
    [bookmark: pgfId-1101153]When you are not changing the Security Manager version, but you are changing the physical hardware or the operating system, you need to go through a migration process. The migration process is essentially the same as the remote backup/restore upgrade process as described in Upgrading Server Applications; however, additional steps are required to migrate the data contained in the Event Manager data store. Use this procedure when you need to perform Security Manager server migration.
 
     
      
    
 
    
 
    [bookmark: pgfId-1069222]Note Minor service pack updates to an operating system are not considered upgrades when it comes to Security Manager server-migration requirements. Server migration is required when you are moving between different major versions of the operating system.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1069806]Before You Begin
 
    [bookmark: pgfId-1069823]This procedure assumes that you want the target server (the server to which you are moving Security Manager) to have the same database and event data store contents as the source computer. If you started using Security Manager on the target server, you cannot merge the database or event data store of the source and target systems: you must replace the target data with the source data. Any data that existed on the target system prior to the migration will become unusable after completing the migration. Do not attempt to copy the old target-system data into the newly-migrated folder.
 
    [bookmark: pgfId-1070320]Also note that the steps for copying and restoring the event data store are required only if you want to preserve this data. You can skip the steps if you want to start with a fresh empty event data store.
 
    
 
    [bookmark: pgfId-1069808]Step 1 Do the following on the source Security Manager server (the server from which you are migrating):
 
    [bookmark: pgfId-1069308] a. Determine the name of the event data store folder. Using the Security Manager client, select Tools > Security Manager Administration, and select Event Management from the table of contents. The folder is shown in the Event Data Store Location field; the default is NMSROOT\MDC\eventing\database, where NMSROOT is the installation directory [usually C:\Program Files (x86)\CSCOpx].
 
    [bookmark: pgfId-1069407] b. Stop all processes by entering the following at the command line: 
 
    [bookmark: pgfId-1069369]net stop crmdmgtd 
 
    [bookmark: pgfId-1069315] c. Make a copy of the NMSROOT\MDC\eventing\config\collector.properties file and the event data store folder. Place the copy on a disk where you can access it from the target computer.
 
    [bookmark: pgfId-1069316] d. Back up the Security Manager database using the command line method as described in Backing Up the Server Database By Using the CLI.
 
    [bookmark: pgfId-1069309]Step 2 Prepare the new target computer. For example:
 
     
     	 [bookmark: pgfId-1069525]If you are simply upgrading the operating system, but not moving to new hardware, perform the operating system upgrade and ensure that the operating system is functioning correctly. Then, install Security Manager.
 
     	 [bookmark: pgfId-1069554]If you are moving to a new computer, ensure that it is functioning correctly and install Security Manager.
 
    
 
    [bookmark: pgfId-1069486]Step 3 Do the following on the target Security Manager server:
 
    [bookmark: pgfId-1069606] a. Stop all processes by entering the following at the command line: 
 
    [bookmark: pgfId-1069607]net stop crmdmgtd 
 
    [bookmark: pgfId-1069562] b. Copy the backed up NMSROOT\MDC\eventing\config\collector.properties file from the source computer to the target server, overwriting the file on the target server.
 
    [bookmark: pgfId-1069632] c. If you did not restart processes after completing the database restore, restart them now:
 
    [bookmark: pgfId-1069645]net start crmdmgtd 
 
    [bookmark: pgfId-1069637] d. Use the Security Manager client to log into the new server, then select Tools > Security Manager Administration, and select Event Management from the table of contents.
 
    [bookmark: pgfId-1070439] e. Ensure that the event data store folder exists and that it is empty (delete files if necessary). The folder must have the same name and location as the event data store had on the source server.
 
    [bookmark: pgfId-1069638] f. Select the correct Event Data Store Location (if the default is not already the correct folder), and deselect the Enable Event Management check box to stop the Event Manager service. Click Save to save your changes. You are prompted to verify that you want to stop the service; click Yes, and wait until you are notified that the service has stopped.
 
    [bookmark: pgfId-1069710] g. Copy the event data store backed up from the source computer to the new location on the target server.
 
    [bookmark: pgfId-1069720] h. Using the Security Manager client, select Tools > Security Manager Administration, and select Event Management from the table of contents. Select the Enable Event Management check box and click Save. You are prompted to verify that you want to start the service; click Yes, and wait until you are notified that the service has started.
 
    [bookmark: pgfId-1069497]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1053144][bookmark: 36570]Updating Security Manager[bookmark: marker-1074819]
 
    [bookmark: pgfId-1053145]Although you can specify permanent license files during installation, you can also add licenses after you install Security Manager. AUS does not require a license.
 
    [bookmark: pgfId-1060838]Before You Begin
 
    [bookmark: pgfId-1060843]You must copy the license file to the server machine or to the client machine before adding it (the license) to the application. If you use the client machine, you must enable the client-side browser. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1081191]Note The path to the license file must not contain special characters such as the ampersand (&).
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1089049]Tip You can also apply a license while logging into Security Manager: Security Manager will prompt with the message “Upgrade license” or “Continue Evaluation.” By clicking “Upgrade License,” you can apply the license. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1053152]Procedure
 
    [bookmark: pgfId-1068035]To install a license for Security Manager, follow these steps: 
 
    
 
    [bookmark: pgfId-1060856]Step 1 Log in to the server using the Security Manager client application (see Logging In to Security Manager Using the Security Manager Client).
 
    [bookmark: pgfId-1060874]Step 2 Select Tools > Security Manager Administration and select Licensing from the table of contents.
 
    [bookmark: pgfId-1060924]Step 3 Click CSM if the tab is not active.
 
    [bookmark: pgfId-1060949]Step 4 Click Install a License to open the Install a License dialog box. Use this dialog box to select the license file and click OK. Repeat the process to add additional licenses.
 
     
      
    
 
    
 
    [bookmark: pgfId-1079330]Note The path and file name are restricted to characters in the English alphabet. Japanese characters are not supported. When selecting files on a Windows Japanese OS system, the usual file separator character \ is supported, although you should be aware that it might appear as the Yen symbol (U+00A5).
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1053162]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1061233][bookmark: 76537]Obtaining Service Packs and Point Patches[bookmark: marker-1074824]
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1061234] 
     Caution Do not download or open any file that claims to be a service pack or point patch for Security Manager unless you obtain it from Cisco. Third-party service packs and point patches are not supported. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1061235]After you install Security Manager or other applications, you might install a service pack or point patch from Cisco Systems to fix bugs, support new device types, or otherwise enhance the application. 
 
     
     	 [bookmark: pgfId-1061236]To learn when Cisco has prepared a new service pack, and to download any service pack that matters to you, open Security Manager, then select  Help > Security Manager Online . Alternatively, go to  http://www.cisco.com/go/csmanager .
 
     	 [bookmark: pgfId-1061238]If your organization submits a Cisco TAC service request, TAC will tell you if an unscheduled point patch exists that might solve the problem you have described. Cisco does not distribute Security Manager point patches in any other way.
 
    
 
    [bookmark: pgfId-1061239]Service packs and point patches provide server support for client software updates and detect version level mismatches between a client and its server.
 
   
 
    
     [bookmark: pgfId-1053165][bookmark: 95280]Uninstalling Server Applications[bookmark: marker-1074834][bookmark: marker-1074840]
 
    [bookmark: pgfId-1053166]Use this procedure to uninstall server applications. Before uninstalling an application, consider performing a backup so that you can recover your data if you decide to re-install the application. For information on performing backups, see Backing Up the Database for Remote Upgrades.
 
    [bookmark: pgfId-1053170]Before You Begin
 
    [bookmark: pgfId-1053171]If any version of Windows Defender is installed, disable it before you uninstall a server application. Otherwise, the uninstallation application cannot run.
 
    [bookmark: pgfId-1053172]Procedure
 
    [bookmark: pgfId-1068037]To uninstall server applications, follow these steps: 
 
    
 
    [bookmark: pgfId-1053174]Step 1 Select Start > Programs > Cisco Security Manager > Uninstall Cisco Security Manager. 
 
    [bookmark: pgfId-1088731]By default, all applications will be uninstalled. 
 
    [bookmark: pgfId-1088733]Step 2 The uninstaller removes all applications.
 
     
      
    
 
    
 
    [bookmark: pgfId-1053178]Note If the uninstallation causes an error, see Server Problems During Uninstallation, and the “Troubleshooting and FAQs” chapter in Installing and Getting Started With CiscoWorks LAN Management Solution 3.1: http://www.cisco.com/en/US/products/sw/cscowork/ps3996/prod_installation_guides_list.
html.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1053181]Step 3 [bookmark: marker-1053180]Although no reboot is required, we recommend that you reboot the server after an uninstallation so that Registry entries and running processes on the server are in a suitable state for a future re-installation. 
 
    [bookmark: pgfId-1053182]Step 4 Only if you uninstall all Cisco Security Management Suite applications, including Common Services:
 
    [bookmark: pgfId-1053183] a. If NMSROOT still exists, delete it, move it, or rename it. NMSROOT is the path to the Security Manager installation directory. The default value of NMSROOT is C:\Program Files (x86)\CSCOpx. Other values, such as E:\Program Files (x86)\CSCOpx, are possible as well. 
 
    [bookmark: pgfId-1053184] b. If the C:\CMFLOCK.TXT file exists, delete it.
 
    [bookmark: pgfId-1053185] c. Use a Registry editor to delete these Registry entries before you re-install the applications:
 
     
      
      	 [bookmark: pgfId-1053186]My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Cisco\Resource Manager
 
      	 [bookmark: pgfId-1053187]My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Cisco\MDC
 
     
 
    
 
    [bookmark: pgfId-1097051] d. Delete any folders under NMSROOT that were not deleted during uninstallation. 
 
    [bookmark: pgfId-1053188]Step 5 If you disabled Windows Defender before uninstalling the applications, re-enable it now.
 
    [bookmark: pgfId-1053189]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1075154][bookmark: 40448]Downgrading Server Applications[bookmark: marker-1075153]
 
    [bookmark: pgfId-1075155]You cannot downgrade Security Manager applications to earlier releases and preserve any configurations that you created in this release of the product. If you decide that you do not want to use this release of Security Manager, you can uninstall it and reinstall the desired older version of the product. (This assumes that you have the required licenses and installation media for the older version.) You can then restore the desired database backup that you saved from your previous installation of the downgraded version, as described in Restoring the Server Database.
 
    [bookmark: pgfId-1075159]If you downgrade Security Manager, you must also downgrade Auto Update Server to a version supported by the Security Manager version that you reinstall.
 
    [bookmark: pgfId-1075199]After you restore the old database, keep in mind that it might contain device properties and policies that are no longer synchronized with the current state of the managed devices. For example, you might have upgraded the operating system on the device to one that is not directly supported by the older version of Security Manager, or you might have configured, and deployed, policies that do not exist in the older version. To ensure that the database is synchronized with the devices, consider rediscovering device policies for all managed devices. Be aware that some major changes (such as a major operating system release upgrade) require that you remove the device from the inventory and add it again. In some cases, you might need to revert an operating system upgrade (for example, ASA Software release 8.3 requires special handling and cannot be supported in downward compatibility mode, therefore, the Security Manager version you use must support it directly). See the “Managing the Device Inventory” chapter in the User Guide for Cisco Security Manager for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-1075201]Tip If you try to manage a device and operating system release combination that the older version of Security Manager cannot manage, you will see deployment errors.
 
     
     
 
    
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1043281][bookmark: 70417]Installing and Configuring the Client[bookmark: marker-1121363] 
      
      
 
     
 
 
    [bookmark: pgfId-1112598]There are two main client applications that you use with Security Manager applications:
 
     
     	 [bookmark: pgfId-1112618]The Security Manager client. This is a client-server application that is installed on your workstation and that interacts with the database running on the Security Manager server, which normally resides on another computer. This client also uses your web browser for some functions.
 
     	 [bookmark: pgfId-1112648]A web browser. You use your web browser to use AUS and for configuring the Security Manager server and other servers that use Common Services. 
 
    
 
    [bookmark: pgfId-1056272]The following topics describe how to configure your web browser to run the clients and how to install the Security Manager client:
 
     
     	 [bookmark: pgfId-1085953]Configuring Web Browser Clients
 
     	 [bookmark: pgfId-1121181]Tips for Installing the Security Manager Client
 
     	 [bookmark: pgfId-1061227]Installing the Security Manager Client
 
     	 [bookmark: pgfId-1057777]Logging In to the Applications
 
     	 [bookmark: pgfId-1064669]Uninstalling Security Manager Client
 
    
 
   
 
    
     [bookmark: pgfId-1065442][bookmark: 93233]Configuring Web Browser Clients[bookmark: marker-1121392]
 
    [bookmark: pgfId-1123904]You must ensure that your web browser is configured to allow certain types of content and not to block popup windows from the server running the applications. The web browser is used for displaying online help as well as functional application windows. The following sections explain the browser settings you must configure so that you can use your browser effectively as an application client:
 
     
     	 [bookmark: pgfId-1123905]HTTP/HTTPS Proxy Exception 
 
     	 [bookmark: pgfId-1135821]Configuring Browser Cookies
 
     	 [bookmark: pgfId-1123909]Configuring Internet Explorer Settings 
 
     	 [bookmark: pgfId-1088015]Configuring Firefox Settings 
 
     	 [bookmark: pgfId-1065269]Enabling and Configuring Exceptions in Third-party Tools 
 
    
 
     
      [bookmark: pgfId-1124020][bookmark: 78347]HTTP/HTTPS Proxy Exception
 
     [bookmark: pgfId-1124021]If you use an HTTP/HTTPS proxy, you need to configure a proxy exception for the Security Manager server. 
 
     [bookmark: pgfId-1124068]This requirement applies to Internet Explorer and Firefox, for which additional configuration details are provided in the sections that follow. 
 
    
 
     
      [bookmark: pgfId-1135632][bookmark: 37786]Configuring Browser Cookies 
 
     [bookmark: pgfId-1135683]When more than one browser is installed, the default browser's cookies should be enabled. [bookmark: marker-1135862]More[bookmark: marker-1135866] specifically, Internet Explorer Privacy Settings should be set at the Medium level or lower (IE > Tools > Internet Options > Privacy Settings <= Medium). 
 
     [bookmark: pgfId-1135648]Blocking cookies can cause Security Manager user login to fail even after a clean installation of Security Manager. If user login fails after a clean installation of Security Manager, you may see the following error message: “CMF session id cannot be assigned.”
 
    
 
     
      [bookmark: pgfId-1124024][bookmark: 59295]Configuring Internet Explorer Settings[bookmark: marker-1124023]
 
     [bookmark: pgfId-1109973]There are several settings that you need to configure in Internet Explorer for Security Manager and its applications to function correctly. Internet Explorer is used to display online help, activity reports, CS-MARS lookup information, and so forth. This procedure explains the settings you need to configure in Internet Explorer. 
 
     [bookmark: pgfId-1117469]Procedure
 
     
 
     [bookmark: pgfId-1125703]Step 1 If you are using Internet Explorer 8.x, 9.x, 10.x, or 11.x, use Compatibility View; Internet Explorer 8.x, 9.x, 10.x, and 11.x are supported only in Compatibility View. To use Compatibility View, open Internet Explorer, navigate to Tools > Compatibility View Settings, and add the Security Manager server as a website to be displayed in Compatibility View. 
 
     [bookmark: pgfId-1137064]Step 2 Turn off Pop-up Blocker for Security Manager by performing the following steps: 
 
     [bookmark: pgfId-1119846] a. Open Internet Explorer 
 
     [bookmark: pgfId-1119967] b. Go to Tools > Pop-up Blocker > Pop-up Blocker Settings 
 
     [bookmark: pgfId-1119984] c. In the Address of website to allow field, enter the IP address of your Security Manager server and then click Add. Refer to http://windows.microsoft.com/en-US/windows-vista/Internet-Explorer-Pop-up-Blocker-frequently-asked-questions. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1119847] 
      Caution If you do not turn off Pop-up Blocker, you may not be able to discover devices in Security Manager. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1119725]Step 3 In Internet Explorer, select Tools > Internet Options. All subsequent steps in this procedure are performed in the Internet Options dialog box. 
 
     [bookmark: pgfId-1119028]Step 4 Allow active content by performing the following steps: 
 
     [bookmark: pgfId-1110059] a. Click the Advanced tab, scroll to the Security section, and select Allow active content to run in files on My Computer. 
 
     [bookmark: pgfId-1110117] b. Click Apply to save your changes. 
 
     [bookmark: pgfId-1110192]Step 5 [bookmark: marker-1110191]Confirm that the browser security settings enable you to save encrypted pages to disk. If you cannot save encrypted pages, you cannot download the client software installer.
 
     [bookmark: pgfId-1110193]On the Advanced tab, in the Security area, deselect Do not save encrypted pages to disk. If you needed to change the setting, click Apply to save your changes.
 
     [bookmark: pgfId-1110304]Step 6 Confirm that the size of the disk cache for temporary files is greater than the size of the client software installer that you expect to download. If the cache allocation is too small, you cannot download the installer. Change the cache size by performing the following steps:[bookmark: marker-1116103]
 
     [bookmark: pgfId-1110305] a. Click the General tab.
 
     [bookmark: pgfId-1110371] b. Click Settings in the Temporary Internet Files group.
 
     [bookmark: pgfId-1110430] c. If necessary, increase the amount of disk space to use for temporary Internet files, and click OK.
 
     [bookmark: pgfId-1110452] d. Click Apply to save your changes.
 
     [bookmark: pgfId-1110550]Step 7 (Optional) Some interactions between CS-MARS and Security Manager require the opening of pages that have both secure and nonsecure content. By default, Internet Explorer asks you whether you want to display the nonsecure items. You can click Yes to this prompt and the software will function normally.
 
     [bookmark: pgfId-1110735]If desired, you can change the Internet Explorer settings so that you are not prompted and any page that has mixed content, that is, both secure and nonsecure content, are displayed automatically. Configure Internet Explorer to display mixed content pages by performing the following steps:
 
     [bookmark: pgfId-1110495] a. Click the Security tab. 
 
     [bookmark: pgfId-1110496] b. Click Custom Level near the bottom of the dialog box.
 
     [bookmark: pgfId-1110497] c. Under the Miscellaneous heading, select the Enable radio button for the “Display mixed content” setting. (Ensure that you do not select Disable.)
 
     [bookmark: pgfId-1111113] d. Click Apply to save your changes.
 
     [bookmark: pgfId-1110499]Step 8 Click OK to close the Internet Options dialog box.
 
     [bookmark: pgfId-1111215]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1086878][bookmark: 67277]Configuring Firefox Settings[bookmark: marker-1121443]
 
     [bookmark: pgfId-1112935]There are several settings that you need to configure in Firefox for Security Manager and its applications to function correctly. Firefox is used to display some features, such as online help, activity reports, CS-MARS lookup information, and so forth. This procedure explains the options you need to configure in Firefox.
 
      
      	 [bookmark: pgfId-1096156]Editing the Preferences File
 
      	 [bookmark: pgfId-1096209]Editing the Size of the Disk Cache
 
      	 [bookmark: pgfId-1096230]Disabling the Popup Blocker or Creating a White List
 
      	 [bookmark: pgfId-1096241]Enabling JavaScript
 
      	 [bookmark: pgfId-1096251]Displaying Online Help on a New Tab in the Most Recent Window and Reusing Existing Windows on Subsequent Requests
 
     
 
    
 
     
      [bookmark: pgfId-1094859][bookmark: 88973]Editing the Preferences File[bookmark: marker-1121452]
 
     [bookmark: pgfId-1095315]Procedure
 
     [bookmark: pgfId-1117659]To edit the preferences file, do the following:
 
     
 
     [bookmark: pgfId-1095324]Step 1 From the \Mozilla Firefox\defaults\pref subdirectory, open firefox.js in a text editor, such as Notepad.
 
     [bookmark: pgfId-1095325]Step 2 Add the following: 
pref("dom.allow_scripts_to_close_windows", true);
 
     [bookmark: pgfId-1095336]Step 3 Save, and then close, the edited file.
 
     [bookmark: pgfId-1095348]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1095359][bookmark: 60623]Editing the Size of the Disk Cache[bookmark: marker-1121461]
 
     [bookmark: pgfId-1095376]Confirm that the size of the disk cache for temporary files is greater than the size of the client software installer that you expect to download. If the cache allocation is too small, you cannot download the installer. 
 
     [bookmark: pgfId-1117664]Procedure
 
     [bookmark: pgfId-1117665]To change the cache size, do the following:
 
     
 
     [bookmark: pgfId-1095377]Step 1 Select Tools > Options, then click Advanced. 
 
     [bookmark: pgfId-1095388]Step 2 Reserve more space for the cache if the setting is too small, then click OK.
 
     [bookmark: pgfId-1095389]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1095402][bookmark: 97970]Disabling the Popup Blocker or Creating a White List[bookmark: marker-1121474]
 
     [bookmark: pgfId-1095416]Procedure
 
     [bookmark: pgfId-1117700]To disable popup blockers, do the following:
 
     
 
     [bookmark: pgfId-1095443]Step 1 Select Tools > Options, then click the Content icon.
 
     [bookmark: pgfId-1095470]Step 2 Deselect the Block pop-up windows check box.
 
     [bookmark: pgfId-1095445]Alternatively, to create a white list of trustworthy sources from which to accept popups, select the Block pop-up windows check box, then click Exceptions and in the Allowed Sites - Popups dialog box do the following:
 
     [bookmark: pgfId-1095446] a. Enter http://<SERVER_NAME> (where SERVER_NAME is the IP address or DNS-routable name of your Security Manager server) in the Address of web site field, then click Allow.
 
     [bookmark: pgfId-1095567] b. Enter file:///C:/Documents%20and%20Settings/<USER_NAME>/Local%20Settings/
Temp/ (where C: is the client system disk drive on which you installed Windows and USER_NAME is your Windows username on the client system), then click Allow.
 
     [bookmark: pgfId-1095448] c. Click Close.
 
     [bookmark: pgfId-1095449]Step 3 Click OK.
 
     [bookmark: pgfId-1095578]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1095625][bookmark: 77426]Enabling JavaScript[bookmark: marker-1121483]
 
     [bookmark: pgfId-1117811]Procedure
 
     [bookmark: pgfId-1138685]To enable JavaScript, do the following:
 
     
 
     [bookmark: pgfId-1138686]Step 1 Select Tools > Options, then click the Contents icon.
 
     [bookmark: pgfId-1138687]Step 2 Select the Enable JavaScript check box.
 
     [bookmark: pgfId-1095612]Step 3 Click Advanced, and in the Advanced JavaScript Settings dialog box, select every check box in the Allow scripts to area.
 
     [bookmark: pgfId-1095617]Step 4 Click OK.
 
     [bookmark: pgfId-1095568]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1095352][bookmark: 81345]Displaying Online Help on a New Tab in the Most Recent Window and Reusing Existing Windows on Subsequent Requests[bookmark: marker-1121488]
 
     [bookmark: pgfId-1095942]When you access online help the first time, two new browser windows might be opened: a blank page and a page with help contents. Also, existing browser windows might not be reused during subsequent attempts to access online help. 
 
     [bookmark: pgfId-1117903]Procedure
 
     [bookmark: pgfId-1117924]To configure Firefox to display online help on a new tab in the most recently opened browser window and to reuse existing windows on later occasions, follow these steps:
 
     
 
     [bookmark: pgfId-1095943]Step 1 In the address bar, enter about:config and press Enter. The list of user preferences is displayed.
 
     [bookmark: pgfId-1096132]Step 2 Double-click browser.link.open_external and enter 3 in the resulting dialog box. This value denotes that links from an external application are opened in a new tab in the browser window that was last opened.
 
     [bookmark: pgfId-1096138]Step 3 Double-click browser.link.open_newwindow and set it to 1. This value denotes that links are opened in the active tab or window.
 
     [bookmark: pgfId-1096141]Step 4 Double-click browser.link.open_newwindow.restriction and set it to 0. This value causes all new windows to be opened as tabs.
 
     [bookmark: pgfId-1096144]Step 5 Close the about:config page.
 
      
       
     
 
     
 
     [bookmark: pgfId-1095948]Note A blank page might be displayed when you open context-sensitive help, even after the browser status bar displays the status as Done. If this problem occurs, wait for a few minutes to allow the content to be downloaded and displayed.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1095651]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1089683][bookmark: 44338]Enabling and Configuring Exceptions in Third-party Tools[bookmark: marker-1121493]
 
     [bookmark: pgfId-1061177]Some third-party popup blockers enable you to allow popups from a specific site or server without allowing popups universally. If your popup blocker does not allow you to configure exceptions to include in a white list, or if that option fails to meet your requirements, you must set your utility to allow all popups. The method for allowing popups from a trusted site varies according to the utility that you use. Please refer to the third-party product’s documentation for more information.
 
    
 
   
 
    
     [bookmark: pgfId-1121141][bookmark: 77198]Tips for Installing the Security Manager Client
 
    [bookmark: pgfId-1121142]You use the Security Manager client to configure your devices. When you save changes in the client, they are saved to your workstation. You then must submit the changes to the database, which updates the database that resides on the server.
 
    [bookmark: pgfId-1121143]While using the client, there is constant back-and-forth communication between the client and the server. With that in mind, consider the following tips on installing the client to help improve client performance:
 
     
     	 [bookmark: pgfId-1121144]Do not run the client on the same computer as the server as a normal day-to-day operation. If you install the client on the server, use it only for limited troubleshooting purposes.
 
     	 [bookmark: pgfId-1121145]Install the client on workstations that are reasonably close to the server to avoid network latency problems. For example, if you have the server installed in the USA, a client running from a network in India might experience poor responsiveness due to the latency introduced. To alleviate this problem, you can employ a remote desktop or terminal server arrangement, where the clients are collocated in the same data center as the server.
 
     	 [bookmark: pgfId-1121146]You can install only one copy of the client on a computer. There must be an exact version match between the client and server. Therefore, if you want to run two different versions of the Security Manager product, you must have two separate workstations for running the client.
 
    
 
    [bookmark: pgfId-1121147]On the other hand, you can start the client more than once to connect to different Security Manager servers that are running the same version.
 
   
 
    
     [bookmark: pgfId-1083596][bookmark: 68466]Installing the Security Manager Client[bookmark: marker-1121498]
 
    [bookmark: pgfId-1113106]The Security Manager client is a separate program that you install on your workstation. You use the client to log in to the Security Manager server and to configure security policies on your devices. The Security Manager client is the main application that you use with the product.
 
    [bookmark: pgfId-1113116]You might have already installed the client on the Security Manager server when you installed the server software. However, using the client on the same system as the server is not recommended for normal day-to-day usage of the product. Instead, you should install the client on a separate workstation using the following procedure. For information on workstation system requirements and supported browser versions, see Client Requirements, page 3-10.
 
    [bookmark: pgfId-1113912]If you run into problems during installation, see the following topics: 
 
     
     	 [bookmark: pgfId-1113913]Configuring a Non-Default HTTP or HTTPS Port
 
     	 [bookmark: pgfId-1113917]Unable to Upgrade From a Previous Version of the Client
 
     	 [bookmark: pgfId-1113903]Client Problems During Installation.
 
    
 
    [bookmark: pgfId-1073988]Before You Begin
 
     
     	 [bookmark: pgfId-1084327]Ensure that your browser is configured correctly. See Configuring Web Browser Clients.
 
     	 [bookmark: pgfId-1116126]Ensure that Windows Firewall is configured correctly. On the operating systems supported by Security Manager, Windows Firewall is enabled by default. As a result, inbound connections for HTTP, HTTPS and syslog are blocked. For example, an admin can access the Security Manager client installation URL locally on the server but not from remote workstations. Another example is syslog data not showing up in Event Viewer. You must disable Windows Firewall or configure inbound rules to permit the management traffic in question. 
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1128099]Caution If you disable Windows Firewall on your workstation, it is vulnerable to malicious activity that Windows Firewall acts to prevent when it is enabled. 
      
      
 
     
 
    
 
     
     	 [bookmark: pgfId-1128078]We recommend that you manually delete the Temp files on your client system before you download the client software installer. Deleting such files increases the chances that you have enough available space.
 
     	 [bookmark: pgfId-1116112]If it is installed on your workstation, the Cisco Security Agent needs to be disabled, either before or during the process of installing the client. If the client installer cannot disable the Cisco Security Agent during the installation process, the process aborts and you are prompted to manually disable it before restarting the client installation. 
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1124241]Tip [bookmark: marker-1124412]To disable Cisco Security Agent on your workstation, use one of the following two methods: (1) right-click the Cisco Security Agent icon in the system tray and select Security Level > Off or (2) open Services (Control Panel > Administrative Tools > Services), right-click Cisco Security Agent, and click Stop. For both of these two methods, you then need to take the following step for some versions of Windows: open Services right-click Cisco Security Agent Monitor, and click Stop. After you finish installing the client, re-start Cisco Security Agent. 
 
     
     
 
    
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1124329] 
     Caution 
     [bookmark: marker-1124413]While Cisco Security Agent is disabled on your workstation, it is vulnerable to malicious activity that Cisco Security Agent acts to prevent when it is enabled. 
      
      
 
     
 
    
 
     
     	 [bookmark: pgfId-1114007]If you already have the Security Manager client installed on the workstation, the installation program must uninstall it before installing the updated client. The wizard will prompt you if this is necessary.
 
    
 
    [bookmark: pgfId-1117969]Procedure
 
    
 
    [bookmark: pgfId-1060617]Step 1 Log in to the client workstation using a user account that has Windows administrator privileges.
 
    [bookmark: pgfId-1130513]Step 2 In your web browser, open one of these URLs, where SecManServer is the name of the computer where Security Manager is installed. Click Yes on any Security Alert windows.
 
     
      
      	 [bookmark: pgfId-1113460]If you are not using SSL, open  http://  SecManServer  :1741 
 
      	 [bookmark: pgfId-1113461]If you are using SSL, open  https://  SecManServer  :443 
 
     
 
    
 
    [bookmark: pgfId-1069663]The Cisco Security Management Suite login screen is displayed. Verify on the page that JavaScript and cookies are enabled and that you are running a supported version of the web browser.
 
    [bookmark: pgfId-1113516]Step 3 Log in to the Cisco Security Management Suite server with your username and password. When you initially install the server, you can log in using the username admin and the password defined during product installation.
 
    [bookmark: pgfId-1082492]Step 4 On the Cisco Security Management Suite home page, click Cisco Security Manager Client Installer.
 
    [bookmark: pgfId-1113530]You are prompted to either open or run the file or to save it to disk. You can choose either option. If you choose to save it to disk, run the program after downloading it (double-click the file or select the Run option if your browser prompts you).
 
     
      
    
 
    
 
    [bookmark: pgfId-1125022]Tip If you get any security warnings about the application, such as “a problem was detected” or “the publisher cannot be verified” or that an unidentified application wants access to your computer, ensure that you allow the access. You might need to click more than one button, and the button names vary based on the application prompting you (such as Allow, Yes, Apply, and so forth). 
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1136930]Note A special consideration applies if you are using Internet Explorer 10.x. When you click Cisco Security Manager Client Installer, you receive a prompt for user action (save or run), just as you do for all versions of Internet Explorer supported by Cisco Security Manager 4.9. If you choose the option to run, a dialog box appears and states that this option is not recommended; you then receive another prompt for user action. When you receive that prompt and click the Actions button, the SmartScreen Filter dialog box for Internet Explorer appears. Important--You need to choose the option Run Anyway to start the client installation process. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1125023]Step 5 The installation wizard displays a “Welcome” screen. 
 
    [bookmark: pgfId-1125129]The Security Manager client is installed as a single application with six views—Configuration Manager, Event Viewer, Report Manager, Health and Performance Manager, Image Manager, and Dashboard. Each can be launched independently in one of the following three ways (further information is available in Logging In to Security Manager Using the Security Manager Client): 
 
     
      
      	 [bookmark: pgfId-1125131]Start > All Programs > Cisco Security Manager Client [folder] > Cisco Security Manager Client 
 
     
 
     	 [bookmark: pgfId-1125133][login screen]
 
      
      	 [bookmark: pgfId-1128576][after starting one of the views] Launch > [choose a different one of the views] 
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1128577]Note A desktop icon is also created for Cisco Security Manager. This icon opens the Cisco Security Management Suite home page. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1128578]Step 6 Follow the installation wizard instructions. During installation, you are asked for the following information:
 
     
      
      	 [bookmark: pgfId-1114067]Server name—The DNS name or IP address of the server on which the Security Manager server software is installed. Normally, this is the server from which you downloaded the client installer.
 
      	 [bookmark: pgfId-1114130]Protocol—HTTPS or HTTP. Select the protocol the Security Manager server is configured to use. Typically, the server is configured to use HTTPS. Ask your system administrator if you are not sure which to select. Also, if you know that the server is configured to use a non-default port, configure the port after installation using the information in Configuring a Non-Default HTTP or HTTPS Port.
 
      	 [bookmark: pgfId-1114152]Shortcuts—Whether to create shortcuts for just yourself, for all user accounts that log in to this workstation, or for no users. This determines who will see Cisco Security Manager Client in the Start menu. You can start the client from Start > All Programs > Cisco Security Manager Client [folder] > Cisco Security Manager Client or from the icon on the desktop.
 
      	 [bookmark: pgfId-1114186]Installation location—The folder in which you want to install the client. Accept the default unless you have a compelling reason to install it elsewhere. The default location is C:\Program Files (x86)\Cisco Systems. 
 
     
 
    
 
    [bookmark: pgfId-1124923]Step 7 Continue to follow the installation wizard instructions. 
 
    [bookmark: pgfId-1117156]Step 8 After you click Done to complete the installation, if you disabled an antivirus application temporarily, re-enable it. 
 
    [bookmark: pgfId-1083761]If the Cisco Security Agent on your workstation was stopped by the client installer, it is restarted at the end of the installation. However, if you manually disabled the Cisco Security Agent on your system, you must enable it after client installation is complete.
 
    [bookmark: pgfId-1137695]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1137724]Handling Security Settings That Prevent Installation 
 
     [bookmark: pgfId-1137789]There are many different ways you can configure security settings on your workstation, and many different products that you can install, that might prevent you from installing the Security Manager client. If you run into problems during installation, first ensure that your Windows user account has the administrative privileges required for installing software, then consider the following note: 
 
      
       
     
 
     
 
     [bookmark: pgfId-1137870]Note If Microsoft Windows User Account Control (UAC) is turned on, you must install and run the client with “Run as administrator.” 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1137699][bookmark: 17419][bookmark: 33522]Configuring a Non-Default HTTP or HTTPS Port[bookmark: marker-1137698]
 
     [bookmark: pgfId-1137700]The Security Manager server uses these default ports: HTTPS is 443; HTTP is 1741. If your organization installed the Security Manager server to use a different port, you need to configure the client to use the non-standard port. Otherwise, the client cannot connect to the server.
 
     [bookmark: pgfId-1114735]To configure different ports for your client, edit the C:\Program Files (x86)\Cisco Systems\Cisco Security Manager Client\jars\client.info file using a text editor such as NotePad. Add the following settings and specify the custom port number in place of <port number>:
 
      
      	 [bookmark: pgfId-1114736]HTTPS_PORT= <port number> 
 
      	 [bookmark: pgfId-1114747]HTTP_PORT= <port number> 
 
     
 
     [bookmark: pgfId-1114737]These settings are used the next time you start the client.
 
    
 
     
      [bookmark: pgfId-1114644][bookmark: 89393]Unable to Upgrade From a Previous Version of the Client[bookmark: marker-1121525]
 
     [bookmark: pgfId-1113238]When you attempt to install the Security Manager client when you already have an older client installed, or when you used to have a client installed on the workstation, the client installer first uninstalls the previous version before installing the new one. If you receive the error message “Could not find main class. Program will exit,” the installer cannot install the client.
 
     [bookmark: pgfId-1109789]Procedure
 
     [bookmark: pgfId-1118046]This problem occurs because of the presence of old registry entries in your system. To correct this problem, do the following:
 
     
 
     [bookmark: pgfId-1109790]Step 1 Start the Registry Editor by selecting Start > Run and entering regedit.
 
     [bookmark: pgfId-1109791]Step 2 Remove the following registry key:
 
     [bookmark: pgfId-1109792]HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\Uninstall\f427e21299b0dd254754c0d2778feec4-837992615
 
     [bookmark: pgfId-1109793]Step 3 Delete the previous installation directory, usually C:\Program Files (x86)\Cisco Systems\Cisco Security Manager Client.
 
     [bookmark: pgfId-1109794]Step 4 Rename the following folder:
 
     [bookmark: pgfId-1109795]C:\Program Files (x86)\Common Files\InstallShield\Universal\common\Gen1 
 
     [bookmark: pgfId-1109796]Step 5 Select Start > Control Panel > Add or Remove Programs. If the Cisco Security Manager Client is still listed, click Remove. If you receive the message, “Program already removed; do you want to remove it from the list?”, click Yes.
 
     [bookmark: pgfId-1109797]If you still cannot re-install the Security Manager client, rename the C:\Program Files (x86)\Common Files\InstallShield directory, then try again. Also see Client Problems During Installation.
 
     [bookmark: pgfId-1109798]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1057574][bookmark: 48274]Patching a Client[bookmark: marker-1121538]
 
     [bookmark: pgfId-1071010]After you apply a service pack or a point patch to your Security Manager server, the Security Manager client prompts you to apply an update when you log in to the server. The version number of the client software must be the same as the version number of the server software.
 
     [bookmark: pgfId-1115057]When you are prompted to download and apply a required software update, your web browser is used to download the update. You are prompted to either open or run the file, or to save it to disk. You can choose either option. If you choose to save it to disk, run the program after downloading it (double-click the file or select the Run option if your browser prompts you).
 
     [bookmark: pgfId-1115100]Installation of the patch is similar to installation of the client, and you must allow (or click Yes) to any security alerts from Cisco Security Agent or other security software you have installed to allow the installer to run.
 
     [bookmark: pgfId-1115113]When prompted for installation location, ensure that you select the folder in which you installed the client, and select Yes to All if you are asked if you want to overwrite files.
 
      
       
     
 
     
 
     [bookmark: pgfId-1115125]Tip If you get an error message that says that the URL cannot be retrieved or that the connection timed out, you need to uninstall the Security Manager client, then install a fresh copy (which will already have the patch applied). For more information, see Uninstalling Security Manager Client and Installing the Security Manager Client. 
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1115274][bookmark: 32666]Logging In to the Applications[bookmark: marker-1121547]
 
    [bookmark: pgfId-1115286]After you have installed the server applications, configured your web browser, and installed the Security Manager client, you can log in to the applications:
 
     
     	 [bookmark: pgfId-1118784]Logging In to Security Manager Using the Security Manager Client
 
     	 [bookmark: pgfId-1118788]Logging In to Server Applications Using a Web Browser
 
    
 
     
      [bookmark: pgfId-1118791][bookmark: 82102]Logging In to Security Manager Using the Security Manager Client[bookmark: marker-1121556]
 
     [bookmark: pgfId-1115867]The Security Manager client is installed as an application suite with six applications—Configuration Manager, Event Viewer, Report Manager, Health and Performance Manager, Image Manager, and Dashboard. Each can be launched independently in one of the three ways described in the procedure below. 
 
     [bookmark: pgfId-1125988]Use the Configuration Manager application (which is part of the Security Manager client application suite) to perform most Security Manager tasks. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1121952]Tip You must log in to the client workstation using a Windows user account that has Administrator privileges to fully use the Security Manager client. If you try to operate the client with lesser privileges, you might find that some features do not work correctly.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1118004]Procedure
 
     
 
     [bookmark: pgfId-1115873]Step 1 Launch your choice of Configuration Manager, Event Viewer, Report Manager, Health and Performance Monitor, Image Manager, or Dashboard. Each can be launched independently in one of the following three ways: 
 
      
       
       	 [bookmark: pgfId-1135129]Start > All Programs > Cisco Security Manager Client [folder] > Cisco Security Manager Client 
 
       	 [bookmark: pgfId-1126035][login screen] 
 
       	 [bookmark: pgfId-1126036][after starting one of the applications] Launch > [choose a different one of the applications in the Security Manager client application suite]. The login dialog window does not appear. 
 
      
 
     
 
     [bookmark: pgfId-1115875]Step 2 In the Security Manager login dialog window, enter or select the DNS name of the server you want to log in to. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1126262]Note If you enter or select the IP address—instead of the DNS name—some features may not function as intended in an Internet Explorer 7 environment. To ensure the correct function of all Security Manager features, enter the DNS name of the server to which you want to log in. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1126076]Step 3 Enter your Security Manager username and password. 
 
     [bookmark: pgfId-1126072]Step 4 If the server uses HTTPS for connections, ensure that the HTTPS check box is selected; otherwise, deselect it. Click Login. 
 
     [bookmark: pgfId-1126417]Step 5 If the server prompts you to download and install a client software update, see Patching a Client, page 6-10. 
 
     [bookmark: pgfId-1130279]Step 6 If you log in to a Security Manager server that is running a higher version than your client, a notification will be displayed and you will have the option of downloading the matching client version. 
 
     [bookmark: pgfId-1126419]Step 7 If there are no sessions running with the username and password that you just entered, the client application (Configuration Manager, Event Viewer, Report Manager, Health and Performance Monitor, Image Manager, or Dashboard) logs in to the server and opens the client interface. 
 
     [bookmark: pgfId-1126420]Step 8 If there is already a session running with the username and password that you just entered, an informational message appears to inform you that there is an easier way to launch the new application with the same session from the existing application. That way is the following:
 
     [bookmark: pgfId-1126133][after starting one of the applications] Launch > [choose a different one of the applications in the Security Manager client application suite]. 
 
     [bookmark: pgfId-1126134]Step 9 The new application is launched from the existing session, or, if it is already running, it is brought to focus. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1126291]Tip The client closes if it is idle for 120 minutes. To change the idle timeout, select Tools > Security Manager Administration, select Customize Desktop from the table of contents, and enter the desired timeout period. You can also disable the feature so that the client does not close automatically. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1126127]Step 10 To exit Security Manager, select File > Exit. 
 
     [bookmark: pgfId-1115879]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1115817][bookmark: 80182]Logging In to Server Applications Using a Web Browser[bookmark: marker-1121565][bookmark: marker-1121574]
 
     [bookmark: pgfId-1115354]Only the Security Manager server uses a regular Windows application client for hosting the client application. All other applications, including the server administration features of Security Manager (through the Common Services application), CiscoWorks, and Auto Update Server are hosted in your web browser.
 
     [bookmark: pgfId-1115418]Logging in to these applications is identical. If you install more than one application on a single server, you log in to all installed applications at the same time. This is because the login is controlled by CiscoWorks, and all these applications are hosted under the CiscoWorks umbrella.
 
     [bookmark: pgfId-1118012]Procedure
 
     
 
     [bookmark: pgfId-1115444]Step 1 In your web browser, open one of these URLs, where server is the name of the computer where you installed any of the server applications. Click Yes on any Security Alert windows.
 
      
       
       	 [bookmark: pgfId-1115445]If you are not using SSL, open http:// server :1741.
 
       	 [bookmark: pgfId-1115446]If you are using SSL, open https:// server :443.
 
      
 
     
 
     [bookmark: pgfId-1115447]The Cisco Security Management Suite login screen is displayed. Verify on the page that JavaScript and cookies are enabled and that you are running a supported version of the web browser. For information on configuring the browser to run the applications, see Configuring Web Browser Clients.
 
     [bookmark: pgfId-1115449]Step 2 Log in to the Cisco Security Management Suite server with your username and password. When you initially install the server, you can log in using the username admin and the password defined during product installation.
 
     [bookmark: pgfId-1115450]Step 3 On the Cisco Security Management Suite home page, you can access the features installed on the server. The home page can contain different items based on what you installed. 
 
      
       
       	 [bookmark: pgfId-1115608]Click the panel for the application that you want to run, such as  Auto Update Server .
 
       	 [bookmark: pgfId-1115636]Click the  Server Administration panel to open the CiscoWorks Common Services Server menu. You can click this link to get to any place within Common Services. CiscoWorks Common Services is the foundation software that manages the server. Use it to configure and manage back-end server features such as server maintenance and troubleshooting, local user definition, and so on.
 
      
 
      	 [bookmark: pgfId-1115451]Click the  Cisco Security Manager Client Installer to install the Security Manager client. The client is the main interface for using the Security Manager server.
 
     
 
     [bookmark: pgfId-1115454]Step 4 To exit the application, click Logout in the upper right corner of the screen. If you have both the home page and the Security Manager client open at the same time, exiting the browser connection does not exit the Security Manager client.
 
     [bookmark: pgfId-1115455]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1044093][bookmark: 38371]Uninstalling Security Manager Client[bookmark: marker-1121581]
 
    [bookmark: pgfId-1116015]If you want to uninstall the Security Manager client, select Start > All Programs > Cisco Security Manager Client > Uninstall Cisco Security Manager Client and follow the uninstallation wizard prompts. 
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1028144]Post-Installation Server Tasks 
      
      
 
     
 
 
    [bookmark: pgfId-1036333]The following topics are tasks to complete after you install Security Manager or its related applications on a server.
 
     
     	 [bookmark: pgfId-1030809]Server Tasks To Complete Immediately
 
     	 [bookmark: pgfId-1039789]Verifying that Required Processes Are Running
 
     	 [bookmark: pgfId-1061511]Configuration of Heap Sizes for Security Manager Processes using MRF
 
     	 [bookmark: pgfId-1034264]Best Practices for Ongoing Server Security
 
     	 [bookmark: pgfId-1037007]Verifying an Installation or an Upgrade
 
     	 [bookmark: pgfId-1046000]Where To Go Next
 
    
 
   
 
    
     [bookmark: pgfId-1031857][bookmark: 47404]Server Tasks To Complete Immediately[bookmark: marker-1059211]
 
    [bookmark: pgfId-1036783]Make sure that you complete the following tasks immediately after installation.
 
    [bookmark: pgfId-1036821]
 
     
      
       
        
        	[bookmark: pgfId-1036789]
 
          
          [image: ] 
         
  
        	 
          
          [bookmark: pgfId-1036791]Task 
         
  
       
 
        
        	[bookmark: pgfId-1036796]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1071388] 1. Re-enable or re-install antivirus scanners and similar products. If you uninstalled or temporarily disabled any server security software, such as an antivirus tool, re-install or restart that software now, then restart your server if required.Make sure to exclude the NMSROOT directory and the eventing folder from scanning as long as Security Manager is installed on the server.
 [bookmark: pgfId-1071389]Note If you see that your antivirus software is reducing the efficiency or responsiveness of a Security Manager server, see your antivirus software documentation for recommended settings.
  
       
 
        
        	[bookmark: pgfId-1036804]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1036806] 2. Re-enable the services and server processes that you disabled for installation. Do not re-enable IIS.
  
       
 
        
        	[bookmark: pgfId-1040531]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1041764] 3. Re-enable any mission-critical applications that you disabled for installation, including those that use any Sybase technology or software code. 
  
       
 
        
        	[bookmark: pgfId-1036811]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1036813] 4. On the server, add a self-signed certificate to the list of trusted certificates. To learn how, see your browser documentation.[bookmark: marker-1058050]
  
       
 
        
        	[bookmark: pgfId-1036818]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1036820] 5. Check for updates on Cisco.com for Security Manager and its related applications. If you learn that updates are available, install the ones that are relevant to your organization and network.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1038420][bookmark: 36736]Verifying that Required Processes Are Running[bookmark: marker-1059229]
 
    [bookmark: pgfId-1038434]You can run the pdshow command from a Windows command prompt window to verify that all required processes are running correctly for the Cisco server applications that you choose to install. Process requirements differ among the applications. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1038716]Tip To learn more about pdshow, see the Common Services documentation.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-1058562]Table 7-1 [bookmark: 27496]Application Process Requirements 
 
       
       
        
        	 
          
          [bookmark: pgfId-1058566]This application: 
         
  
        	 
          
          [bookmark: pgfId-1058568]Requires these Daemon Manager processes: 
         
  
       
 
        
        	[bookmark: pgfId-1058570]Common Services
  
        	 
          
          [bookmark: pgfId-1058572]Apache 
         
 
          
          [bookmark: pgfId-1058573]CmfDbEngine 
         
 
          
          [bookmark: pgfId-1058574]CmfDbMonitor 
         
 
          
          [bookmark: pgfId-1058575]CMFOGSServer 
         
 
          
          [bookmark: pgfId-1058576]CSRegistryServer 
         
 
          
          [bookmark: pgfId-1058577]DCRServer 
         
 
          
          [bookmark: pgfId-1058578]diskWatcher 
         
 
          
          [bookmark: pgfId-1058579]EDS 
         
 
          
          [bookmark: pgfId-1058580]EDS-GCF 
         
 
          
          [bookmark: pgfId-1058581]ESS 
         
 
          
          [bookmark: pgfId-1058582]EssMonitor 
         
 
          
          [bookmark: pgfId-1058583]jrm 
         
 
          
          [bookmark: pgfId-1058584]LicenseServer 
         
 
          
          [bookmark: pgfId-1058585]Proxy 
         
 
          
          [bookmark: pgfId-1058586]Tomcat 
         
 
          
          [bookmark: pgfId-1059449]TomcatMonitor 
         
 
          
          [bookmark: pgfId-1059462]NameServer 
         
 
          
          [bookmark: pgfId-1059457]NameServiceMonitor 
         
 
          
          [bookmark: pgfId-1065685]EventFramework 
         
  
       
 
        
        	[bookmark: pgfId-1058589]Cisco Security Manager
  
        	 
          
          [bookmark: pgfId-1059675]AthenaOGSServer 
         
 
          
          [bookmark: pgfId-1059676]ccrWrapper 
         
 
          
          [bookmark: pgfId-1059677]CsmReportServer 
         
 
          
          [bookmark: pgfId-1059658]rptDbEngine 
         
 
          
          [bookmark: pgfId-1059660]rptDbMonitor 
         
 
          
          [bookmark: pgfId-1058592]VmsBackendServer 
         
 
          
          [bookmark: pgfId-1058593]vmsDbEngine 
         
 
          
          [bookmark: pgfId-1058937]vmsDbMonitor 
         
 
          
          [bookmark: pgfId-1058924]VmsEventServer 
         
 
          
          [bookmark: pgfId-1065670]CsmHPMServer 
         
  
       
 
        
        	[bookmark: pgfId-1058596]Auto Update Server
  
        	 
          
          [bookmark: pgfId-1058598]AusDbEngine 
         
 
          
          [bookmark: pgfId-1058599]AusDbMonitor 
         
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1036823][bookmark: 32615]Configuration of Heap Sizes for Security Manager Processes using MRF
 
    [bookmark: pgfId-1061281]Memory Reservation Framework (MRF), a feature introduced in Security Manager 4.1, provides Cisco Security Manager administrators the capability to modify heap sizes of key processes; doing so can enhance the performance of the server. MRF enables processes to adjust heap sizes on the basis of the RAM installed on the server. 
 
    [bookmark: pgfId-1061285]The Security Manager processes that can be configured using MRF are listed in Table 7-2. 
 
     
      
       
       [bookmark: pgfId-1061557]Table 7-2 [bookmark: 75331]Security Manager Processes that Can Be Configured by Using MRF 
 
       
       
        
        	 
          
          [bookmark: pgfId-1061563]Process 
         
  
        	 
          
          [bookmark: pgfId-1061565]Name as shown in pdshow 
         
  
        	 
          
          [bookmark: pgfId-1061567]Description 
         
  
       
 
        
        	[bookmark: pgfId-1061569]Backend Process
  
        	[bookmark: pgfId-1061571]VmsBackendServer
  
        	[bookmark: pgfId-1061573]Performs device discovery and deployment operations.
  
       
 
        
        	[bookmark: pgfId-1061575]Tomcat
  
        	[bookmark: pgfId-1061577]Tomcat
  
        	[bookmark: pgfId-1061579]Hosts applications responsible for editing and validating policies, etc.
  
       
 
        
        	[bookmark: pgfId-1061581]Report Server
  
        	[bookmark: pgfId-1061583]CsmReportServer
  
        	[bookmark: pgfId-1061585]Generates reporting data.
  
       
 
        
        	[bookmark: pgfId-1061587]Event Server
  
        	[bookmark: pgfId-1061589]VmsEventServer
  
        	[bookmark: pgfId-1061591]Collects events being sent from devices.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1071811]Note There is no MRF configuration for the HPM (Health and Performance Monitor) server. 
    
 
    [bookmark: pgfId-1071812]Note You can learn more about the pdshow command in the previous section, Verifying that Required Processes Are Running, and in the Common Services documentation. 
    
 
     
      [bookmark: pgfId-1064525]Default Configuration
 
     [bookmark: pgfId-1061357]The processes listed in Table 7-3, which are the Security Manager processes that can be configured by using MRF, are pre-configured with default values for heap sizes. Table 7-3 lists the default minimum and maximum heap sizes in megabytes for different amounts of RAM available to the server for each Security Manager process that can be configured by using MRF. 
 
      
       
        
        [bookmark: pgfId-1070040]Table 7-3 [bookmark: 28827]Default Heap Sizes Preconfigured for Security Manager Processes 
 
        
        
         
         	 
           
           [bookmark: pgfId-1070052]Physical RAM on server (GB) 
          
  
         	 
           
           [bookmark: pgfId-1070054]VmsBackendServer 
          
  
         	 
           
           [bookmark: pgfId-1070056]Tomcat 
          
  
         	 
           
           [bookmark: pgfId-1070058]CsmReportServer 
          
  
         	 
           
           [bookmark: pgfId-1070060]VmsEventServer 
          
  
         	 
           
           [bookmark: pgfId-1070062]CsmHPMServer 
          
  
        
 
         
         	[bookmark: pgfId-1070064]< 8
  
         	[bookmark: pgfId-1070066]1024, 2048
  
         	[bookmark: pgfId-1070068]512, 1024
  
         	[bookmark: pgfId-1070070]1024, 1024
  
         	[bookmark: pgfId-1070072]1024, 2048
  
         	[bookmark: pgfId-1070074]512, 1024
  
        
 
         
         	[bookmark: pgfId-1070076]8
  
         	[bookmark: pgfId-1070078]1024, 3072
  
         	[bookmark: pgfId-1070080]1024, 2048
  
         	[bookmark: pgfId-1070082]1024, 1024
  
         	[bookmark: pgfId-1070084]1024, 3072
  
         	[bookmark: pgfId-1070086]512, 1024
  
        
 
         
         	[bookmark: pgfId-1070088]12
  
         	[bookmark: pgfId-1070090]2048, 4096
  
         	[bookmark: pgfId-1070092]2048, 3072
  
         	[bookmark: pgfId-1070094]1024, 2048
  
         	[bookmark: pgfId-1070096]2048, 4096
  
         	[bookmark: pgfId-1070098]512, 1024
  
        
 
         
         	[bookmark: pgfId-1070100]16
  
         	[bookmark: pgfId-1070102]2048, 4096
  
         	[bookmark: pgfId-1070104]2048, 4096
  
         	[bookmark: pgfId-1070106]1024, 4096
  
         	[bookmark: pgfId-1070108]4096, 4096
  
         	[bookmark: pgfId-1070110]512, 1024
  
        
 
         
         	[bookmark: pgfId-1070112]24
  
         	[bookmark: pgfId-1070114]4096, 8192
  
         	[bookmark: pgfId-1070116]4096, 4096
  
         	[bookmark: pgfId-1070118]1024, 4096
  
         	[bookmark: pgfId-1070120]4096, 8192
  
         	[bookmark: pgfId-1070122]512, 1024
  
        
 
         
         	[bookmark: pgfId-1070124]>= 28
  
         	[bookmark: pgfId-1070126]8192, 8192
  
         	[bookmark: pgfId-1070128]4096, 4096
  
         	[bookmark: pgfId-1070130]1024, 4096
  
         	[bookmark: pgfId-1070132]4096, 8192
  
         	[bookmark: pgfId-1070134]512, 1024
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1061445]Some RAM is reserved for the operating system and for other processes and is not listed here. For example, consider the case of 16 GB RAM in Table 7-3. The total maximum heap size for all 4 processes is (4096 + 4096 + 1024 + 4096) = 13312 Mb or 13 Gb. There is 3 GB additional RAM available for the operating system and for other processes. 
 
    
 
     
      [bookmark: pgfId-1061449]Configuration Commands
 
     [bookmark: pgfId-1061450]MRF provides a command and a set of sub-commands to read and modify heap sizes for Security Manager server processes. Minimum and maximum heap sizes can be set for the process by using the mrf command. Information on using of this command is displayed by executing this command as follows: 
 
     [bookmark: pgfId-1062036]Make sure that only valid process names are used while running mrf commands. No error is thrown when an invalid process name is specified. Valid process names are listed in Table 7-2. Process names are case-sensitive. 
 
    
 
     
      [bookmark: pgfId-1062096]Configuring Heap Sizes for Processes
 
     [bookmark: pgfId-1062562]Configuring heap sizes for Security Manager processes can be thought of as consisting of the following three major steps:
 
     [bookmark: pgfId-1062566]1. Save Existing Configuration 
 
     [bookmark: pgfId-1062570]2. Read Existing Configuration 
 
     [bookmark: pgfId-1062546]3. Modify Configuration 
 
    
 
     
      [bookmark: pgfId-1062233][bookmark: 82017]1. Save Existing Configuration 
 
     [bookmark: pgfId-1062264]Configuring a process heap size is a critical procedure that can affect the performance of Security Manager, so Cisco recommends that it be done only under the guidance of application experts. 
 
     [bookmark: pgfId-1062277]Also, as a precautionary measure, Cisco recommends that you save your existing memory configurations for processes before changing them, and MRF provides two methods for doing so. 
 
     [bookmark: pgfId-1062289] 1. The first method can be used if you are testing the configuration changes. In this case the old configuration can be saved, and new modifications can be reverted to old configurations, by using the two commands listed below, respectively: 
 
      
      [bookmark: pgfId-1062333]mrf backup 
     
 
      
      [bookmark: pgfId-1062290]mrf revert 
     
 
      
      [bookmark: pgfId-1062400] 
     
 
     [bookmark: pgfId-1062417] 2. The second method is useful if you would like to revert to old values after you have used the new configuration for a significant period. There are two ways of doing this; you can use one or the other of the following ways: 
 
     [bookmark: pgfId-1062418] a. You can run mrf revert, provided you have not run mrf backup after you did the configuration changes. 
 
     [bookmark: pgfId-1062441] b. You will be taking a backup of your Cisco Security Manager Server before you make configuration changes. If you want to revert the changes, then restore the backup. In this case, data changes done after backup was taken will be lost. 
 
    
 
     
      [bookmark: pgfId-1062485][bookmark: 17822]2. Read Existing Configuration 
 
     [bookmark: pgfId-1062581]Now that you have saved your data, you can query existing values for the processes by using the following command: 
 
     [bookmark: pgfId-1062583]mrf get_heap_params [process name] [memory] 
 
     [bookmark: pgfId-1062953]To configure the heap sizes, use the following command: 
 
     [bookmark: pgfId-1062955]mrf set_heap_params [process name] [X-Y] [min],[max]
 
     [bookmark: pgfId-1062957]The parameter [process name] can be any of the processes listed in Table 7-2. Process names are case-sensitive. 
 
     [bookmark: pgfId-1062959]You need to restart the Security Manager server after executing this command for the changes to take effect. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1062961]Note Changes made by using mrf set_heap_params can be lost if the backup that was taken before modifying heap parameters is restored. In this case, if you want to retain the new values, you can follow these steps: 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1063081] 1. Run, mrf backup
 
     [bookmark: pgfId-1063083] 2. Do application restore.
 
     [bookmark: pgfId-1063075] 3. Run, mrf revert
 
     [bookmark: pgfId-1062967]This command uses the following syntax:
 
     [bookmark: pgfId-1062969] mrf set_heap_params [process name] [X-Y] [min],[max] 
 
     [bookmark: pgfId-1063164]Sets minimum and maximum heap sizes 
 
     [bookmark: pgfId-1063166][X-Y[: memory range in MB to which heap sizes apply 
 
     [bookmark: pgfId-1062973][min],[max]: minimum and maximum heap sizes in MB. These are optional but at least one should be specified.
 
     [bookmark: pgfId-1062937]The parameter [process name] has one of the values listed in Table 7-2. Process names are case-sensitive. 
 
    
 
     
      [bookmark: pgfId-1063232]Examples of Modify Configuration 
 
     [bookmark: pgfId-1064272]The following examples illustrate how you can modify heap size configurations: 
 
      
      	 [bookmark: pgfId-1063259]mrf set_heap_params Tomcat 7372-8192 2048,4096 
 
     
 
     [bookmark: pgfId-1063302]Sets minimum and maximum heap sizes to 2048 MB and 4096 MB, respectively, for the Tomcat process when the RAM size is in the range of 7372 MB to 8192 MB 
 
      
      	 [bookmark: pgfId-1063303]mrf set_heap_params Tomcat 7372-8192 2048 
 
     
 
     [bookmark: pgfId-1063307]Sets the minimum heap size to 2048 MB for the Tomcat process when the RAM size is in the range of 7372 MB to 8192 MB 
 
      
      	 [bookmark: pgfId-1063312]mrf set_heap_params Tomcat 7372-8192,4096 
 
     
 
     [bookmark: pgfId-1063317]Sets the maximum heap size to 4096 MB for the Tomcat process when the RAM size is in the range of 7372 MB to 8192 MB 
 
      
      	 [bookmark: pgfId-1063304]mrf set_heap_params Tomcat 8080-8080 2048,4096 
 
     
 
     [bookmark: pgfId-1063366]Sets the minimum and maximum heap sizes to 2048 MB and 4096 MB, respectively, for the Tomcat process when the RAM size is 8080 MB. You can execute the getramsize command to get the existing RAM size in MB.
 
    
 
     
      [bookmark: pgfId-1063367]Verification of Modify Configuration
 
     [bookmark: pgfId-1063285]After heap parameters are set, you can verify the changes by executing the mrf get_heap_params command. 
 
    
 
     
      [bookmark: pgfId-1063756]Summary of Configuring Heap Sizes for Processes
 
     [bookmark: pgfId-1063785]The three major steps described in this section for configuring heap sizes for Security Manager processes can be summarized by the following commands, listed in their order of execution:
 
      
      [bookmark: pgfId-1063929]mrf backup  
     
 
      
      [bookmark: pgfId-1063930]mrf get_heap_params process  
     
 
      
      [bookmark: pgfId-1063931]mrf set_heap_params Tomcat 7372-8192 2048,4096  
     
 
      
      [bookmark: pgfId-1063915]mrf revert #if required to revert changes  
     
 
    
 
     
      [bookmark: pgfId-1063962]Typical scenarios in which the User Might Have to Reconfigure Heap Sizes
 
    
 
     
      [bookmark: pgfId-1063996]Scenario 1 
 
     [bookmark: pgfId-1064070]A Security Manager 4.0 user potentially may be using a maximum heap size of 4 GB for the Backend Process (VmsBackendServer). This is more than the default maximum heap size of 3 GB allocated in Security Manager 4.1 for 8 GB RAM. In this scenario, the user may have to reconfigure the Backend Process heap size to 4 GB. The user can choose to do this in case Event Management, which uses the Event Server process (VmsEventServer) is not enabled. 
 
    
 
     
      [bookmark: pgfId-1064031]Scenario 2 
 
     [bookmark: pgfId-1064074]Suppose Security Manager is being used in configuration-only mode (Event Management and reporting are disabled). In this scenario, the Backend Process and Tomcat heap sizes can be increased. 
 
    
 
     
      [bookmark: pgfId-1064044]Scenario 3 
 
     [bookmark: pgfId-1064075]Suppose Security Manager is being used in configuration-only mode (Event Management and reporting are disabled) and Event Management needs to be enabled. In this scenario, the Backend process and Tomcat heap sizes should be decreased, before enabling Event Management, so that the total of all heap sizes of Security Manager processes does not exceed the RAM size available to the server. 
 
    
 
     
      [bookmark: pgfId-1064057]Scenario 4 
 
     [bookmark: pgfId-1064076]Event Management and the Backend process are memory-intensive and need higher RAM allocation. (If event Management is unused, that RAM could be allocated for the Backend process by increasing its maximum heap size.) 
 
    
 
   
 
    
     [bookmark: pgfId-1062236][bookmark: 90201]Best Practices for Ongoing Server Security[bookmark: marker-1062235]
 
    [bookmark: pgfId-1034595]The least secure component of a system defines how secure the system is. The steps in the following checklist can help you to secure a server and its OS after you install Security Manager:
 
    [bookmark: pgfId-1034002]
 
     
      
       
        
        	[bookmark: pgfId-1033769]
 
          
          [image: ] 
         
  
        	 
          
          [bookmark: pgfId-1033771]Task 
         
  
       
 
        
        	[bookmark: pgfId-1033776]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1033781] 1. Monitor server security regularly. Log and review system activity. Use security tools such as the Microsoft Security Configuration Tool Set (MSCTS) and Fport to periodically review the security configuration of your server. Review the log file for the standalone version of Cisco Security Agent that is installed sometimes on a Security Manager server.
 [bookmark: pgfId-1036870]Tip You can obtain MSCTS from the Microsoft web site and Fport from the Foundstone/McAfee web site.  
       
 
        
        	[bookmark: pgfId-1033791]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1033796] 2. Limit physical access to your server. If your server contains removable media drives, set the server to boot from the hard drive first. Your data can be compromised if someone boots your server from a removable media drive. You can typically set the boot order in the system BIOS. Make sure you protect the BIOS with a strong password.
  
       
 
        
        	[bookmark: pgfId-1033827]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1033830] 3. Do not install remote access or administration tools on the server. These tools provide a point of entry to your server and are a security risk.
  
       
 
        
        	[bookmark: pgfId-1033836]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1033839] 4. Set a virus scanning application to run automatically and continuously on the server. Virus scanning software can prevent trojan horse applications from infecting your server. Update the virus signatures regularly.
  
       
 
        
        	[bookmark: pgfId-1040636]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1071403] 5. Back up your server database frequently. Store all backups in a secure location with restricted access. 
 [bookmark: pgfId-1071404]Note Remove the logs/ database backup files regularly in order to maintain sufficient free space on your hard disk at all times. It is recommended to have a minimum of 10GB hard disk space free.
  
       
 
        
        	[bookmark: pgfId-1071429]
 
          
          [image: ] 
         
  
        	[bookmark: pgfId-1071439] 6. Back up your Security Manager Server regularly. If regular backups have not been made, or if several changes have been made to your Security Manager installation, back up your Security Manager server before running any Windows Update.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1036947][bookmark: 55868]Verifying an Installation or an Upgrade[bookmark: marker-1059251]
 
    [bookmark: pgfId-1036949]You can use Common Services to verify that you installed or upgraded Security Manager successfully. If you are trying to verify the installation because the Security Manager interface does not appear or is not displayed correctly, see Server Problems After Installation.
 
    
 
    [bookmark: pgfId-1056693]Step 1 Use a browser on the client system to log in to the Security Manager server using either of the following:
 
     
      
      	 [bookmark: pgfId-1056694]For HTTP service— http:// < server_name > :1741 
 
      	 [bookmark: pgfId-1056695]For SSL service— https:// < server_name > :443 
 
     
 
    
 
    [bookmark: pgfId-1056710]To learn which browsers and browser versions are supported, see Client Requirements, page 3-10.
 
    [bookmark: pgfId-1038380]Step 2 From the Cisco Security Management Suite page, click the Server Administration panel to open Common Services at the Server > Admin page.
 
    [bookmark: pgfId-1036952]Step 3 To display the Process Management page, click Processes.
 
    [bookmark: pgfId-1036953]The resulting list names all the server processes and describes the operational status of each process. The following processes must be running normally:
 
     
      
      	 [bookmark: pgfId-1036955]vmsDbEngine
 
      	 [bookmark: pgfId-1036956]vmsDbMonitor
 
      	 [bookmark: pgfId-1040257]EDS
 
     
 
    
 
    [bookmark: pgfId-1040567]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1045926][bookmark: 68894]Where To Go Next[bookmark: marker-1059256]
 
    [bookmark: pgfId-1045966]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1045929]If you want to: 
         
  
        	 
          
          [bookmark: pgfId-1045931]Do this: 
         
  
       
 
        
        	[bookmark: pgfId-1045934]Understand the basics 
  
        	[bookmark: pgfId-1045936]See the interactive JumpStart guide that opens when you start Security Manager. 
  
       
 
        
        	[bookmark: pgfId-1045939]Get up and running with the product quickly 
  
        	[bookmark: pgfId-1045941]See the “Getting Started with Security Manager” topic in the online help, or see Chapter 1 of User Guide for Cisco Security Manager.
  
       
 
        
        	[bookmark: pgfId-1045943]Complete the product configuration
  
        	[bookmark: pgfId-1045945]See the “Completing the Initial Security Manager Configuration” topic in the online help, or see Chapter 1 of User Guide for Cisco Security Manager.
  
       
 
        
        	[bookmark: pgfId-1045947]Manage user authentication and authorization
  
        	[bookmark: pgfId-1045949]See the following topics:
 
          
          	 [bookmark: pgfId-1057898]User Permissions
 
          	 [bookmark: pgfId-1057905]Integrating Security Manager with Cisco Secure ACS 
 
         
  
       
 
        
        	[bookmark: pgfId-1045956][bookmark: marker-1058845]Bootstrap your devices
  
        	[bookmark: pgfId-1045958]See the “Preparing Devices for Management” topic in the online help, or see Chapter 2 of User Guide for Cisco Security Manager 4.9, available at http://www.cisco.com/c/en/us/support/security/security-manager/products-user-guide-list.html. 
  
       
 
       
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-607509][bookmark: 8][bookmark: aduser_cncpt_ManagingUserAccounts]Managing User Accounts [bookmark: marker-1065797][bookmark: marker-1065806] 
      
      
 
     
 
 
    [bookmark: pgfId-607511]Managing user accounts involves account creation and user permissions: 
 
     
     	 [bookmark: pgfId-1079951]Account Creation. Your account can be a local account on the Security Manager Server, an ACS account on the CiscoWorks Common Services server, or a non-ACS account on the Common Services server. 
 
     	 [bookmark: pgfId-1079952]User Permissions. Your permissions (or privileges) are the tasks that you are authorized to perform. Your permissions are defined by your role within Security Manager. Your role within Security Manager is established after your username and password are authenticated. Authentication is done by Security Manager during login. 
 
    
 
   
 
    
     [bookmark: pgfId-1079917][bookmark: 97564]Account Creation 
 
    [bookmark: pgfId-1079849]To use Cisco Security Manager, you must log in with the admin account that you created during installation and create an account for each user. You can create the following types of accounts: 
 
     
     	 [bookmark: pgfId-1080188]Local Account 
 
     	 [bookmark: pgfId-1079995]ACS Account 
 
     	 [bookmark: pgfId-1080352]Non-ACS Account 
 
    
 
     
      [bookmark: pgfId-1080015][bookmark: 51859]Local Account 
 
     [bookmark: pgfId-1115145]To create a local account:
 
     [bookmark: pgfId-1115389] 1. Do one of the following: 
 
      
      	 [bookmark: pgfId-1115147]If you currently have the Security Manager client open and are logged in with an admin account, you can select  Tools > Security Manager Administration and select  Server Security from the table of contents. The Server Security page has buttons that link to and open specific pages in Common Services. Click  Local User Setup to navigate to the Local User Setup page in Common Services.
 
      	 [bookmark: pgfId-1114609]Using your web browser, link to the Security Manager server using the URL https:// servername , where  servername is the IP address or DNS name of the server. This URL opens the Security Manager home page. Click  Server Administration to open Common Services. Point to  Server > Single-Server Management > Local User Setup to navigate to the Local User Setup page in Common Services.
 
     
 
     [bookmark: pgfId-1114532] 2. Click Add.
 
    
 
     
      [bookmark: pgfId-1080353][bookmark: 23528]ACS Account 
 
     [bookmark: pgfId-1080608]To create an ACS account:
 
     [bookmark: pgfId-1116009] 1. Do one of the following: 
 
      
      	 [bookmark: pgfId-1116010]If you currently have the Security Manager client open and are logged in with an admin account, you can select  Tools > Security Manager Administration and select  Server Security from the table of contents. The Server Security page has buttons that link to and open specific pages in Common Services. Click  AAA Setup to navigate to the Authentication Mode Setup page in Common Services.
 
      	 [bookmark: pgfId-1116011]Using your web browser, link to the Security Manager server using the URL https:// servername , where  servername is the IP address or DNS name of the server. This URL opens the Security Manager home page. Click  Server Administration to open Common Services. Point to  Server > AAA Mode Setup to navigate to the Authentication Mode Setup page in Common Services.
 
     
 
     [bookmark: pgfId-1112436] 2. Select ACS under AAA Mode Setup.
 
      
       
     
 
     
 
     [bookmark: pgfId-1081197]Tip An ACS account uses (1) the ACS type of AAA Mode Setup (this is on the Authentication Mode Setup page) and (2) the ACS login module in CiscoWorks Common Services. However, you do not need to select the ACS login module; it is selected for you automatically when you select the ACS type of AAA Mode Setup. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1081200][bookmark: 95820]Non-ACS Account 
 
     [bookmark: pgfId-1112890]To create a non-ACS account:
 
     [bookmark: pgfId-1116289] 1. Do one of the following: 
 
      
      	 [bookmark: pgfId-1116290]If you currently have the Security Manager client open and are logged in with an admin account, you can select  Tools > Security Manager Administration and select  Server Security from the table of contents. The Server Security page has buttons that link to and open specific pages in Common Services. Click  AAA Setup to navigate to the Authentication Mode Setup page in Common Services.
 
      	 [bookmark: pgfId-1116291]Using your web browser, link to the Security Manager server using the URL https:// servername , where  servername is the IP address or DNS name of the server. This URL opens the Security Manager home page. Click  Server Administration to open Common Services. Point to  Server > AAA Mode Setup to navigate to the Authentication Mode Setup page in Common Services.
 
     
 
     [bookmark: pgfId-1116292] 2. Select Local RBAC under AAA Mode Setup.
 
      
       
     
 
     
 
     [bookmark: pgfId-1112886]Tip A non-ACS account uses (1) the Local RBAC type of AAA Mode Setup (this is on the Authentication Mode Setup page) and (2) one of the following login modules in CiscoWorks Common Services: CiscoWorks Local (the default login module), Local NT System, MS Active Directory, RADIUS, or TACACS+. 
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1080066][bookmark: 24][bookmark: defapset_cncpt_SettingUpUserPermissions]User Permissions [bookmark: marker-1080062][bookmark: marker-1080063][bookmark: marker-1080064][bookmark: marker-1080065]
 
    [bookmark: pgfId-1080040]Cisco Security Manager authenticates your username and password before you can log in. After they are authenticated, Security Manager establishes your role within the application. This role defines your permissions (also called privileges), which are the set of tasks or operations that you are authorized to perform. If you are not authorized for certain tasks or devices, the related menu items, items in tables of contents, and buttons are hidden or disabled. In addition, a message tells you that you do not have permission to view the selected information or perform the selected operation.
 
    [bookmark: pgfId-1080198][bookmark: 48443]Authentication and authorization for Security Manager is managed either by the CiscoWorks server or the Cisco Secure Access Control Server (ACS). By default, CiscoWorks manages authentication and authorization, but you can change to Cisco Secure ACS by using the AAA Mode Setup page in CiscoWorks Common Services. For more information on ACS integration, refer to the following sections of this chapter: 
 
     
     	 [bookmark: pgfId-1082907]Integrating Security Manager with Cisco Secure ACS 
 
     	 [bookmark: pgfId-1095720]Troubleshooting Security Manager-ACS Interactions 
 
    
 
    [bookmark: pgfId-1095721]Prior to Security Manager 4.3, the major advantages of using Cisco Secure ACS were (1) the ability to create highly granular user roles with specialized permission sets (for example, allowing the user to configure certain policy types but not others) and (2) the ability to restrict users to certain devices by configuring network device groups (NDGs). These granular privileges (effectively “role-based access control,” or RBAC) were not available in Security Manager 4.2 and earlier versions, unless you used Cisco Secure ACS. These granular privileges (RBAC) are available in Security Manager 4.3 and later because they use Common Services 4.0 or later, in which local RBAC is available without the use of ACS. 
 
    [bookmark: pgfId-1082863]Security Manager 4.9 retains compatibility with ACS 4.2. See Integrating Security Manager with Cisco Secure ACS. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1083026]Note Users who wish to migrate their RBAC abilities from ACS to Common Services must do so manually; there are no migration scripts or other migration support. 
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-607553]Tip To view the complete Security Manager permissions tree, log in to Cisco Secure ACS, then click Shared Profile Components on the navigation bar. For more information, see Customizing Cisco Secure ACS Roles.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-607555]The following topics describe user permissions:
 
     
     	 [bookmark: pgfId-607560]Security Manager ACS Permissions
 
     	 [bookmark: pgfId-607565]Understanding CiscoWorks Roles
 
     	 [bookmark: pgfId-607570]Understanding Cisco Secure ACS Roles
 
     	 [bookmark: pgfId-607575]Default Associations Between Permissions and Roles in Security Manager
 
    
 
     
      [bookmark: pgfId-607587][bookmark: 64][bookmark: aduser_cncpt_SecurityManagerPermissions]Security Manager ACS Permissions[bookmark: marker-1065838][bookmark: marker-1065843][bookmark: marker-1065848]
 
     [bookmark: pgfId-607589]Cisco Security Manager provides default ACS roles and permissions. You can customize the default roles or create additional roles to suit your needs. However, when defining new roles or customizing default roles, make sure that the permissions you select are logical within the context of the Security Manager application. For example, if you assign modify permissions without view permissions, you lock the user out of the application.
 
     [bookmark: pgfId-1063083]Security Manager classifies permissions into the following categories. For an explanation of individual permissions, see the online help integrated with Cisco Secure ACS (for information on viewing the permissions, see Customizing Cisco Secure ACS Roles).
 
      
      	 [bookmark: pgfId-1063088] View —Allows you to view the current settings. These are the main view permissions:[bookmark: marker-1063087]
 
     
 
     [bookmark: pgfId-1063089] – View > Policies. Allows you to view the various types of policies. The folder contains permissions for various policy classes, such as firewall and NAT.
 
     [bookmark: pgfId-607602] – View > Objects. Allows you to view the various types of policy objects. The folder contains permissions for each type of policy object.
 
     [bookmark: pgfId-607604] – View > Admin. Allows you to view Security Manager administrative settings.
 
     [bookmark: pgfId-607606] – View > CLI. Allows you to view the CLI commands configured on a device and preview the commands that are about to be deployed.
 
     [bookmark: pgfId-607608] – View > Config Archive. Allows you to view the list of configurations contained in the configuration archive. You cannot view the device configuration or any CLI commands.
 
     [bookmark: pgfId-607610] – View > Devices. Allows you to view devices in Device view and all related information, including their device settings, properties, assignments, and so on. You can limit device permissions to particular sets of devices by configuring network device groups (NDGs).
 
     [bookmark: pgfId-607612] – View > Device Managers. Allows you to launch read-only versions of the device managers for individual devices, such as the Cisco Router and Security Device Manager (SDM) for Cisco IOS routers.
 
     [bookmark: pgfId-607614] – View > Topology. Allows you to view maps configured in Map view. 
 
     [bookmark: pgfId-1071190] – View > Event Viewer. Allows you to view events in the Event Viewer in both the Real Time Viewer and the Historical Viewer. 
 
     [bookmark: pgfId-1071191] – View > Report Manager. Allows you to view reports in Report Manager. 
 
     [bookmark: pgfId-1074633] – View > Schedule Reports. Allows you to schedule reports in Report Manager. 
 
     [bookmark: pgfId-1112931] – View > Health and Performance Manager. Allows you to launch the Health and Performance Manager.
 
     [bookmark: pgfId-1112927] – View > Image Manager. Allows you to launch the Image Manager.
 
      
      	 [bookmark: pgfId-607618] Modify —Allows you to change the current settings.[bookmark: marker-607616]
 
     
 
     [bookmark: pgfId-607620] – Modify > Policies. Allows you to modify the various types of policies. The folder contains permissions for various policy classes.
 
     [bookmark: pgfId-607622] – Modify > Objects. Allows you to modify the various types of policy objects. The folder contains permissions for each type of policy object.
 
     [bookmark: pgfId-607624] – Modify > Admin. Allows you to modify Security Manager administrative settings.
 
     [bookmark: pgfId-607626] – Modify > Config Archive. Allows you to modify the device configuration in the Configuration Archive. In addition, it allows you to add configurations to the archive and customize the Configuration Archive tool.
 
     [bookmark: pgfId-607628] – Modify > Devices. Allows you to add and delete devices, as well as modify device properties and attributes. To discover the policies on the device being added, you must also enable the Import permission. In addition, if you enable the Modify > Devices permission, make sure that you also enable the Assign > Policies > Interfaces permission. You can limit device permissions to particular sets of devices by configuring network device groups (NDGs).
 
     [bookmark: pgfId-607630] – Modify > Hierarchy. Allows you to modify device groups.
 
     [bookmark: pgfId-607632] – Modify > Topology. Allows you to modify maps in Map view. 
 
     [bookmark: pgfId-1071266] – Modify > Manage Event Monitoring. Allows you to enable and disable the monitoring in Security Manager for any device, so that Security Manager starts or stops event reception and processing from that device. 
 
     [bookmark: pgfId-1113221] – Modify > Modify Image Repository. Allows you to modify items in the Image Repository and to check for image updates from Cisco.com.
 
      
      	 [bookmark: pgfId-1113222] Assign —Allows you to assign the various types of policies to devices and VPNs. The folder contains permissions for various policy classes.[bookmark: marker-1113223]
 
      	 [bookmark: pgfId-607640] Approve —Allows you to approve policy changes and deployment jobs.[bookmark: marker-607638]
 
      	 [bookmark: pgfId-607644] Control —Allows you to issue commands to devices, such as ping. This permission is used for connectivity diagnostics.[bookmark: marker-607642]
 
      	 [bookmark: pgfId-607648] Deploy —Allows you to deploy configuration changes to the devices in your network and perform rollback to return to a previously deployed configuration.[bookmark: marker-607646]
 
      	 [bookmark: pgfId-607652] Import —Allows you to import the configurations that are already deployed on devices into Security Manager. You must also have view device and modify device privileges.[bookmark: marker-607650]
 
      	 [bookmark: pgfId-607656] Submit —Allows you to submit your configuration changes for approval.[bookmark: marker-607654]
 
     
 
     [bookmark: pgfId-607658]Tips
 
      
      	 [bookmark: pgfId-607660]When you select modify, assign, approve, import, control or deploy permissions, you must also select the corresponding view permissions; otherwise, Security Manager will not function properly.
 
      	 [bookmark: pgfId-607662]When you select modify policy permissions, you must also select the corresponding assign and view policy permissions.
 
      	 [bookmark: pgfId-607664]When you permit a policy that uses policy objects as part of its definition, you must also grant view permissions to these object types. For example, if you select the permission for modifying routing policies, you must also select the permissions for viewing network objects and interface roles, which are the object types required by routing policies.
 
      	 [bookmark: pgfId-607666]The same holds true when permitting an object that uses other objects as part of its definition. For example, if you select the permission for modifying user groups, you must also select the permissions for viewing network objects, ACL objects, and AAA server groups.
 
      	 [bookmark: pgfId-607668]You can limit device permissions to particular sets of devices by configuring network device groups (NDGs). NDGs have the following effects on policy permissions:
 
     
 
     [bookmark: pgfId-607670] – To view a policy, you must have permissions for at least one device to which the policy is assigned.
 
     [bookmark: pgfId-607672] – To modify a policy, you must have permissions for all the devices to which the policy is assigned.
 
     [bookmark: pgfId-607674] – To view, modify, or assign a VPN policy, you must have permissions for all the devices in the VPN topology.
 
     [bookmark: pgfId-607676] – To assign a policy to a device, you need permissions only for that device, regardless of whether you have permissions for any other devices to which the policy is assigned. (VPN policies are an exception, as noted above.) However, if a user assigns a policy to a device for which you do not have permissions, you cannot modify that policy.
 
    
 
     
      [bookmark: pgfId-607686][bookmark: 189][bookmark: defapset_cncpt_UnderstandingCiscoWorksRoles]Understanding CiscoWorks Roles[bookmark: marker-1065891][bookmark: marker-1065949]
 
     [bookmark: pgfId-607688]When users are created in CiscoWorks Common Services, they are assigned one or more roles. The permissions associated with each role determine the operations that each user is authorized to perform in Security Manager.
 
     [bookmark: pgfId-607690]The following topics describe CiscoWorks roles:
 
      
      	 [bookmark: pgfId-607695]CiscoWorks Common Services Default Roles
 
      	 [bookmark: pgfId-1063285]Selecting an Authorization Type and Assigning Roles to Users in Common Services
 
     
 
    
 
     
      [bookmark: pgfId-1063290][bookmark: 206][bookmark: defapset_cncpt_CiscoWorksCommonServicesDefaultRoles]CiscoWorks Common Services Default Roles[bookmark: marker-1065985][bookmark: marker-1066006]
 
     [bookmark: pgfId-1063291]CiscoWorks Common Services contains the following default roles for Security Manager:
 
      
      	 [bookmark: pgfId-1093583] Help Desk —Help desk users can view (but not modify) devices, policies, objects, and topology maps.[bookmark: marker-1093584]
 
      	 [bookmark: pgfId-1093585] Approver —Can approve the modification of changes and CLI changes.[bookmark: marker-1093586]
 
      	 [bookmark: pgfId-1093587] Network Operator —In addition to view permissions, network operators can view CLI commands and Security Manager administrative settings. Network operators can also modify the configuration archive and issue commands (such as ping) to devices.[bookmark: marker-1093588]
 
      	 [bookmark: pgfId-607728] Network Administrator —Can only deploy changes.[bookmark: marker-607726]
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-607733]Note Cisco Secure ACS features a default role called Network Administrator that contains a different set of permissions. For more information, see Understanding Cisco Secure ACS Roles.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1078796] System Administrator —System administrators have complete access to all Security Manager permissions, including modification, policy assignment, activity and job approval, discovery, deployment, and issuing commands to devices.[bookmark: marker-1078797]
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1093307]Tip In Security Manager, the System Administrator role has the highest level of permissions. 
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1093142] Super Admin— Can perform all CiscoWorks operations including the administration and approval tasks. By default, this role has full privileges.  
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1093360]Tip In Security Manager, the Super Admin role does not have the highest level of permissions. Also, the Super Admin role is specific to Common Services and not to ACS. 
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1084879] Security Administrator— Can only modify, assign, and submit changes. 
 
      	 [bookmark: pgfId-1084888] Security Approver— Can approve only the modification of changes. 
 
     
 
    
 
     
      [bookmark: pgfId-1084896]Image Manager
 
     [bookmark: pgfId-1084944]Additional tasks for each of the default roles are defined for Image Manager, a feature that first appeared in Security Manager 4.3 and continues to be available in Security Manager 4.9:
 
      
      	 [bookmark: pgfId-1078805]Launching Image Manager 
 
      	 [bookmark: pgfId-1078811]Adding images to the repository in Security Manager 
 
      	 [bookmark: pgfId-1078813]Creating image upgrade jobs 
 
     
 
     [bookmark: pgfId-1079224]When using a local account (unique to Security Manager, defined on the Security Manager server), these additional tasks are assigned to different roles as listed in Table 8-1. 
 
     [bookmark: pgfId-1079285]
 
      
       
        
        [bookmark: pgfId-1095378]Table 8-1 [bookmark: 19136]Image Manager Tasks for Default Roles
 
        
        
         
         	 
           
           [bookmark: pgfId-1095386]Role 
          
  
         	 
           
           [bookmark: pgfId-1095388]Tasks 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1095396]Launch and View 
          
  
         	 
           
           [bookmark: pgfId-1095398]Add Images to Repository 
          
  
         	 
           
           [bookmark: pgfId-1095400]Create Image Upgrade Jobs 
          
  
        
 
         
         	[bookmark: pgfId-1095402]Help Desk
  
         	[bookmark: pgfId-1095404]Yes
  
         	[bookmark: pgfId-1095406]No
  
         	[bookmark: pgfId-1095408]No
  
        
 
         
         	[bookmark: pgfId-1095410]Approver
  
         	[bookmark: pgfId-1095412]Yes
  
         	[bookmark: pgfId-1095414]No
  
         	[bookmark: pgfId-1095416]No
  
        
 
         
         	[bookmark: pgfId-1095418]Network Operator
  
         	[bookmark: pgfId-1095420]Yes
  
         	[bookmark: pgfId-1095422]No
  
         	[bookmark: pgfId-1095424]No
  
        
 
         
         	[bookmark: pgfId-1095426]Network Administrator
  
         	[bookmark: pgfId-1095428]Yes
  
         	[bookmark: pgfId-1095430]Yes
  
         	[bookmark: pgfId-1095432]Yes
  
        
 
         
         	[bookmark: pgfId-1095434]System Administrator
  
         	[bookmark: pgfId-1095436]Yes
  
         	[bookmark: pgfId-1095438]Yes
  
         	[bookmark: pgfId-1095440]Yes
  
        
 
         
         	[bookmark: pgfId-1095449]Security Administrator
  
         	[bookmark: pgfId-1095451]Yes
  
         	[bookmark: pgfId-1095453]No
  
         	[bookmark: pgfId-1095455]No
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1078804]For details about which Security Manager permissions are associated with each CiscoWorks role, see Default Associations Between Permissions and Roles in Security Manager.
 
     [bookmark: pgfId-1094948]For a detailed series of tables that shows the RBAC permissions matrix for Image Manager, see Appendix B, “Permissions Matrix for Image Manager.”
 
     [bookmark: pgfId-607744]Tips
 
      
      	 [bookmark: pgfId-607746]Additional roles, such as Export Data, might be displayed in Common Services if additional applications are installed on the server. The Export Data role is for third-party developers and is not used by Security Manager.
 
      	 [bookmark: pgfId-607751]Although you cannot change the definition of CiscoWorks roles, you can define which roles are assigned to each user. For more information, see Selecting an Authorization Type and Assigning Roles to Users in Common Services.
 
      	 [bookmark: pgfId-1090851]To generate a permissions table in CiscoWorks, select  Server > Reports > Permission  and click  Generate Report .
 
     
 
    
 
     
      [bookmark: pgfId-1090856][bookmark: 259][bookmark: defapset_proc_AssigningRolestoUsersinCiscoWorksCommonServices]Selecting an Authorization Type and Assigning Roles to Users in Common Services[bookmark: marker-1090854][bookmark: marker-1090855] 
 
     [bookmark: pgfId-1090857]In CiscoWorks Common Services 4.2.2, the Local User Setup > Add page is used (1) to select one of the three authorization types that are available for local users and (2) to assign roles to users. The three authorization types are the following: 
 
      
      	 [bookmark: pgfId-1086880]Full Authorization 
 
      	 [bookmark: pgfId-1086882]Enable Task Authorization 
 
      	 [bookmark: pgfId-1086884]Enable Device Authorization 
 
     
 
     [bookmark: pgfId-1087476]You must select one of these three authorization types (Full Authorization, Enable Task Authorization, or Enable Device Authorization) when you add a local user in Common Services. 
 
     [bookmark: pgfId-1087461]Selecting any of these three authorization types enables you to select the roles that the local user should have. Selecting the roles that the local user should have is important because it defines the operations that the user is authorized to perform. 
 
     [bookmark: pgfId-1092224]For example, if you select the Help Desk role, the user is limited to view operations and cannot modify any data. For another example, if you assign the Network Operator role, the user is also able to modify the configuration archive. You can assign more than one role to a particular user. 
 
     [bookmark: pgfId-1091626]By default the Help Desk role is enabled. You can also clear default roles, and you can set any roles to be default roles. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1074619]Tip You must restart the Security Manager client after making changes to user permissions. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1074604]Related Topics
 
      
      	 [bookmark: pgfId-1063338]Security Manager ACS Permissions
 
      	 [bookmark: pgfId-1063342]Default Associations Between Permissions and Roles in Security Manager
 
      	 [bookmark: pgfId-1113241]Understanding CiscoWorks Roles
 
     
 
     
 
     [bookmark: pgfId-1113242]Step 1 Navigate to the Local User Setup page in Common Services by following this path: 
 
     [bookmark: pgfId-1113538]Server where Security Manager is installed > 
 
     [bookmark: pgfId-1113539]desktop icon for Cisco Security Manager application > 
 
     [bookmark: pgfId-1113540]admin account login (or user account with sufficient privileges) > 
 
     [bookmark: pgfId-1113541]Server Administration > 
 
     [bookmark: pgfId-1087987]Server > [menu selector symbol] >
 
     [bookmark: pgfId-1087988]Security > 
 
     [bookmark: pgfId-1087989]Single-Server Management > 
 
     [bookmark: pgfId-1087990]Local User Setup
 
     [bookmark: pgfId-1090050]Step 2 Do one of the following:
 
      
      	 [bookmark: pgfId-1090051]To create a user, click  Add and enter the appropriate information in the following fields: Username, Password, Verify Password, and Email.
 
      	 [bookmark: pgfId-1090052]To change the authorizations of an existing user, check the check box next to the username and click  Edit . 
 
     
 
     [bookmark: pgfId-1088666]Step 3 Select Full Authorization if you want the user to have all the roles (Help Desk, Approver, Network Operator, Network Administrator, System Administrator, Super Admin, Security Administrator, and Security Approver) that are available in Security Manager. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1088798]Tip If you select Full Authorization, you cannot also select Enable Task Authorization or Enable Device Authorization (as indicated by the radio button format). 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1091774]Skip to Step 6 in this procedure. 
 
     [bookmark: pgfId-1088675]Step 4 Select Enable Task Authorization if you want the new user to have only roles that you select (such as Network Operator only). 
 
      
       
     
 
     
 
     [bookmark: pgfId-1088935]Tip If you select Enable Task Authorization, you cannot also select Full Authorization or Enable Device Authorization (as indicated by the radio button format).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1091703] a. Select one or more of the following roles: Help Desk, Approver, Network Operator, Network Administrator, System Administrator, Super Admin, Security Administrator, and Security Approver. For more information about each role, see CiscoWorks Common Services Default Roles.
 
     [bookmark: pgfId-1091759] b. Skip to Step 8 in this procedure. 
 
     [bookmark: pgfId-1088676]Step 5 Select Enable Device Authorization if you want the new user to be authorized only for device groups that you select, not all of the device groups that are present in your Security Manager installation. (You can define device groups on the Device Groups page at Security Manager > Tools > Security Manager Administration > Device Groups.) 
 
      
       
     
 
     
 
     [bookmark: pgfId-1089036]Tip If you select Enable Device Authorization, you cannot also select Full Authorization or Enable Task Authorization (as indicated by the radio button format).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1091812] a. Select the device group(s) that you want the new user to be authorized for. 
 
     [bookmark: pgfId-1091819] b. Select one or more of the following roles: Help Desk, Approver, Network Operator, Network Administrator, System Administrator, Super Admin, Security Administrator, and Security Approver. For more information about each role, see CiscoWorks Common Services Default Roles.
 
     [bookmark: pgfId-1090419]Step 6 Click OK to save your changes.
 
     [bookmark: pgfId-1090420]Step 7 Restart the Security Manager client.
 
     [bookmark: pgfId-1090421]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1063220][bookmark: 310][bookmark: defapset_cncpt_UnderstandingCiscoSecureACSRoles]Understanding Cisco Secure ACS Roles[bookmark: marker-1066070][bookmark: marker-1066083]
 
     [bookmark: pgfId-1063221]Prior to Common Services 4.0 (used with Security Manager 4.3 and 4.4) and Common Services 4.2.2 (used with Security Manager 4.5, 4.6, 4.7, 4.8 and 4.9), Cisco Secure ACS provided greater flexibility than Common Services for managing Security Manager permissions because it (ACS) supported application-specific roles (effectively “role-based access control,” or RBAC). 
 
     [bookmark: pgfId-1084967]These granular privileges (RBAC) are available in Common Services 4.0 and 4.2.2, in which local RBAC is available without the use of ACS. Each role is made up of a set of permissions that determine the level of authorization to Security Manager tasks. In Cisco Secure ACS, you assign a role to each user group (and optionally, to individual users as well), which enables each user in that group to perform the operations authorized by the permissions defined for that role.
 
     [bookmark: pgfId-607819]In addition, you can assign these roles to Cisco Secure ACS device groups, allowing permissions to be differentiated on different sets of devices.
 
      
       
     
 
     
 
     [bookmark: pgfId-607821]Note Cisco Secure ACS device groups are independent of Security Manager device groups.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-607823]The following topics describe Cisco Secure ACS roles:
 
      
      	 [bookmark: pgfId-607828]Cisco Secure ACS Default Roles
 
      	 [bookmark: pgfId-607833]Customizing Cisco Secure ACS Roles
 
     
 
    
 
     
      [bookmark: pgfId-607843][bookmark: 329][bookmark: defapset_cncpt_CiscoSecureACSDefaultRoles]Cisco Secure ACS Default Roles[bookmark: marker-1066096][bookmark: marker-1066105]
 
     [bookmark: pgfId-607848]Cisco Secure ACS includes the same roles as CiscoWorks (see Understanding CiscoWorks Roles), plus these additional roles:
 
      
      	 [bookmark: pgfId-1063365] Security Approver —Security approvers can view (but not modify) devices, policies, objects, maps, CLI commands, and administrative settings. In addition, security approvers can approve or reject the configuration changes contained in an activity.
 
      	 [bookmark: pgfId-1063367] Security Administrator —In addition to having view permissions, security administrators can modify devices, device groups, policies, objects, and topology maps. They can also assign policies to devices and VPN topologies, and perform discovery to import new devices into the system.[bookmark: marker-1063368]
 
      	 [bookmark: pgfId-607860] Network Administrator —In addition to view permissions, network administrators can modify the configuration archive, perform deployment, and issue commands to devices.[bookmark: marker-607858]
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-607865]Note The permissions contained in the Cisco Secure ACS network administrator role are different from those contained in the CiscoWorks network administrator role. For more information, see Understanding CiscoWorks Roles.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-607870]Unlike CiscoWorks, Cisco Secure ACS enables you to customize the permissions associated with each Security Manager role. For more information about modifying the default roles, see Customizing Cisco Secure ACS Roles.
 
     [bookmark: pgfId-607875]For details about which Security Manager permissions are associated with each Cisco Secure ACS role, see Default Associations Between Permissions and Roles in Security Manager.
 
     [bookmark: pgfId-607877]Related Topics
 
      
      	 [bookmark: pgfId-607882]Integrating Security Manager with Cisco Secure ACS
 
      	 [bookmark: pgfId-607887]User Permissions
 
     
 
    
 
     
      [bookmark: pgfId-607899][bookmark: 372][bookmark: defapset_proc_CustomizingCiscoSecureACSRoles]Customizing Cisco Secure ACS Roles[bookmark: marker-1066128][bookmark: marker-1066746] 
 
     [bookmark: pgfId-607901]Cisco Secure ACS enables you to modify the permissions associated with each Security Manager role. You can also customize Cisco Secure ACS by creating specialized user roles with permissions that are targeted to particular Security Manager tasks.
 
      
       
     
 
     
 
     [bookmark: pgfId-607903]Note You must restart Security Manager after making changes to user permissions.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-607905]Related Topics
 
      
      	 [bookmark: pgfId-607910]Security Manager ACS Permissions
 
      	 [bookmark: pgfId-607915]Default Associations Between Permissions and Roles in Security Manager
 
     
 
     
 
     [bookmark: pgfId-607917]Step 1 In Cisco Secure ACS, click Shared Profile Components on the navigation bar.
 
     [bookmark: pgfId-607919]Step 2 Click Cisco Security Manager on the Shared Components page. The roles that are configured for Security Manager are displayed.
 
     [bookmark: pgfId-607921]Step 3 Do one of the following:
 
      
      	 [bookmark: pgfId-607923]To create a role, click  Add . Enter a name for the role and, optionally, a description.
 
      	 [bookmark: pgfId-607925]To modify an existing role, click the role.
 
     
 
     [bookmark: pgfId-607927]Step 4 Check and uncheck the check boxes in the permissions tree to define the permissions for this role.
 
     [bookmark: pgfId-607929]Checking the check box for a branch of the tree selects all permissions in that branch. For example, selecting the Assign checkbox selects all the assign permissions.
 
     [bookmark: pgfId-607934]Descriptions of the individual permissions are included in the window. For additional information, see Security Manager ACS Permissions.
 
      
       
     
 
     
 
     [bookmark: pgfId-607936]Tip When you select modify, approve, assign, import, control or deploy permissions, you must also select the corresponding view permissions; otherwise, Security Manager does not function properly.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-607938]Step 5 Click Submit to save your changes.
 
     [bookmark: pgfId-607940]Step 6 Restart Security Manager.
 
     [bookmark: pgfId-607942]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-607956][bookmark: 425][bookmark: defapset_cncpt_DefaultAssociationsBetweenPermissionsandRolesinSecurityManager]Default Associations Between Permissions and Roles in Security Manager[bookmark: marker-1066146][bookmark: marker-1066151][bookmark: marker-1066156][bookmark: marker-1066161]
 
     [bookmark: pgfId-607964]Table 8-2 shows how Security Manager permissions are associated with CiscoWorks Common Services roles and the default roles in Cisco Secure ACS. Some roles (Super Admin, Security Administrator, and Security Approver) are not listed because they are not specifically associated with the default roles in Cisco Secure ACS. For information about the specific permissions, see Security Manager ACS Permissions.
 
     [bookmark: pgfId-607967]
 
      
       
        
        [bookmark: pgfId-1093895]Table 8-2 [bookmark: 450]Default Permission to Role Associations in Security Manager and CiscoWorks Common Services 
 
        
        
         
         	 
           
           [bookmark: pgfId-1093911]Permissions 
          
  
         	 
           
           [bookmark: pgfId-1093913]Roles 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1093929]System Admin. 
          
  
         	 
           
           [bookmark: pgfId-1093931]Security Admin. 
          
  
         	 
           
           [bookmark: pgfId-1093933]Security Approver 
          
  
         	 
           
           [bookmark: pgfId-1094569]Network Admin. 
          
  
         	 
           
           [bookmark: pgfId-1093937]Approver 
          
  
         	 
           
           [bookmark: pgfId-1093939]Network Operator 
          
  
         	 
           
           [bookmark: pgfId-1093941]Help Desk 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1093943]View Permissions 
          
  
        
 
         
         	[bookmark: pgfId-1093959]View Device
  
         	[bookmark: pgfId-1093961]Yes
  
         	[bookmark: pgfId-1093963]Yes
  
         	[bookmark: pgfId-1093965]Yes
  
         	[bookmark: pgfId-1094574]Yes
  
         	[bookmark: pgfId-1093969]Yes
  
         	[bookmark: pgfId-1093971]Yes
  
         	[bookmark: pgfId-1093973]Yes
  
        
 
         
         	[bookmark: pgfId-1093975]View Policy
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     [bookmark: pgfId-607977][bookmark: 961][bookmark: defapset_cncpt_IntegratingSecurityManagerwithCiscoSecureACS]Integrating Security Manager with Cisco Secure ACS[bookmark: marker-1066166][bookmark: marker-1066179]
 
    [bookmark: pgfId-607979]This section describes how to integrate your Cisco Secure ACS with Cisco Security Manager.
 
    [bookmark: pgfId-607981]Cisco Secure ACS provides command authorization for users who are using management applications, such as Security Manager, to configure managed network devices. Support for command authorization is provided by unique command authorization set types (called roles in Security Manager) that contain a set of permissions. These permissions (also called privileges) determine the actions that users with particular roles can perform within Security Manager.
 
    [bookmark: pgfId-607983]Cisco Secure ACS uses TACACS+ to communicate with management applications. For Security Manager to communicate with Cisco Secure ACS, you must configure the CiscoWorks server in Cisco Secure ACS as a AAA client that uses TACACS+. In addition, you must provide the CiscoWorks server with (1) the administrator name and password that you use to log in to the Cisco Secure ACS and (2) the shared key configured in ACS on external user addition. Fulfilling these requirements ensures the validity of communications between Security Manager and Cisco Secure ACS.
 
     
      
    
 
    
 
    [bookmark: pgfId-607987]Note For an understanding of TACACS+ security advantages, see User Guide for Cisco Secure Access Control Server.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-607989]When Security Manager initially communicates with Cisco Secure ACS, it dictates to Cisco ACS the creation of default roles, which appear in the Shared Profile Components section of the Cisco Secure ACS HTML interface. It also dictates a custom service to be authorized by TACACS+. This custom service appears on the TACACS+ (Cisco IOS) page in the Interface Configuration section of the HTML interface. You can then modify the permissions included in each Security Manager role and apply these roles to users and user groups.
 
    [bookmark: pgfId-607991]The following topics describe how to use Cisco Secure ACS with Security Manager:
 
     
     	 [bookmark: pgfId-607996]ACS Integration Requirements
 
     	 [bookmark: pgfId-608001]Procedural Overview for Initial Cisco Secure ACS Setup
 
     	 [bookmark: pgfId-608006]Integration Procedures Performed in Cisco Secure ACS
 
     	 [bookmark: pgfId-608011]Integration Procedures Performed in CiscoWorks
 
     	 [bookmark: pgfId-608016]Restarting the Daemon Manager
 
     	 [bookmark: pgfId-608021]Assigning Roles to User Groups in Cisco Secure ACS
 
    
 
     
      [bookmark: pgfId-608029][bookmark: 996][bookmark: defapset_cncpt_ACSIntegrationRequirements]ACS Integration Requirements[bookmark: marker-1066192]
 
     [bookmark: pgfId-608031]To use Cisco Secure ACS, make sure that the following steps are completed:
 
      
      	 [bookmark: pgfId-608033]You defined roles that include the permissions required to perform necessary functions in Security Manager.
 
      	 [bookmark: pgfId-608037]The Network Access Restriction (NAR) includes the device group (or the devices) that you want to administer, if you apply a NAR to the profile.[bookmark: marker-608035]
 
      	 [bookmark: pgfId-608039]Managed device names are spelled and capitalized identically in Cisco Secure ACS and in Security Manager. This restriction applies to the display names, not the hostnames defined on the devices. ACS naming restrictions can be more limiting than those for Security Manager, so you should define the device in ACS first.
 
      	 [bookmark: pgfId-1104349]There are additional device display name requirements that you must meet for PIX/ASA security contexts, FWSMs, and IPS devices. These are described in Adding Devices as AAA Clients Without NDGs. 
 
      	 [bookmark: pgfId-1104355]Network Device Groups must be enabled. 
 
     
 
     [bookmark: pgfId-1069740]Tips
 
      
      	 [bookmark: pgfId-1069817]If you already have devices imported into Security Manager prior to ACS integration, we recommend adding those devices to ACS as AAA clients before the integration. The name of the AAA client must match the display name of the device in Security Manager. If you do not do so, the devices will not show up in the Device list of Security Manager after the ACS integration. 
 
      	 [bookmark: pgfId-1069742]We highly recommend that you create a fault-tolerant infrastructure that utilizes multiple Cisco Secure ACS servers. Having multiple servers helps to ensure your ability to continue work in Security Manager even if connectivity is lost to one of the ACS servers.
 
      	 [bookmark: pgfId-608045]You can integrate only one version of Security Manager with a Cisco Secure ACS. Therefore, if your organization is using two different versions of Security Manager at the same time, you must perform integration with two different Cisco Secure ACS servers. You can, however, upgrade to a new version of Security Manager without having to use a different ACS.
 
      	 [bookmark: pgfId-608047]Even when Cisco Secure ACS authentication is used, CiscoWorks Common Services software uses local authorization for CiscoWorks Common Services-specific utilities, such as Compact Database and Database Checkpoint. To use these utilities, you must be defined locally and be assigned the appropriate permissions.
 
     
 
     [bookmark: pgfId-608049]Related Topics
 
      
      	 [bookmark: pgfId-608054]Procedural Overview for Initial Cisco Secure ACS Setup
 
      	 [bookmark: pgfId-608059]Integrating Security Manager with Cisco Secure ACS
 
     
 
    
 
     
      [bookmark: pgfId-608067][bookmark: 1030][bookmark: defapset_cncpt_ChecklistforInitialCiscoSecureACSSetup]Procedural Overview for Initial Cisco Secure ACS Setup[bookmark: marker-1066201]
 
     [bookmark: pgfId-608069]The following procedure summarizes the overall tasks you need to perform to use Cisco Secure ACS with Security Manager. The procedure contains references to more specific procedures used to perform each step.
 
     [bookmark: pgfId-608071]Related Topics
 
      
      	 [bookmark: pgfId-608076]ACS Integration Requirements
 
      	 [bookmark: pgfId-608081]Integrating Security Manager with Cisco Secure ACS
 
     
 
     
 
     [bookmark: pgfId-608083]Step 1 Plan your administrative authentication and authorization model.
 
     [bookmark: pgfId-608085]You should decide on your administrative model before using Security Manager. This includes defining the administrative roles and accounts that you plan to use.
 
      
       
     
 
     
 
     [bookmark: pgfId-608087]Tip When defining the roles and permissions of potential administrators, you should also consider whether to enable Workflow. This selection affects how you can restrict access.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-608089]For more information, see the following:
 
      
      	 [bookmark: pgfId-608094]Understanding Cisco Secure ACS Roles
 
      	 [bookmark: pgfId-608098] User Guide for Cisco Security Manager 
 
      	 [bookmark: pgfId-608102] User Guide for Cisco Secure Access Control Server 
 
     
 
     [bookmark: pgfId-608104]Step 2 Install Cisco Secure ACS, Cisco Security Manager, and CiscoWorks Common Services.
 
     [bookmark: pgfId-608106]Install Cisco Secure ACS. Install CiscoWorks Common Services and Cisco Security Manager on a different server. Do not run Cisco Secure ACS and Security Manager on the same server.
 
     [bookmark: pgfId-608108]For more information, see the following:
 
      
      	 [bookmark: pgfId-1056015] Release Notes for Cisco Security Manager (for information on the supported versions of Cisco Secure ACS)
 
      	 [bookmark: pgfId-1056033]Installing Security Manager Server, Common Services, and AUS
 
      	 [bookmark: pgfId-608120] Installation Guide for Cisco Secure ACS for Windows Server 
 
     
 
     [bookmark: pgfId-608122]Step 3 Perform integration procedures in Cisco Secure ACS.
 
     [bookmark: pgfId-608124]Define Security Manager users as ACS users and assign them to user groups based on their planned role, add all your managed devices (as well as the CiscoWorks/Security Manager server) as AAA clients, and create an administration control user.
 
     [bookmark: pgfId-608129]For more information, see Integration Procedures Performed in Cisco Secure ACS.
 
     [bookmark: pgfId-608131]Step 4 Perform integration procedures in CiscoWorks Common Services.
 
     [bookmark: pgfId-608133]Configure a local user that matches the system identity user defined in Cisco Secure ACS, define that same user for the system identity setup, configure ACS as the AAA setup mode, and configure an SMTP server and system administrator email address.
 
     [bookmark: pgfId-608138]For more information, see Integration Procedures Performed in CiscoWorks.
 
     [bookmark: pgfId-608140]Step 5 Restart the Daemon Manager.
 
     [bookmark: pgfId-608142]You must restart the Security Manager server Daemon Manager for the AAA settings you configured to take effect.
 
     [bookmark: pgfId-608147]For more information, see Restarting the Daemon Manager.
 
     [bookmark: pgfId-608149]Step 6 Assign roles to user groups in Cisco Secure ACS.
 
     [bookmark: pgfId-608151]Assign roles to each user group configured in Cisco Secure ACS. The procedure you should use depends on whether you have configured network device groups (NDGs).
 
     [bookmark: pgfId-608156]For more information, see Assigning Roles to User Groups in Cisco Secure ACS.
 
     [bookmark: pgfId-608158]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-608166][bookmark: 1109][bookmark: defapset_cncpt_IntegrationProceduresPerformedinCiscoSecureACS]Integration Procedures Performed in Cisco Secure ACS[bookmark: marker-1066210]
 
     [bookmark: pgfId-608170]The following topics describe the procedures to perform in Cisco Secure ACS when integrating it with Cisco Security Manager. Perform the tasks in the listed order. For more information about the procedures described in these sections, see User Guide for Cisco Secure Access Control Server.
 
     [bookmark: pgfId-608175] 1. Defining Users and User Groups in Cisco Secure ACS
 
     [bookmark: pgfId-608180] 2. Adding Managed Devices as AAA Clients in Cisco Secure ACS
 
     [bookmark: pgfId-608185] 3. Creating an Administration Control User in Cisco Secure ACS
 
    
 
     
      [bookmark: pgfId-608197][bookmark: 1127][bookmark: defapset_proc_DefiningUsersandUserGroupsinCiscoSecureACS]Defining Users and User Groups in Cisco Secure ACS[bookmark: marker-1066231][bookmark: marker-1066252][bookmark: marker-1066273]
 
     [bookmark: pgfId-608202]All users of Security Manager must be defined in Cisco Secure ACS and assigned a role appropriate to their job function. The easiest way to do this is to divide the users into different groups based on each default role available in ACS, for example, assigning all the system administrators to one group, all the network operators to another group, and so on. For more information about the default roles in ACS, see Cisco Secure ACS Default Roles.
 
     [bookmark: pgfId-608207]You must create an additional user that is assigned the system administrator role with full permissions to devices. The credentials established for this user are later used on the System Identity Setup page in CiscoWorks. See Defining the System Identity User.
 
     [bookmark: pgfId-608209]Please note that at this stage you are merely assigning users to different groups. The actual assignment of roles to these groups is performed later, after CiscoWorks, Security Manager, and any other applications have been registered to Cisco Secure ACS.
 
      
       
     
 
     
 
     [bookmark: pgfId-608211]Tip This procedure explains how to create user accounts during the initial Cisco Secure ACS integration. After you complete the integration, when you create a user account, you can assign it to the appropriate group as you create the account.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-608213]Related Topics
 
      
      	 [bookmark: pgfId-608218]ACS Integration Requirements
 
      	 [bookmark: pgfId-608223]Procedural Overview for Initial Cisco Secure ACS Setup
 
      	 [bookmark: pgfId-608228]Assigning Roles to User Groups in Cisco Secure ACS
 
     
 
     
 
     [bookmark: pgfId-608230]Step 1 Log in to Cisco Secure ACS.
 
     [bookmark: pgfId-1059321]Step 2 Configure a user with full permissions using the following procedure. For more information about the options available when configuring users and user groups, see User Guide for Cisco Secure Access Control Server.
 
     [bookmark: pgfId-608236] a. Click User Setup on the navigation bar.
 
     [bookmark: pgfId-608238] b. On the User Setup page, enter a name for the new user and click Add/Edit.
 
      
       
     
 
     
 
     [bookmark: pgfId-608240]Tip Do not create a user named admin. The admin user is the fall-back user in Security Manager. If the ACS system stops working for some reason, you can still log in to CiscoWorks Common Services on the Security Manager server using the admin account to change the AAA mode to CiscoWorks local authentication and continue using the product.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-608242] c. Select an authentication method from the Password Authentication list under User Setup.
 
     [bookmark: pgfId-608244] d. Enter and confirm the password for the new user.
 
     [bookmark: pgfId-608246] e. Select Group 1 as the group to which the user should be assigned.
 
     [bookmark: pgfId-608248] f. Click Submit to create the user account.
 
     [bookmark: pgfId-608250]Step 3 Repeat this process for each Security Manager user. We recommend dividing the users into groups based on the role each user will be assigned:
 
      
      	 [bookmark: pgfId-608252]Group 1—System Administrators
 
      	 [bookmark: pgfId-608254]Group 2—Security Administrators
 
      	 [bookmark: pgfId-608256]Group 3—Security Approvers
 
      	 [bookmark: pgfId-608258]Group 4—Network Administrators
 
      	 [bookmark: pgfId-608260]Group 5—Approvers
 
      	 [bookmark: pgfId-608262]Group 6—Network Operators
 
      	 [bookmark: pgfId-608264]Group 7—Help Desk
 
     
 
     [bookmark: pgfId-608272]For more information about the default permissions associated with each role, see Default Associations Between Permissions and Roles in Security Manager. For more information about customizing user roles, see Customizing Cisco Secure ACS Roles.
 
      
       
     
 
     
 
     [bookmark: pgfId-608277]Note At this stage, the groups themselves are collections of users without any role definitions. You assign roles to each group after you complete the integration process. See Assigning Roles to User Groups in Cisco Secure ACS.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-608284]Step 4 [bookmark: 1203]Create an additional user that you will use as the system identity user in CiscoWorks Common Services. Assign this user to the system administrators group and grant all privileges to devices. The credentials established for this user are later used on the System Identity Setup page in CiscoWorks. See Defining the System Identity User.
 
     [bookmark: pgfId-608289]Step 5 Continue with Adding Managed Devices as AAA Clients in Cisco Secure ACS.
 
     [bookmark: pgfId-608291]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-608299][bookmark: 1212][bookmark: defapset_cncpt_AddingManagedDevicesasAAAClientsinCiscoSecureACS]Adding Managed Devices as AAA Clients in Cisco Secure ACS[bookmark: marker-1066294][bookmark: marker-1066307] 
 
     [bookmark: pgfId-608301]Before you can begin importing devices into Security Manager, you must first configure each device as a AAA client in your Cisco Secure ACS. In addition, you must configure the CiscoWorks/Security Manager server as a AAA client.
 
     [bookmark: pgfId-608303]If Security Manager is managing security contexts configured on firewall devices, including security contexts configured on FWSMs for Catalyst 6500/7600 devices, each context must be added individually to Cisco Secure ACS. Likewise, all virtual sensors defined on IPS devices must also be added.
 
     [bookmark: pgfId-608305]The method for adding managed devices depends on whether you want to restrict users to managing a particular set of devices by creating network device groups (NDGs). Proceed as follows:
 
      
      	 [bookmark: pgfId-608315]If you want users to have access only to certain NDGs, add the devices as described in Configuring Network Device Groups for Use in Security Manager. 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1104483]Note While devices do not need to be broken out into Network Device Groups, Security Manager expects the Security Manager Network Device to be in an NDG. "Not Assigned" is not an NDG. It is best to move all devices out of Not Assigned and into a Default NDG if multiple NDGs are not desired. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-608323][bookmark: 1227][bookmark: defapset_proc_AddingDevicesasAAAClientsWithoutNDGs]Adding Devices as AAA Clients Without NDGs[bookmark: marker-1066320] 
 
     [bookmark: pgfId-608327]This procedure describes how to add devices as AAA clients of a Cisco Secure ACS. For complete information about all available options, see User Guide for Cisco Secure Access Control Server.
 
      
       
     
 
     
 
     [bookmark: pgfId-608329]Tip Remember to add the CiscoWorks/Security Manager server as a AAA client.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-608331]Related Topics
 
      
      	 [bookmark: pgfId-608336]ACS Integration Requirements
 
      	 [bookmark: pgfId-608341]Procedural Overview for Initial Cisco Secure ACS Setup
 
     
 
     
 
     [bookmark: pgfId-608343]Step 1 Click Network Configuration on the Cisco Secure ACS navigation bar.
 
     [bookmark: pgfId-608345]Step 2 Click Add Entry beneath the AAA Clients table.
 
     [bookmark: pgfId-608347]Step 3 Enter the AAA client hostname (up to 32 characters) on the Add AAA Client page. The hostname of the AAA client must match the display name you plan to use for the device in Security Manager.
 
     [bookmark: pgfId-608349]For example, if you intend to append a domain name to the device name in Security Manager, the AAA client hostname in ACS must be <device_name>.<domain_name>.
 
     [bookmark: pgfId-608351]When naming the CiscoWorks server, we recommend using the fully qualified hostname. Be sure to spell the hostname correctly. (The hostname is not case sensitive.)
 
     [bookmark: pgfId-608353]Additional naming conventions include:
 
      
      	 [bookmark: pgfId-608355]PIX or ASA security context, or FWSM security context when discovered through the FWSM:  <parent_display_name>_<context_name> 
 
      	 [bookmark: pgfId-608357]FWSM blade:  <chassis_name>_FW_<slot_number> 
 
      	 [bookmark: pgfId-608359]FWSM security context when discovered through the chassis:  <chassis_name>_FW_<slot_number>_<context_name> 
 
      	 [bookmark: pgfId-608361]IPS sensor:  <IPSParentName>_<virtualSensorName> 
 
     
 
     [bookmark: pgfId-608363]Step 4 Enter the IP address of the network device in the AAA Client IP Address field. If the device does not have an IP address (for example, a virtual sensor or a virtual context), enter the word dynamic instead of an address.
 
      
       
     
 
     
 
     [bookmark: pgfId-608367]Note If you are adding a multi-homed device (a device with multiple NICs), enter the IP address of each NIC. Press Enter between each address. In addition, you must modify the gatekeeper.cfg file on the Security Manager server.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-608369]Step 5 Enter the shared secret in the Key field.
 
     [bookmark: pgfId-608371]Step 6 Select TACACS+ (Cisco IOS) from the Authenticate Using list.
 
     [bookmark: pgfId-608373]Step 7 Click Submit to save your changes. The device you added is displayed in the AAA Clients table.
 
     [bookmark: pgfId-608375]Step 8 Repeat the process to add additional devices.
 
     [bookmark: pgfId-608377]Step 9 To save the devices you have added, click Submit + Restart.
 
     [bookmark: pgfId-608382]Step 10 Continue with Creating an Administration Control User in Cisco Secure ACS.
 
     [bookmark: pgfId-608384]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-608394][bookmark: 1298][bookmark: defapset_cncpt_ConfiguringNetworkDeviceGroupsforUseinSecurityManager]Configuring Network Device Groups for Use in Security Manager[bookmark: marker-1066329][bookmark: marker-1066334] 
 
     [bookmark: pgfId-608396]Cisco Secure ACS enables you to configure network device groups (NDGs) that contain specific devices to be managed. For example, you can create NDGs for each geographic region or NDGs that match your organizational structure. When used with Security Manager, NDGs enable you to provide users with different levels of permissions, depending on the devices they need to manage. For example, by using NDGs you can assign User A system administrator permissions to the devices located in Europe and Help Desk permissions to the devices located in Asia. You can then assign the opposite permissions to User B.
 
     [bookmark: pgfId-608398]NDGs are not assigned directly to users. Rather, NDGs are assigned to the roles that you define for each user group. Each NDG can be assigned to a single role only, but each role can include multiple NDGs. These definitions are saved as part of the configuration for the selected user group.
 
     [bookmark: pgfId-608400]Tips
 
      
      	 [bookmark: pgfId-608402]Each device can be a member of only one NDG.
 
      	 [bookmark: pgfId-1059537]NDGs are  not related to the device groups that you can configure in Security Manager.
 
      	 [bookmark: pgfId-1059539]For complete details about managing NDGs, see  User Guide for Cisco Secure Access Control Server. 
 
     
 
     [bookmark: pgfId-1059540]The following topics outline the basic information and steps for configuring NDGs:
 
      
      	 [bookmark: pgfId-608415]NDGs and User Permissions
 
      	 [bookmark: pgfId-608420]Activating the NDG Feature
 
      	 [bookmark: pgfId-608425]Creating NDGs
 
      	 [bookmark: pgfId-608430]Associating NDGs and Roles with User Groups
 
     
 
    
 
     
      [bookmark: pgfId-608440][bookmark: 1335][bookmark: defapset_cncpt_NDGsandUserPermissions]NDGs and User Permissions[bookmark: marker-1066339][bookmark: marker-1066344]
 
     [bookmark: pgfId-608442]Because NDGs limit users to particular sets of devices, they affect policy permissions, as follows:
 
      
      	 [bookmark: pgfId-608444]To view a policy, you must have permissions for at least  one device to which the policy is assigned.
 
      	 [bookmark: pgfId-608446]To modify a policy, you must have permissions for  all the devices to which the policy is assigned.
 
      	 [bookmark: pgfId-608448]To view, modify, or assign a VPN policy, you must have permissions for  all the devices in the VPN topology.
 
      	 [bookmark: pgfId-608450]To assign a policy to a device, you need permissions only for that device, regardless of whether you have permissions for any other devices to which the policy is assigned. (VPN policies are an exception, as noted above.) However, if a user assigns a policy to a device for which you do not have permissions, you cannot modify that policy.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-608452]Note To modify an object, a user does not need modify permissions for all the devices that are using the object. However, a user must have modify permissions for a particular device in order to modify a device-level object override defined on that device.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-608454]Related Topics
 
      
      	 [bookmark: pgfId-608459]Configuring Network Device Groups for Use in Security Manager
 
      	 [bookmark: pgfId-608464]User Permissions
 
     
 
    
 
     
      [bookmark: pgfId-608474][bookmark: 1368][bookmark: defapset_proc_ActivatingtheNDGFeature]Activating the NDG Feature[bookmark: marker-1066349][bookmark: marker-1066358]
 
     [bookmark: pgfId-608476]You must activate the NDG feature before you can create NDGs and populate them with devices.
 
     [bookmark: pgfId-608478]Related Topics
 
      
      	 [bookmark: pgfId-608483]Creating NDGs
 
      	 [bookmark: pgfId-608488]Associating NDGs and Roles with User Groups
 
      	 [bookmark: pgfId-608493]NDGs and User Permissions
 
      	 [bookmark: pgfId-608498]Configuring Network Device Groups for Use in Security Manager
 
     
 
     
 
     [bookmark: pgfId-608500]Step 1 Click Interface Configuration on the Cisco Secure ACS navigation bar.
 
     [bookmark: pgfId-608502]Step 2 Click Advanced Options.
 
     [bookmark: pgfId-608504]Step 3 Scroll down, then check the Network Device Groups check box.
 
     [bookmark: pgfId-608506]Step 4 Click Submit.
 
     [bookmark: pgfId-608511]Step 5 Continue with Creating NDGs.
 
     [bookmark: pgfId-608513]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-608523][bookmark: 1411][bookmark: defapset_proc_CreatingNDGs]Creating NDGs[bookmark: marker-1066367][bookmark: marker-1066376]
 
     [bookmark: pgfId-608525]This procedure describes how to create NDGs and populate them with devices. Each device can belong to only one NDG.
 
      
       
     
 
     
 
     [bookmark: pgfId-608527]Tip We highly recommend creating a special NDG that contains the CiscoWorks/Security Manager servers.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-608529]Before You Begin
 
     [bookmark: pgfId-608534]Activate the NDG feature as described in Activating the NDG Feature.
 
     [bookmark: pgfId-608536]Related Topics
 
      
      	 [bookmark: pgfId-608541]Associating NDGs and Roles with User Groups
 
      	 [bookmark: pgfId-608546]NDGs and User Permissions
 
      	 [bookmark: pgfId-608551]Configuring Network Device Groups for Use in Security Manager
 
     
 
     
 
     [bookmark: pgfId-608553]Step 1 Click Network Configuration on the navigation bar.
 
     [bookmark: pgfId-608555]All devices are initially placed under Not Assigned, which holds all devices that were not placed in an NDG. Please note that Not Assigned is not an NDG.
 
     [bookmark: pgfId-608557]Step 2 Create NDGs:
 
     [bookmark: pgfId-608559] a. Click Add Entry.
 
     [bookmark: pgfId-608561] b. Enter a name for the NDG on the New Network Device Group page. The maximum length is 24 characters. Spaces are permitted.
 
     [bookmark: pgfId-608563] c. (Optional) Enter a key to be used by all devices in the NDG. If you define a key for the NDG, it overrides any keys defined for the individual devices in the NDG.
 
     [bookmark: pgfId-608565] d. Click Submit to save the NDG.
 
     [bookmark: pgfId-608567] e. Repeat the process to create more NDGs.
 
     [bookmark: pgfId-608569]Step 3 Populate the NDGs with devices. Keep in mind that each device can be a member of only one NDG.
 
     [bookmark: pgfId-608571] a. Click the name of the NDG in the Network Device Groups area.
 
     [bookmark: pgfId-608573] b. Click Add Entry in the AAA Clients area.
 
     [bookmark: pgfId-608578] c. Define the particulars of the device to add to the NDG, then click Submit. For more information, see Adding Devices as AAA Clients Without NDGs.
 
     [bookmark: pgfId-608580] d. Repeat the process to add the remaining devices to NDGs. The only device you should consider leaving in the Not Assigned category is the default AAA server.
 
     [bookmark: pgfId-608582] e. After you configure the last device, click Submit + Restart.
 
     [bookmark: pgfId-608587]Step 4 Continue with Creating an Administration Control User in Cisco Secure ACS.
 
      
       
     
 
     
 
     [bookmark: pgfId-608592]Tip You can associate roles with each NDG only after completing the integration procedures in Cisco Secure ACS and CiscoWorks Common Services. See Associating NDGs and Roles with User Groups.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-608594]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-608604][bookmark: 1484][bookmark: defapset_proc_CreatinganAdministrationControlUserinCiscoSecureACS]Creating an Administration Control User in Cisco Secure ACS[bookmark: marker-1066385][bookmark: marker-1066390]
 
     [bookmark: pgfId-608609]Use the Administration Control page in Cisco Secure ACS to define the administrator account that is used when defining the AAA setup mode in CiscoWorks Common Services. Security Manager uses this account to access the ACS server and register the application, to query device group membership and group setup, and to perform other basic interactions with ACS. For more information, see Configuring the AAA Setup Mode in CiscoWorks.
 
     [bookmark: pgfId-608611]Related Topics
 
      
      	 [bookmark: pgfId-608616]ACS Integration Requirements
 
      	 [bookmark: pgfId-608621]Procedural Overview for Initial Cisco Secure ACS Setup
 
     
 
     
 
     [bookmark: pgfId-608623]Step 1 Click Administration Control on the Cisco Secure ACS navigation bar.
 
     [bookmark: pgfId-608625]Step 2 Click Add Administrator.
 
     [bookmark: pgfId-608627]Step 3 On the Add Administrator page, enter a name and password for the administrator.
 
     [bookmark: pgfId-608629]Step 4 Select the following administrator privileges:
 
      
      	 [bookmark: pgfId-608631]Under Users and Group Setup
 
     
 
     [bookmark: pgfId-608633] – Read access to users in group
 
     [bookmark: pgfId-608635] – Read access of these groups
 
      
      	 [bookmark: pgfId-608637]Under Shared Profile Components
 
     
 
     [bookmark: pgfId-608639] – Create Device Command Set Type
 
      
      	 [bookmark: pgfId-608641]Network Configuration
 
     
 
     [bookmark: pgfId-1059363]Step 5 Click Submit to create the administrator. For more information about the options available when configuring an administrator, see User Guide for Cisco Secure Access Control Server.
 
     [bookmark: pgfId-1059364]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-608659][bookmark: 1539][bookmark: defapset_cncpt_IntegrationProceduresPerformedinCiscoWorks]Integration Procedures Performed in CiscoWorks[bookmark: marker-1066399][bookmark: marker-1066404][bookmark: marker-1066409] 
 
     [bookmark: pgfId-608664]After you complete the integration tasks in Cisco Secure ACS (described in Integration Procedures Performed in Cisco Secure ACS), you must complete some tasks in CiscoWorks Common Services. Common Services performs the actual registration of any installed applications, such as Cisco Security Manager and Auto Update Server, into Cisco Secure ACS.
 
     [bookmark: pgfId-608666]The following topics describe the procedures to perform in CiscoWorks Common Services when integrating it with Cisco Security Manager:
 
      
      	 [bookmark: pgfId-608671]Creating a Local User in CiscoWorks
 
      	 [bookmark: pgfId-608676]Defining the System Identity User
 
      	 [bookmark: pgfId-608681]Configuring the AAA Setup Mode in CiscoWorks
 
      	 [bookmark: pgfId-1054542]Configuring an SMTP Server and System Administrator Email Address for ACS Status Notifications
 
     
 
    
 
     
      [bookmark: pgfId-608691][bookmark: 1560][bookmark: defapset_proc_CreatingaLocalUserinCiscoWorks]Creating a Local User in CiscoWorks[bookmark: marker-1066414][bookmark: marker-1066419]
 
     [bookmark: pgfId-608699]Use the Local User Setup page in CiscoWorks Common Services to create a local user account that duplicates the system identity user you previously created in Cisco Secure ACS (as described in Defining Users and User Groups in Cisco Secure ACS). This local user account is later used for the system identity setup. For more information, see Defining the System Identity User.
 
     [bookmark: pgfId-608701]Related Topics
 
      
      	 [bookmark: pgfId-608706]ACS Integration Requirements
 
      	 [bookmark: pgfId-608711]Procedural Overview for Initial Cisco Secure ACS Setup
 
     
 
     
 
     [bookmark: pgfId-608713]Step 1 Navigate to the Local User Setup page in Common Services by following this path: 
 
     [bookmark: pgfId-1085568]Server where Security Manager is installed > 
 
     [bookmark: pgfId-1085569]desktop icon for Cisco Security Manager application > 
 
     [bookmark: pgfId-1085570]admin account login > 
 
     [bookmark: pgfId-1085571]Server Administration > 
 
     [bookmark: pgfId-1085572]Server > [menu selector symbol] >
 
     [bookmark: pgfId-1085573]Security > 
 
     [bookmark: pgfId-1085574]Single-Server Management > 
 
     [bookmark: pgfId-608715]Local User Setup
 
     [bookmark: pgfId-608719]Step 2 Click Add.
 
     [bookmark: pgfId-608724]Step 3 Enter the same name and password that you entered when creating the system identity user in Cisco Secure ACS. See Defining Users and User Groups in Cisco Secure ACS.
 
     [bookmark: pgfId-608726]Step 4 Check all check boxes under Roles.
 
     [bookmark: pgfId-608728]Step 5 Click OK to create the user.
 
     [bookmark: pgfId-608730]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-608740][bookmark: 1605][bookmark: defapset_proc_DefiningtheSystemIdentityUser]Defining the System Identity User[bookmark: marker-1066424][bookmark: marker-1066429] 
 
     [bookmark: pgfId-608742]Use the System Identity Setup page in CiscoWorks Common Services to create a trust user (called the System Identity user) that enables communication between servers that are part of the same domain and application processes that are located on the same server. Applications use the System Identity user to authenticate processes on local or remote CiscoWorks servers. This is especially useful when the applications must synchronize before any users have logged in.
 
     [bookmark: pgfId-608744]In addition, the System Identity user is often used to perform a subtask when the primary task has already been authorized for the logged in user.
 
     [bookmark: pgfId-608746]The System Identity user you configure here must also be defined as a local user in CiscoWorks (assigned to all roles) and as a user with all privileges to devices in ACS. If you do not select a user with the required privileges, you might not be able to view all the devices and policies configured in Security Manager. Make sure that you performed the following procedures before continuing:
 
      
      	 [bookmark: pgfId-608751]Defining Users and User Groups in Cisco Secure ACS
 
      	 [bookmark: pgfId-608756]Creating a Local User in CiscoWorks
 
     
 
     [bookmark: pgfId-608758]Related Topics
 
      
      	 [bookmark: pgfId-608763]ACS Integration Requirements
 
      	 [bookmark: pgfId-1085229]Procedural Overview for Initial Cisco Secure ACS Setup
 
     
 
     
 
     [bookmark: pgfId-1085363]Step 1 Navigate to the System Identify Setup page in Common Services by following this path: 
 
     [bookmark: pgfId-1085617]Server where Security Manager is installed > 
 
     [bookmark: pgfId-1085618]desktop icon for Cisco Security Manager application > 
 
     [bookmark: pgfId-1085619]admin account login > 
 
     [bookmark: pgfId-1085620]Server Administration > 
 
     [bookmark: pgfId-1085621]Server > [menu selector symbol] >
 
     [bookmark: pgfId-1085622]Security > 
 
     [bookmark: pgfId-1085623]Multi-Server Trust Management > 
 
     [bookmark: pgfId-1085624]System Identity Setup
 
     [bookmark: pgfId-1085202]Step 2 Enter the name of the system identity user that you created in Cisco Secure ACS. See Defining Users and User Groups in Cisco Secure ACS.
 
     [bookmark: pgfId-608779]Step 3 Enter and verify the password for this user.
 
     [bookmark: pgfId-608781]Step 4 Click Apply.
 
     [bookmark: pgfId-608783]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-608795][bookmark: 1650][bookmark: defapset_proc_ConfiguringtheAAASetupModeinCiscoWorks]Configuring the AAA Setup Mode in CiscoWorks[bookmark: marker-1066434][bookmark: marker-1066439][bookmark: marker-1066444] 
 
     [bookmark: pgfId-608797]Use the AAA Setup Mode page in CiscoWorks Common Services to define your Cisco Secure ACS as the AAA server, including the required port and shared secret key. In addition, you can define up to two backup servers.
 
     [bookmark: pgfId-608799]This procedure performs the actual registration of CiscoWorks and Security Manager (and optionally, Auto Update Server) into Cisco Secure ACS.
 
      
       
     
 
     
 
     [bookmark: pgfId-608801]Tip The AAA setup configured here is not retained if you uninstall CiscoWorks Common Services or Cisco Security Manager. In addition, this configuration cannot be backed up and restored after re-installation. Therefore, if you upgrade to a new version of either application, you must reconfigure the AAA setup mode and re-register Security Manager with ACS. This process is not required for incremental updates. If you install additional applications, such as AUS, on top of CiscoWorks, you must re-register the new applications and Cisco Security Manager. In addition to re registering Security Manager with ACS, you must configure your existing system identity user and grant it the newly introduced permissions; otherwise, RBAC will not work properly. Please refer to Defining the System Identity User. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-608803]Related Topics
 
      
      	 [bookmark: pgfId-608808]ACS Integration Requirements
 
      	 [bookmark: pgfId-608813]Procedural Overview for Initial Cisco Secure ACS Setup
 
     
 
     
 
     [bookmark: pgfId-1085801]Step 1 Navigate to the AAA Mode Setup page in Common Services by following this path: 
 
     [bookmark: pgfId-1085802]Server where Security Manager is installed > 
 
     [bookmark: pgfId-1085803]desktop icon for Cisco Security Manager application > 
 
     [bookmark: pgfId-1085804]admin account login > 
 
     [bookmark: pgfId-1085805]Server Administration > 
 
     [bookmark: pgfId-1085806]Server > [menu selector symbol] >
 
     [bookmark: pgfId-1085807]Security > 
 
     [bookmark: pgfId-1085808]AAA Mode Setup 
 
     [bookmark: pgfId-608819]Step 2 Select TACACS+ under Available Login Modules.
 
     [bookmark: pgfId-608821]Step 3 Select ACS as the AAA type.
 
     [bookmark: pgfId-608823]Step 4 Enter the IP addresses of up to three Cisco Secure ACS servers in the Server Details area. The secondary and tertiary servers act as backups in case the primary server fails. All servers must be running the same version of Cisco Secure ACS.
 
      
       
     
 
     
 
     [bookmark: pgfId-608825]Note If all the configured TACACS+ servers fail to respond, you must log in using the admin CiscoWorks Local account, then change the AAA mode back to Non-ACS/CiscoWorks Local. After the TACACS+ servers are restored to service, you must change the AAA mode back to ACS.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-608830]Step 5 In the Login area, enter the name of the administrator that you defined on the Administration Control page of Cisco Secure ACS. For more information, see Creating an Administration Control User in Cisco Secure ACS.
 
     [bookmark: pgfId-608832]Step 6 Enter and verify the password for this administrator.
 
     [bookmark: pgfId-608837]Step 7 Enter and verify the shared secret key that you entered when you added the Security Manager server as a AAA client of Cisco Secure ACS. See Adding Devices as AAA Clients Without NDGs.
 
     [bookmark: pgfId-608843]Step 8 Check the Register all installed applications with ACS check box to register Security Manager and any other installed applications with Cisco Secure ACS.[bookmark: marker-608839][bookmark: marker-608841]
 
     [bookmark: pgfId-608845]Step 9 Click Apply to save your settings. A progress bar displays the progress of the registration. A message is displayed when registration is complete.
 
     [bookmark: pgfId-608850]Step 10 Restart the Cisco Security Manager Daemon Manager service. See Restarting the Daemon Manager.
 
     [bookmark: pgfId-608855]Step 11 Log back in to Cisco Secure ACS to assign roles to each user group. See Assigning Roles to User Groups in Cisco Secure ACS.
 
     [bookmark: pgfId-608857]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1054305][bookmark: 35120]Configuring an SMTP Server and System Administrator Email Address for ACS Status Notifications[bookmark: marker-1066451]
 
     [bookmark: pgfId-1054367]If all the ACS servers become unavailable, users cannot perform tasks in Security Manager. Users who are logged in can be abruptly logged out of the system (without an opportunity to save changes) if they try to perform a task that requires ACS authorization.
 
     [bookmark: pgfId-1054414]If you configure Common Services settings to identify an SMTP server and a system administrator, Security Manager sends an email message to the administrator if all ACS servers become unavailable. This can alert you to a problem that needs immediate attention. The administrator might also receive email messages from Common Services for non-ACS-related events.
 
      
       
     
 
     
 
     [bookmark: pgfId-1054379]Tip Security Manager can send email notifications for several other types of events such as deployment job completion, activity approval, or ACL rule expiration. The SMTP server you configure here is also used for these notifications, although the sender email address is set in Security Manager. For more information about configuring these other email addresses, see the User Guide for Cisco Security Manager for this version of the product, or the client online help.
 
      
      
 
     
 
     
 
     
 
     [bookmark: pgfId-1085886]Step 1 Navigate to the System Preferences page in Common Services by following this path: 
 
     [bookmark: pgfId-1085887]Server where Security Manager is installed > 
 
     [bookmark: pgfId-1085888]desktop icon for Cisco Security Manager application > 
 
     [bookmark: pgfId-1085889]admin account login > 
 
     [bookmark: pgfId-1085890]Server Administration > 
 
     [bookmark: pgfId-1085891]Server > [menu selector symbol] >
 
     [bookmark: pgfId-1085892]Admin > 
 
     [bookmark: pgfId-1085920]System Preferences 
 
     [bookmark: pgfId-1054497]Step 2 On the System Preferences page, enter the hostname or IP address of an SMTP server that Security Manager can use. The SMTP server cannot require user authentication for sending email messages.
 
     [bookmark: pgfId-1054498]Step 3 Enter an email address that CiscoWorks can use for sending emails. This does not have to be the same email address that you configure for Security Manager to use when sending notifications.
 
     [bookmark: pgfId-1054513]If the ACS server becomes unavailable, a message is sent to (and from) this account.
 
     [bookmark: pgfId-1054499]Step 4 Click Apply to save your changes.
 
     [bookmark: pgfId-1054495]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-608869][bookmark: 1721][bookmark: defapset_proc_RestartingtheDaemonManager]Restarting the Daemon Manager[bookmark: marker-1066456][bookmark: marker-1066461][bookmark: marker-1066466]
 
     [bookmark: pgfId-608871]This procedure describes how to restart the Daemon Manager of the Security Manager server. You must do this so the AAA settings that you configured take effect. You can then log back in to CiscoWorks using the credentials defined in Cisco Secure ACS.
 
     [bookmark: pgfId-608873]Related Topics
 
      
      	 [bookmark: pgfId-608878]Procedural Overview for Initial Cisco Secure ACS Setup
 
      	 [bookmark: pgfId-608883]ACS Integration Requirements
 
     
 
     
 
     [bookmark: pgfId-608885]Step 1 Log in to the machine on which the Security Manager server is installed.
 
     [bookmark: pgfId-608887]Step 2 Select Start > Programs > Administrative Tools > Services to open the Services window.
 
     [bookmark: pgfId-608889]Step 3 From the list of services displayed in the right pane, select Cisco Security Manager Daemon Manager.
 
     [bookmark: pgfId-608891]Step 4 Click the Restart Service button on the toolbar.
 
     [bookmark: pgfId-608896]Step 5 Continue with Assigning Roles to User Groups in Cisco Secure ACS.
 
     [bookmark: pgfId-608898]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-608906][bookmark: 1760][bookmark: defapset_cncpt_AssigningRolestoUserGroupsinCiscoSecureACS]Assigning Roles to User Groups in Cisco Secure ACS[bookmark: marker-1066471] 
 
     [bookmark: pgfId-608908]After you have registered CiscoWorks, Security Manager and other installed applications to Cisco Secure ACS, you can assign roles to each of the user groups that you previously configured in Cisco Secure ACS. These roles determine the actions that the users in each group are permitted to perform in Security Manager.
 
     [bookmark: pgfId-608910]The procedure for assigning roles to user groups depends on whether NDGs are being used:
 
      
      	 [bookmark: pgfId-608915]Assigning Roles to User Groups Without NDGs
 
      	 [bookmark: pgfId-608920]Associating NDGs and Roles with User Groups
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1104208]Note Security Manager and ACS integration works better by creating a special NDG that contains the CiscoWorks/Security Manager servers. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-608928][bookmark: 1774][bookmark: defapset_proc_AssigningRolestoUserGroupsWithoutNDGs]Assigning Roles to User Groups Without NDGs[bookmark: marker-1066476] 
 
     [bookmark: pgfId-608933]This procedure describes how to assign the default roles to user groups when NDGs have not been defined. For more information, see Cisco Secure ACS Default Roles.
 
     [bookmark: pgfId-608935]Before You Begin
 
      
      	 [bookmark: pgfId-608940]Create a user group for each default role. See Defining Users and User Groups in Cisco Secure ACS.
 
      	 [bookmark: pgfId-608942]Complete the procedures described in these topics:
 
     
 
     [bookmark: pgfId-608947] – Integration Procedures Performed in Cisco Secure ACS
 
     [bookmark: pgfId-608952] – Integration Procedures Performed in CiscoWorks
 
     [bookmark: pgfId-608954]Related Topics
 
      
      	 [bookmark: pgfId-608959]Understanding CiscoWorks Roles
 
      	 [bookmark: pgfId-608964]Understanding Cisco Secure ACS Roles
 
     
 
     
 
     [bookmark: pgfId-608966]Step 1 Log in to Cisco Secure ACS.
 
     [bookmark: pgfId-608968]Step 2 Click Group Setup on the navigation bar.
 
     [bookmark: pgfId-608973]Step 3 Select the user group for system administrators from the list (see Defining Users and User Groups in Cisco Secure ACS), then click Edit Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-608975]Tip You can rename the groups with a more meaningful name to make it easier to identify the correct groups. Select a group and click Rename Group to change the name.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-608977]Step 4 Assign the system administrator role to this group:
 
     [bookmark: pgfId-608979] a. Scroll down to the CiscoWorks area under TACACS+ Settings.
 
     [bookmark: pgfId-608981] b. Select the first Assign option, then select System Administrator from the list of CiscoWorks roles.
 
     [bookmark: pgfId-608983] c. Scroll down to the Cisco Security Manager Shared Services area.
 
     [bookmark: pgfId-608985] d. Select the first Assign option, then select System Administrator from the list of Cisco Secure ACS roles.
 
     [bookmark: pgfId-608987] e. Click Submit to save the group settings.
 
     [bookmark: pgfId-608989]Step 5 Repeat the process for the remaining roles, assigning each role to the appropriate user group.
 
     [bookmark: pgfId-608991]When selecting the Security Approver or Security Administrator roles in Cisco Secure ACS, we recommend selecting Network Administrator as the closest equivalent CiscoWorks role.
 
     [bookmark: pgfId-608996]For more information about customizing the default roles in ACS, see Customizing Cisco Secure ACS Roles.
 
     [bookmark: pgfId-608998]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-609010][bookmark: 1843][bookmark: defapset_proc_AssociatingNDGsandRoleswithUserGroups]Associating NDGs and Roles with User Groups[bookmark: marker-1066481][bookmark: marker-1066506][bookmark: marker-1066531] 
 
     [bookmark: pgfId-609012]When you associate NDGs with roles for use in Security Manager, you must create definitions in two places on the Group Setup page:
 
      
      	 [bookmark: pgfId-609014]CiscoWorks area
 
      	 [bookmark: pgfId-609016]Cisco Security Manager area
 
     
 
     [bookmark: pgfId-609018]The definitions in each area should match as closely as possible. When associating custom roles or ACS roles that do not exist in CiscoWorks Common Services, try to define as close an equivalent as possible based on the permissions assigned to that role.
 
     [bookmark: pgfId-609020]You must create associations for each user group that will be used with Security Manager. For example, if you have a user group containing support personnel for the Western region, you can select that user group, then associate the NDG containing the devices in that region with the Help Desk role.
 
     [bookmark: pgfId-609022]Before You Begin
 
     [bookmark: pgfId-609027]Activate the NDG feature and create NDGs. See Configuring Network Device Groups for Use in Security Manager.
 
     [bookmark: pgfId-609029]Related Topics
 
      
      	 [bookmark: pgfId-609034]ACS Integration Requirements
 
      	 [bookmark: pgfId-609039]Procedural Overview for Initial Cisco Secure ACS Setup
 
     
 
     
 
     [bookmark: pgfId-609041]Step 1 Click Group Setup on the navigation bar.
 
     [bookmark: pgfId-609043]Step 2 Select a user group from the Group list, then click Edit Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-609045]Tip You can rename the groups with a more meaningful name to make it easier to identify the correct groups. Select a group and click Rename Group to change the name.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-609047]Step 3 Map NDGs and roles for use in CiscoWorks:
 
     [bookmark: pgfId-609051] a. On the Group Setup page, scroll down to the CiscoWorks area under TACACS+ Settings.
 
     [bookmark: pgfId-609053] b. Select Assign a Ciscoworks on a per Network Device Group Basis.
 
     [bookmark: pgfId-609055] c. Select an NDG from the Device Group list.
 
     [bookmark: pgfId-609057] d. Select the role to which this NDG should be associated from the second list.
 
     [bookmark: pgfId-609059] e. Click Add Association. The association appears in the Device Group box.
 
     [bookmark: pgfId-609061] f. Repeat the process to create additional associations.
 
     [bookmark: pgfId-609063] g. To remove an association, select it from the Device Group, then click Remove Association.
 
     [bookmark: pgfId-1078589]Step 4 Map NDGs and roles for use in Cisco Security Manager; you should create associations that match as closely as possible the associations defined in the previous step:
 
     [bookmark: pgfId-1078590] a. On the Group Setup page, scroll down to the Cisco Security Manager area under TACACS+ Settings.
 
     [bookmark: pgfId-1078591] b. Select Assign a Cisco Security Manager on a per Network Device Group Basis.
 
     [bookmark: pgfId-1078592] c. Select an NDG from the Device Group list.
 
     [bookmark: pgfId-1078593] d. Select the role to which this NDG should be associated from the second list.
 
     [bookmark: pgfId-1078594] e. Click Add Association. The association appears in the Device Group box.
 
     [bookmark: pgfId-1078595] f. Repeat the process to create additional associations.
 
      
       
     
 
     
 
     [bookmark: pgfId-1078596]Note When you are selecting the Security Approver or Security Administrator roles in Cisco Secure ACS, we recommend selecting Network Administrator as the closest equivalent CiscoWorks role.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1078597]Note CiscoWorks Common Services has a default role called “Network Administrator.” Cisco Secure ACS has a default role called “Network Admin.” These roles are not identical; they differ for a few of the permissions in Cisco Security Manager. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-609069]Step 5 Click Submit to save your settings.
 
     [bookmark: pgfId-609071]Step 6 Repeat the process to define NDGs for the remaining user groups.
 
     [bookmark: pgfId-609073]Step 7 To save the associations that you have created, click Submit + Restart.
 
     [bookmark: pgfId-609078]For more information about customizing the default roles in ACS, see Customizing Cisco Secure ACS Roles.
 
     [bookmark: pgfId-609080]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1055705][bookmark: 77224]Troubleshooting Security Manager-ACS Interactions[bookmark: marker-1066556]
 
    [bookmark: pgfId-1055714]This following topics describe how to troubleshoot common problems that could occur because of how Security Manager and Cisco Secure ACS interact:
 
     
     	 [bookmark: pgfId-1055718]Using Multiple Versions of Security Manager with Same ACS
 
     	 [bookmark: pgfId-1055722]Authentication Fails When in ACS Mode
 
     	 [bookmark: pgfId-1055726]System Administrator Granted Read-Only Access
 
     	 [bookmark: pgfId-1055730]ACS Changes Not Appearing in Security Manager
 
     	 [bookmark: pgfId-1055734]Devices Configured in ACS Not Appearing in Security Manager
 
     	 [bookmark: pgfId-1055738]Working in Security Manager after Cisco Secure ACS Becomes Unreachable
 
     	 [bookmark: pgfId-1055742]Restoring Access to Cisco Secure ACS
 
     	 [bookmark: pgfId-1055746]Authentication Problems with Multihomed Devices
 
     	 [bookmark: pgfId-1055750]Authentication Problems with Devices Behind a NAT Boundary
 
    
 
     
      [bookmark: pgfId-1055753][bookmark: 72463]Using Multiple Versions of Security Manager with Same ACS[bookmark: marker-1066577]
 
     [bookmark: pgfId-1055754]You cannot use the same Cisco Secure ACS with two different versions of Security Manager. For example, if you have integrated Security Manager 3.3.1 with a Cisco Secure ACS and another part of your organization plans to use Security Manager 4.0.1 without upgrading the existing installation, you must integrate Security Manager 4.0.1 with a different ACS than the one used for Security Manager 3.3.1.
 
     [bookmark: pgfId-1055755]If you upgrade an existing Security Manager installation, you can continue to use the same Cisco Secure ACS. The permission settings are updated as required.
 
    
 
     
      [bookmark: pgfId-1055758][bookmark: 27466]Authentication Fails When in ACS Mode[bookmark: marker-1066598]
 
     [bookmark: pgfId-1055759]If authentication keeps failing when you log in to Security Manager or CiscoWorks Common Services, even though you used Common Services to configure Cisco Secure ACS as the AAA server for authentication, do the following:
 
      
      	 [bookmark: pgfId-1055760]Ensure that there is connectivity between the ACS servers and the server running Common Services and Security Manager.
 
      	 [bookmark: pgfId-1055761]Ensure that the user credentials (username and password) you are using are defined in ACS and are assigned to the appropriate user group.
 
      	 [bookmark: pgfId-1055762]Ensure that the Common Services server is defined as a AAA client on the Network Configuration page of ACS. Verify that the shared secret keys defined in Common Services (AAA Mode Setup page) and ACS (Network Configuration) match.
 
      	 [bookmark: pgfId-1055763]Ensure that the IP address of each ACS server is correctly defined on the AAA Mode Setup page in Common Services. 
 
      	 [bookmark: pgfId-1055764]Ensure that the correct account is defined on the Administration Control page of ACS.
 
      	 [bookmark: pgfId-1055765]Go to the AAA Mode Setup page in Common Services and verify that Common Services and Security Manager (as well as any other installed applications, such as AUS) are registered with Cisco Secure ACS.
 
      	 [bookmark: pgfId-1055766]Go to Administration Control > Access Setup in ACS and ensure that the ACS is configured for HTTPS communication. 
 
      	 [bookmark: pgfId-1055767]If you receive “key mismatch” errors in the ACS log, verify whether the Security Manager server is defined as a member of a network device group (NDG). If it is, be aware that if you defined a key for the NDG, that key takes precedence over the keys defined for the individual devices in the NDG, including the Security Manager server. Ensure that the key defined for the NDG matches the secret key of the Security Manager server. 
 
     
 
    
 
     
      [bookmark: pgfId-1055770][bookmark: 87234]System Administrator Granted Read-Only Access[bookmark: marker-1066619]
 
     [bookmark: pgfId-1055771]If you have read-only access to all policy pages of Security Manager even after logging in as a System Administrator with full permissions, do the following in Cisco Secure ACS:
 
      
      	 [bookmark: pgfId-1055772](When using network device groups (NDGs)) Click  Group Setup on the Cisco Secure ACS navigation bar, then verify that the System Administrator user role is associated with all necessary correct NDGs for  both CiscoWorks and Cisco Security Manager, especially the NDG containing the Common Services/Security Manager server.
 
      	 [bookmark: pgfId-1055773]Click  Network Configuration on the navigation bar, then do the following:
 
     
 
     [bookmark: pgfId-1055774] – Verify that the Common Services/Security Manager server is not assigned to the Not Assigned (default) group.
 
     [bookmark: pgfId-1055775] – Verify that the Common Services/Security Manager server is configured to use TACACS+ not RADIUS. TACACS+ is the only security protocol supported between the two servers.
 
      
       
     
 
     
 
     [bookmark: pgfId-1055776]Note You can configure the network devices (routers, switches, firewalls, and so on) managed by Security Manager for either TACACS+ or RADIUS.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1055779][bookmark: 94955]ACS Changes Not Appearing in Security Manager[bookmark: marker-1066632]
 
     [bookmark: pgfId-1055780]When you are using Security Manager with Cisco Secure ACS 4.x, information from ACS is cached when you log in to Security Manager or CiscoWorks Common Services on the Security Manager server. If you make changes in the Cisco Secure ACS Network Configuration and Group Setup while logged in to Security Manager, the changes might not appear immediately or be immediately effective in Security Manager. You must log out of Security Manager and Common Services and close their windows, then log in again, to refresh the information from ACS.
 
     [bookmark: pgfId-1055781]If you need to make changes in ACS, it is best practice to first log out of and close Security Manager windows, make your changes, and then log back in to the product.
 
      
       
     
 
     
 
     [bookmark: pgfId-1063529]Note Although Cisco Secure ACS 3.3 is not supported, if you are using that version of ACS, you must open Windows Services and restart the Cisco Security Manager Daemon Manager service to get the ACS changes to appear in Security Manager.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1063532][bookmark: 29182]Devices Configured in ACS Not Appearing in Security Manager[bookmark: marker-1066645]
 
     [bookmark: pgfId-1063533]If the devices that you configured on the Cisco Secure ACS are not appearing in Security Manager, it is probably a problem with the device display name.
 
     [bookmark: pgfId-1055787]The device display names defined in Security Manager must match the names you configure in ACS when you add the devices as AAA clients. This is particularly important when you use domain names. If you intend to append a domain name to the device name in Security Manager, the AAA client hostname in ACS must be <device_name>.<domain_name>, for example, pixfirewall.cisco.com.
 
    
 
     
      [bookmark: pgfId-1055789][bookmark: 23269]Working in Security Manager after Cisco Secure ACS Becomes Unreachable[bookmark: marker-1066650]
 
     [bookmark: pgfId-1055791]Security Manager sessions are affected if the Cisco Secure ACS cannot be reached. Therefore, you should consider creating a fault-tolerant infrastructure that utilizes multiple Cisco Secure ACS servers. Having multiple servers helps to ensure your ability to continue work in Security Manager even if connectivity is lost to one of the ACS servers. 
 
     [bookmark: pgfId-1055792]If your setup includes only a single Cisco Secure ACS and you wish to continue working in Security Manager in the event the ACS becomes unreachable, you can switch to performing local AAA authentication on the Security Manager server.
 
     [bookmark: pgfId-1061526]Procedure
 
     [bookmark: pgfId-1061532]To change the AAA mode, follow these steps:
 
     
 
     [bookmark: pgfId-1055793]Step 1 Log in to Common Services using the admin CiscoWorks local account.
 
     [bookmark: pgfId-1055794]Step 2 Select Server > Security > AAA Mode Setup, then change the AAA mode back to Non-ACS/CiscoWorks Local. This enables you to perform authentication and authorization using the local Common Services database and its built-in roles. Bear in mind that you must create local users in the AAA database to make use of local authentication.
 
     [bookmark: pgfId-1055795]Step 3 Click Change.
 
     [bookmark: pgfId-1055796]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1055799][bookmark: 72271]Restoring Access to Cisco Secure ACS[bookmark: marker-1066655]
 
     [bookmark: pgfId-1055800]If you cannot access Security Manager because the Cisco Secure ACS is down, do the following:
 
      
      	 [bookmark: pgfId-1055801]Open up Windows Services on the ACS server and check whether the CSTacacs and CSRadius services are up and running. Restart these services if required.
 
      	 [bookmark: pgfId-1055802]Perform the following procedure in CiscoWorks Common Services:
 
     
 
     
 
     [bookmark: pgfId-1055803]Step 1 Log in to Common Services as the admin user.
 
     [bookmark: pgfId-1055804]Step 2 Open a DOS window and run NMSROOT\bin\perl ResetLoginModule.pl.
 
     [bookmark: pgfId-1055805]Step 3 Exit Common Services, then log in a second time as the admin user.
 
     [bookmark: pgfId-1055806]Step 4 Go to Server > Security > AAA Mode Setup, then change the AAA mode to Non-ACS > CW Local mode.
 
     [bookmark: pgfId-1055807]Step 5 Open Windows Services and restart the Cisco Security Manager Daemon Manager service.
 
     [bookmark: pgfId-1055808]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1055811][bookmark: 67906]Authentication Problems with Multihomed Devices[bookmark: marker-1066660]
 
     [bookmark: pgfId-1055812]If you cannot configure a multihomed device (a device with multiple network interface cards (NICs)) that was added to the Cisco Secure ACS, even though your user role includes Modify Device permissions, there might be a problem with the way you entered the IP addresses for the device.
 
     [bookmark: pgfId-1055813]When you define a multihomed device as a AAA client of the Cisco Secure ACS, make sure to define the IP address of each NIC. Press Enter between each entry. For more information, see Adding Devices as AAA Clients Without NDGs.
 
    
 
     
      [bookmark: pgfId-1055815][bookmark: 83142]Authentication Problems with Devices Behind a NAT Boundary
 
     [bookmark: pgfId-1055816]If you cannot configure a device with a pre-NAT or post-NAT IP address that was added to the Cisco Secure ACS, even though your user role includes Modify Device permissions, there might be a problem with the IP addresses that you configured.
 
     [bookmark: pgfId-1055817]When a device is behind a NAT boundary, make sure to define all IP addresses, including pre-NAT and post-NAT, for the device in the AAA client configuration settings in Cisco Secure ACS. For more information on how to add AAA client settings to ACS, see User Guide for Cisco Secure Access Control Server. 
 
    
 
   
 
    
     [bookmark: pgfId-1082972][bookmark: 11730]Local RBAC Using Common Services 4.2.2 
 
    [bookmark: pgfId-1082979]Prior to Security Manager 4.3, the major advantages of using Cisco Secure ACS were (1) the ability to create highly granular user roles with specialized permission sets (for example, allowing the user to configure certain policy types but not others) and (2) the ability to restrict users to certain devices by configuring network device groups (NDGs). These granular privileges (effectively “role-based access control,” or RBAC) were not available in Security Manager 4.2 and earlier versions, unless you used Cisco Secure ACS. These granular privileges (RBAC) are available in Security Manager 4.3 and later because they use Common Services 4.0 or later, in which local RBAC is available without the use of ACS. 
 
    [bookmark: pgfId-1084846]Security Manager 4.9 retains compatibility with ACS 4.2. See Integrating Security Manager with Cisco Secure ACS. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1084867]Note Users who wish to migrate their RBAC abilities from ACS to Common Services must do so manually; there are no migration scripts or other migration support. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1082995]Common Services 4.2.2 provides device-level RBAC, defining custom roles for users, and customizing existing roles for users. The following features are available: 
 
     
     	 [bookmark: pgfId-1083000]Managing users (add, remove, edit)
 
     	 [bookmark: pgfId-1083004]Managing network device groups (NDGs) to provide device-level RBAC
 
     	 [bookmark: pgfId-1083006]Managing custom roles
 
     	 [bookmark: pgfId-1083008]Mapping roles to device groups
 
     	 [bookmark: pgfId-1083145]Granular privileges for policy object types and policy types, such as “view network objects,” “modify service objects,” and “modify access rules.” 
 
    
 
    [bookmark: pgfId-1083146]You can implement local RBAC using Common Services 4.2.2 by completing tasks in the following areas:
 
     
     	 [bookmark: pgfId-1083150]Authentication Mode Setup
 
     	 [bookmark: pgfId-1083173]User Management
 
     	 [bookmark: pgfId-1083177]Group Management
 
     	 [bookmark: pgfId-1083181]Role Management 
 
    
 
     
      [bookmark: pgfId-1083109][bookmark: 79623]Authentication Mode Setup
 
     [bookmark: pgfId-1083184]Follow the steps to set up a non-ACS account. See Non-ACS Account. 
 
     [bookmark: pgfId-1083259]Then select the CiscoWorks Local login module. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1083263]Tip CiscoWorks Local is the default value for a clean installation of Security Manager. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1083124][bookmark: 18892]User Management
 
     [bookmark: pgfId-1083273]Navigate to the Local User Setup page in Common Services: 
 
     [bookmark: pgfId-1083537]Server where Security Manager is installed > 
 
     [bookmark: pgfId-1083549]desktop icon for Cisco Security Manager application > 
 
     [bookmark: pgfId-1083554]user account login > 
 
     [bookmark: pgfId-1083559]Server Administration > 
 
     [bookmark: pgfId-1083564]Home > 
 
     [bookmark: pgfId-1083660]System Tasks > 
 
     [bookmark: pgfId-1083569]Local User Setup 
 
     [bookmark: pgfId-1083575]On the Local User Setup page, you can select a user and then choose one of the following actions: 
 
      
      	 [bookmark: pgfId-1083586]Import Users 
 
      	 [bookmark: pgfId-1083592]Export Users 
 
      	 [bookmark: pgfId-1083601]Edit 
 
      	 [bookmark: pgfId-1083606]Delete 
 
      	 [bookmark: pgfId-1083611]Add 
 
      	 [bookmark: pgfId-1083616]Modify My Profile 
 
     
 
     [bookmark: pgfId-1083628]If you select more than one user, Edit is not available. 
 
     [bookmark: pgfId-1083635]If you select no users, you can choose one of the following actions: 
 
      
      	 [bookmark: pgfId-1083638]Import Users 
 
      	 [bookmark: pgfId-1083642]Add 
 
      	 [bookmark: pgfId-1083669]Modify My Profile 
 
     
 
     [bookmark: pgfId-1083676]If you select Edit or Add, you can select one of these three authorization types:
 
      
      	 [bookmark: pgfId-1083680]Full Authorization
 
      	 [bookmark: pgfId-1083681]Enable Task Authorization
 
      	 [bookmark: pgfId-1083682]Enable Device Authorization
 
     
 
    
 
     
      [bookmark: pgfId-1083671][bookmark: 39468]Group Management 
 
     [bookmark: pgfId-1083697]Navigate to the Device Groups page in Security Manager: 
 
     [bookmark: pgfId-1083702]Server where Security Manager is installed > 
 
     [bookmark: pgfId-1083703]desktop icon for Configuration Manager application > 
 
     [bookmark: pgfId-1083704]user account login > 
 
     [bookmark: pgfId-1083705]Tools > 
 
     [bookmark: pgfId-1083706]Security Manager Administration > 
 
     [bookmark: pgfId-1083713]Device Groups
 
     [bookmark: pgfId-1083719]You cannot manage device groups through the Common Services interface (Server where Security Manager is installed > desktop icon for Cisco Security Manager application). 
 
    
 
     
      [bookmark: pgfId-1083673][bookmark: 22364]Role Management
 
     [bookmark: pgfId-1083125]Navigate to the Role Management Setup page:
 
     [bookmark: pgfId-1083738]Server where Security Manager is installed > 
 
     [bookmark: pgfId-1083739]desktop icon for Cisco Security Manager application > 
 
     [bookmark: pgfId-1083740]user account login > 
 
     [bookmark: pgfId-1083747]Server Administration > 
 
     [bookmark: pgfId-1083748]Server > [menu selector symbol] >
 
     [bookmark: pgfId-1083749]Security > 
 
     [bookmark: pgfId-1083750]Single-Server Management > 
 
     [bookmark: pgfId-1083751]Role Management Setup
 
     [bookmark: pgfId-1083752]The Role Management Setup page displays the default roles, which are Approver, Help Desk, Network Administrator, Network Operator, Security Administrator, Security Approver, Super Admin, and System Administrator. The Role Management Setup page also displays custom roles, if any, that you have added. 
 
     [bookmark: pgfId-1083736]On the Role Management page, you can perform the following operations: Add, Edit, Delete, Copy, Export, Import, Set as default, and Clear default. 
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1073331][bookmark: 58185]Troubleshooting[bookmark: marker-1082577] 
      
      
 
     
 
 
    [bookmark: pgfId-1089663]CiscoWorks Common Services provides Security Manager with its framework for installation, uninstallation, and re-installation on servers. If the installation or uninstallation of Security Manager server software causes an error, see “Troubleshooting and FAQs” in the Common Services online help. 
 
    [bookmark: pgfId-1073552]The following topics help you to troubleshoot problems that might occur when you install, uninstall, or re-install Security Manager-related software applications on a client system or on a server, including the standalone version of Cisco Security Agent.
 
     
     	 [bookmark: pgfId-1073556]Startup Requirements for Cisco Security Manager Services
 
     	 [bookmark: pgfId-1076081]Comprehensive List of Required TCP and UDP Ports
 
     	 [bookmark: pgfId-1075409]Troubleshooting the Security Manager Server
 
     	 [bookmark: pgfId-1075421]Troubleshooting the Security Manager Client
 
     	 [bookmark: pgfId-1073564]Running a Server Self-Test
 
     	 [bookmark: pgfId-1073568]Collecting Server Troubleshooting Information
 
     	 [bookmark: pgfId-1073572]Viewing and Changing Server Process Status
 
     	 [bookmark: pgfId-1073510]Reviewing the Server Installation Log File
 
     	 [bookmark: pgfId-1089762]Symantec Co-existence Issues
 
     	 [bookmark: pgfId-1090039]Problems after Installing Windows Updates
 
     	 [bookmark: pgfId-1090455]Problem Connecting to an ASA Device with Higher Encryption
 
     	 [bookmark: pgfId-1091924]Pop-up Showing Activation.jar in Use During the Time of Installation
 
     	 [bookmark: pgfId-1094462]How to Set the Locale for the Windows Default User Template to U.S. English
 
     	 [bookmark: pgfId-1113538]How to disable the RMI Registry Port
 
    
 
   
 
    
     [bookmark: pgfId-1026852][bookmark: 29092]Startup Requirements for Cisco Security Manager Services[bookmark: marker-1082834]
 
    [bookmark: pgfId-1076927]Cisco Security Manager services must be started in a specific order for Security Manager to function correctly. The initialization of these services is controlled by the Cisco Security Manager Daemon Manager service. You should not change the service startup type for any of the Cisco Security Manager services. You should also not stop or start any of the Cisco Security Manager services manually. If you need to restart a specific service, you should restart the Cisco Security Manager Daemon Manager which ensures that all the related services are stopped and started in the correct order.
 
   
 
    
     [bookmark: pgfId-1076929][bookmark: 56601]Comprehensive List of Required TCP and UDP Ports[bookmark: marker-1082607]
 
    [bookmark: pgfId-1076930]The Cisco Security Management Suite applications need to communicate with clients and other applications. Other server applications might be installed on separate computers. For successful communication, certain TCP and UDP ports need to be open and available for transmitting traffic. Normally, you need to open only those ports described in Required Services and Ports. However, if you find that the applications are not able to communicate, the following table describes additional ports that you might need to open. The list is in port number order.
 
    [bookmark: pgfId-1076732]
 
     
      
       
       [bookmark: pgfId-1076133]Table A-1 [bookmark: 23207]Required Services and Ports 
 
       
       
        
        	 
          
          [bookmark: pgfId-1076145]Service 
         
  
        	 
          
          [bookmark: pgfId-1076147]Used For, or Used By 
         
  
        	 
          
          [bookmark: pgfId-1076149]Port Number/ 
          
 Range of Ports 
         
  
        	 
          
          [bookmark: pgfId-1076151]Protocol 
         
  
        	 
          
          [bookmark: pgfId-1076153]Inbound 
         
  
        	 
          
          [bookmark: pgfId-1076155]Outbound 
         
  
       
 
        
        	[bookmark: pgfId-1076169]FTP
  
        	[bookmark: pgfId-1076171]Security Manager communication with TMS server
  
        	[bookmark: pgfId-1076173]21
  
        	[bookmark: pgfId-1076175]TCP
  
        	[bookmark: pgfId-1076177]—
  
        	[bookmark: pgfId-1076179]X
  
       
 
        
        	 [bookmark: pgfId-1076181]SSH
  
        	[bookmark: pgfId-1076183]Common Services
  
        	[bookmark: pgfId-1076185]22
  
        	[bookmark: pgfId-1076187]TCP
  
        	[bookmark: pgfId-1076189]—
  
        	[bookmark: pgfId-1076191]X
  
       
 
        
        	[bookmark: pgfId-1076195]Security Manager
  
        	[bookmark: pgfId-1076197]22
  
        	[bookmark: pgfId-1076199]TCP
  
        	[bookmark: pgfId-1076201]—
  
        	[bookmark: pgfId-1076203]X
  
       
 
        
        	[bookmark: pgfId-1076217]Telnet
  
        	[bookmark: pgfId-1076219]Security Manager
  
        	[bookmark: pgfId-1076221]23
  
        	[bookmark: pgfId-1076223]TCP
  
        	[bookmark: pgfId-1076225]—
  
        	[bookmark: pgfId-1076227]X
  
       
 
        
        	[bookmark: pgfId-1078958]SMTP
  
        	[bookmark: pgfId-1078960]Common Services
  
        	[bookmark: pgfId-1078962]25
  
        	[bookmark: pgfId-1078964]TCP
  
        	[bookmark: pgfId-1078966]—
  
        	[bookmark: pgfId-1078968]X
  
       
 
        
        	[bookmark: pgfId-1076241]TACACS+ (for ACS)
  
        	[bookmark: pgfId-1076243]Common Services
  
        	[bookmark: pgfId-1076245]49
  
        	[bookmark: pgfId-1076247]TCP
  
        	[bookmark: pgfId-1076249]—
  
        	[bookmark: pgfId-1076251]X
  
       
 
        
        	[bookmark: pgfId-1076265]TFTP
  
        	[bookmark: pgfId-1076267]Common Services
  
        	[bookmark: pgfId-1076269]69
  
        	[bookmark: pgfId-1076271]UDP
  
        	[bookmark: pgfId-1076273]X
  
        	[bookmark: pgfId-1076275]X
  
       
 
        
        	 [bookmark: pgfId-1076277]HTTP
  
        	[bookmark: pgfId-1076279]Common Services
  
        	 [bookmark: pgfId-1076281]80
  
        	[bookmark: pgfId-1076283]TCP
  
        	[bookmark: pgfId-1076285]—
  
        	[bookmark: pgfId-1076287]X
  
       
 
        
        	[bookmark: pgfId-1078997]Security Manager
  
        	[bookmark: pgfId-1079001]TCP
  
        	[bookmark: pgfId-1079003]—
  
        	[bookmark: pgfId-1079005]X
  
       
 
        
        	 [bookmark: pgfId-1076301]SNMP (polling)
  
        	[bookmark: pgfId-1076303]Common Services
  
        	[bookmark: pgfId-1076305]161
  
        	[bookmark: pgfId-1076307]UDP
  
        	[bookmark: pgfId-1076309]—
  
        	[bookmark: pgfId-1076311]X
  
       
 
        
        	[bookmark: pgfId-1076315]Performance Monitor
  
        	[bookmark: pgfId-1076317]161
  
        	[bookmark: pgfId-1076319]UDP
  
        	[bookmark: pgfId-1076321]—
  
        	[bookmark: pgfId-1076323]X
  
       
 
        
        	 [bookmark: pgfId-1076325]SNMP (traps)
  
        	[bookmark: pgfId-1076327]Common Services
  
        	[bookmark: pgfId-1076329]162
  
        	[bookmark: pgfId-1076331]UDP
  
        	[bookmark: pgfId-1076333]—
  
        	[bookmark: pgfId-1076335]X
  
       
 
        
        	[bookmark: pgfId-1076339]Performance Monitor
  
        	[bookmark: pgfId-1076341]162
  
        	[bookmark: pgfId-1076343]UDP
  
        	[bookmark: pgfId-1076345]X
  
        	[bookmark: pgfId-1076347]—
  
       
 
        
        	 [bookmark: pgfId-1076349]HTTPS (SSL)
  
        	[bookmark: pgfId-1076351]Common Services
  
        	 [bookmark: pgfId-1076357]4431
  
        	[bookmark: pgfId-1076359]TCP
  
        	[bookmark: pgfId-1076361]X
  
        	[bookmark: pgfId-1076363]—
  
       
 
        
        	[bookmark: pgfId-1076367]Security Manager
  
        	[bookmark: pgfId-1076371]TCP
  
        	[bookmark: pgfId-1076373]X
  
        	[bookmark: pgfId-1076375]X
  
       
 
        
        	[bookmark: pgfId-1076379]AUS
  
        	[bookmark: pgfId-1076383]TCP
  
        	[bookmark: pgfId-1076385]X
  
        	[bookmark: pgfId-1076387]—
  
       
 
        
        	[bookmark: pgfId-1076391]Performance Monitor
  
        	[bookmark: pgfId-1076395]TCP
  
        	[bookmark: pgfId-1076397]X
  
        	[bookmark: pgfId-1076399]—
  
       
 
        
        	 [bookmark: pgfId-1079332]Syslog2
  
        	[bookmark: pgfId-1079334]Security Manager
  
        	[bookmark: pgfId-1079336]514
  
        	[bookmark: pgfId-1079338]UDP
  
        	[bookmark: pgfId-1079340]X
  
        	[bookmark: pgfId-1079342]—
  
       
 
        
        	[bookmark: pgfId-1076403]Common Services (without Security Manager installed)
  
        	[bookmark: pgfId-1076405]514 or 49514 (see footnote for this row)
  
        	[bookmark: pgfId-1076407]UDP
  
        	[bookmark: pgfId-1076409]X
  
        	[bookmark: pgfId-1076411]—
  
       
 
        
        	[bookmark: pgfId-1076415]Performance Monitor (without Security Manager installed)
  
        	[bookmark: pgfId-1076417]514
  
        	[bookmark: pgfId-1076419]UDP
  
        	[bookmark: pgfId-1076421]X
  
        	[bookmark: pgfId-1076423]—
  
       
 
        
        	[bookmark: pgfId-1076425]Remote Copy Protocol
  
        	[bookmark: pgfId-1076427]Common Services
  
        	[bookmark: pgfId-1076429]514
  
        	[bookmark: pgfId-1076431]TCP
  
        	[bookmark: pgfId-1076433]X
  
        	[bookmark: pgfId-1076435]X
  
       
 
        
        	 [bookmark: pgfId-1076437]HTTP
  
        	[bookmark: pgfId-1076439]Common Services
  
        	 [bookmark: pgfId-1076441]1741
  
        	[bookmark: pgfId-1076443]TCP
  
        	[bookmark: pgfId-1076445]X
  
        	[bookmark: pgfId-1076447]—
  
       
 
        
        	[bookmark: pgfId-1076451]Security Manager
  
        	[bookmark: pgfId-1076455]TCP
  
        	[bookmark: pgfId-1076457]X
  
        	[bookmark: pgfId-1076459]—
  
       
 
        
        	[bookmark: pgfId-1076463]AUS
  
        	[bookmark: pgfId-1076467]TCP
  
        	[bookmark: pgfId-1076469]X
  
        	[bookmark: pgfId-1076471]—
  
       
 
        
        	[bookmark: pgfId-1076475]Performance Monitor
  
        	[bookmark: pgfId-1076479]TCP
  
        	[bookmark: pgfId-1076481]X
  
        	[bookmark: pgfId-1076483]—
  
       
 
        
        	[bookmark: pgfId-1076485]RADIUS
 [bookmark: pgfId-1076486]LDAP
 [bookmark: pgfId-1076487]Kerberos
  
        	[bookmark: pgfId-1076489]Security Manager (to external AAA server)
  
        	[bookmark: pgfId-1076491]1645, 1646, 1812(new), 389, 636 (SSL), 88
  
        	[bookmark: pgfId-1076493]TCP
  
        	[bookmark: pgfId-1076495]—
  
        	[bookmark: pgfId-1076497]X
  
       
 
        
        	[bookmark: pgfId-1076499]Access Control Server HTTP/HTTPS
  
        	[bookmark: pgfId-1076501]Security Manager
  
        	[bookmark: pgfId-1076503]2002
  
        	[bookmark: pgfId-1076505]TCP
  
        	[bookmark: pgfId-1076507]—
  
        	[bookmark: pgfId-1076509]X
  
       
 
        
        	[bookmark: pgfId-1076553]HIPO port for CiscoWorks gatekeeper
  
        	[bookmark: pgfId-1076555]Common Services
  
        	[bookmark: pgfId-1076557]8088
  
        	[bookmark: pgfId-1076559]TCP
  
        	[bookmark: pgfId-1076561]X
  
        	[bookmark: pgfId-1076563]X
  
       
 
        
        	[bookmark: pgfId-1076565]Tomcat shutdown
  
        	[bookmark: pgfId-1076567]Common Services
  
        	[bookmark: pgfId-1076569]9007
  
        	[bookmark: pgfId-1076571]TCP
  
        	[bookmark: pgfId-1076573]X
  
        	[bookmark: pgfId-1076575]—
  
       
 
        
        	[bookmark: pgfId-1076577]Tomcat Ajp13 connector
  
        	[bookmark: pgfId-1076579]Common Services
  
        	[bookmark: pgfId-1076581]9009
  
        	[bookmark: pgfId-1076583]TCP
  
        	[bookmark: pgfId-1076585]X
  
        	[bookmark: pgfId-1076587]—
  
       
 
        
        	[bookmark: pgfId-1076589]Database
  
        	[bookmark: pgfId-1076591]Security Manager
  
        	[bookmark: pgfId-1076593]10033
  
        	[bookmark: pgfId-1076595]TCP
  
        	[bookmark: pgfId-1076597]X
  
        	[bookmark: pgfId-1076599]—
  
       
 
        
        	[bookmark: pgfId-1076601]License Server
  
        	[bookmark: pgfId-1076603]Common Services
  
        	[bookmark: pgfId-1076605]40401
  
        	[bookmark: pgfId-1076607]TCP
  
        	[bookmark: pgfId-1076609]X
  
        	[bookmark: pgfId-1076611]—
  
       
 
        
        	[bookmark: pgfId-1076613]Daemon Manager
  
        	[bookmark: pgfId-1076615]Common Services
  
        	[bookmark: pgfId-1076617]42340
  
        	[bookmark: pgfId-1076619]TCP
  
        	[bookmark: pgfId-1076621]X
  
        	[bookmark: pgfId-1076623]X
  
       
 
        
        	[bookmark: pgfId-1076625]Osagent
  
        	[bookmark: pgfId-1076627]Common Services
  
        	[bookmark: pgfId-1076629]42342
  
        	[bookmark: pgfId-1076631]UDP
  
        	[bookmark: pgfId-1076633]X
  
        	[bookmark: pgfId-1076635]X
  
       
 
        
        	[bookmark: pgfId-1076637]Database
  
        	[bookmark: pgfId-1076639]Common Services
  
        	[bookmark: pgfId-1076641]43441
  
        	[bookmark: pgfId-1076643]TCP
  
        	[bookmark: pgfId-1076645]X
  
        	[bookmark: pgfId-1076647]—
  
       
 
        
        	 [bookmark: pgfId-1076649]Sybase
  
        	[bookmark: pgfId-1076651]Auto Update Server
  
        	[bookmark: pgfId-1076653]43451
  
        	[bookmark: pgfId-1076655]TCP
  
        	[bookmark: pgfId-1076657]X
  
        	[bookmark: pgfId-1076659]X
  
       
 
        
        	[bookmark: pgfId-1077828]Performance Monitor
  
        	[bookmark: pgfId-1077807]43453
  
        	[bookmark: pgfId-1077809]TCP
  
        	[bookmark: pgfId-1077811]X
  
        	[bookmark: pgfId-1077813]X
  
       
 
        
        	[bookmark: pgfId-1076661]DCR and OGS
  
        	[bookmark: pgfId-1076663]Common Services
  
        	[bookmark: pgfId-1076665]40050 – 40070
  
        	[bookmark: pgfId-1076667]TCP
  
        	[bookmark: pgfId-1076669]X
  
        	[bookmark: pgfId-1076671]—
  
       
 
        
        	 [bookmark: pgfId-1076673]Event Services
  
        	[bookmark: pgfId-1076675]Software Service
  
        	[bookmark: pgfId-1076677]42350/
44350
  
        	[bookmark: pgfId-1076679]UDP
  
        	[bookmark: pgfId-1076681]X
  
        	[bookmark: pgfId-1076683]X
  
       
 
        
        	[bookmark: pgfId-1076687]Software Listening
  
        	[bookmark: pgfId-1076689]42351/
44351
  
        	[bookmark: pgfId-1076691]TCP
  
        	[bookmark: pgfId-1076693]X
  
        	[bookmark: pgfId-1076695]X
  
       
 
        
        	[bookmark: pgfId-1076699]Software HTTP
  
        	[bookmark: pgfId-1076701]42352/
44352
  
        	[bookmark: pgfId-1076703]TCP
  
        	[bookmark: pgfId-1076705]X
  
        	[bookmark: pgfId-1076707]X
  
       
 
        
        	[bookmark: pgfId-1076711]Software Routing
  
        	[bookmark: pgfId-1076713]42353/
44353
  
        	[bookmark: pgfId-1076715]TCP
  
        	[bookmark: pgfId-1076717]X
  
        	[bookmark: pgfId-1076719]X
  
       
 
        
        	[bookmark: pgfId-1076721]Transport Mechanism (CSTM)
  
        	[bookmark: pgfId-1076723]Common Services
  
        	[bookmark: pgfId-1076725]50000 – 50020 
  
        	[bookmark: pgfId-1076727]TCP
  
        	[bookmark: pgfId-1076729]X
  
        	[bookmark: pgfId-1076731]—
  
       
 
       
     
 
    
 
     
      
       
       	 1.[bookmark: pgfId-1076356][bookmark: 72003]To share and exchange information with a Cisco Security Monitoring, Analysis, and Response System (Cisco Security MARS) appliance, Security Manager uses HTTPS over port 443 by default. You can choose whether to use a different port for this purpose.
 2.[bookmark: pgfId-1081551]During the installation or upgrade of Security Manager, the Common Services syslog service port is changed from 514 to 49514. Later, if Security Manager is uninstalled, the port is not reverted to 514. 
  
      
 
      
    
 
   
 
    
     [bookmark: pgfId-1070593][bookmark: 13645]Troubleshooting the Security Manager Server
 
    [bookmark: pgfId-1048498]This section answers questions that you might have about:
 
     
     	 [bookmark: pgfId-1048507]Server Problems During Installation
 
     	 [bookmark: pgfId-1048527]Server Problems After Installation
 
     	 [bookmark: pgfId-1048631]Server Problems During Uninstallation
 
    
 
     
      [bookmark: pgfId-1048494][bookmark: 57480]Server Problems During Installation[bookmark: marker-1082620]
 
     [bookmark: pgfId-1024516]Q. [bookmark: marker-1026559][bookmark: 92886]When I install the server software, what does this installation error message mean? 
 
     [bookmark: pgfId-1015267]Server software installation error messages and explanations appear in Table A-2, where they are sorted alphabetically by their first word. 
 
     [bookmark: pgfId-1081304]
 
      
       
        
        [bookmark: pgfId-1081225]Table A-2 [bookmark: 61580]Installation Error Messages (Server) 
 
        
        
         
         	 
           
           [bookmark: pgfId-1081231]Message 
          
  
         	 
           
           [bookmark: pgfId-1081233]Reason for Message 
          
  
         	 
           
           [bookmark: pgfId-1081235]User Action 
          
  
        
 
         
         	[bookmark: pgfId-1081237]License file failed. ERROR: The file with the name c:\progra~1\CSCOpx\setup does not exist
  
         	[bookmark: pgfId-1081239]An earlier attempt to uninstall a Common Services-dependent application failed. 
  
         	[bookmark: pgfId-1089286] 1. Shut down the server, then restart it.
 [bookmark: pgfId-1089294] 2. Use a Registry editor to delete this entry:
$HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Cisco\Resource Manager\CurrentVersion. 
 [bookmark: pgfId-1089295] 3. In the directory where you installed Security Manager, create a subdirectory named setup.
 [bookmark: pgfId-1081244] 4. Delete CMFLOCK.TXT if it exists.
 [bookmark: pgfId-1081245] 5. Re-install Security Manager.
  
        
 
         
         	 
           
           [bookmark: pgfId-1081247]Corrupt License file. Please enter a valid License file. 
          
  
         	[bookmark: pgfId-1081249]Your license file is corrupted or the contents of the license file are invalid.
  
         	[bookmark: pgfId-1081254]See Getting Help with Licensing.
  
        
 
         
         	 
           
           [bookmark: pgfId-1081256]Corrupt License file entered for 5 tries. Install will proceed in EVAL mode. Press OK to proceed. 
          
  
         	[bookmark: pgfId-1081258]You entered the pathname to an invalid license file for five consecutive attempts. After five failed attempts, installation continues in evaluation mode.
  
         	[bookmark: pgfId-1081260]Click OK to close the license error dialog box, and installation proceeds to the next screen of the wizard.
  
        
 
         
         	[bookmark: pgfId-1081262]One instance of CiscoWorks Installation is already running. If you are sure that no other instances are running, remove the file C:\CMFLOCK.TXT. This installation will now abort.
  
         	[bookmark: pgfId-1081264]An earlier attempt to install a Common Services-dependant application failed.
  
         	[bookmark: pgfId-1081266]Delete the C:\CMFLOCK.TXT file, then try again.
  
        
 
         
         	 
           
           [bookmark: pgfId-1081268]Severe 
          
 
           
           [bookmark: pgfId-1081269] 
          
 
           
           [bookmark: pgfId-1081270]Failed on call to FileInsertLine. 
          
  
         	[bookmark: pgfId-1081272]Your server does not meet the requirement for hard drive space.
  
         	[bookmark: pgfId-1081277]See Server Requirements and Recommendations, page 3-4.
  
        
 
         
         	 
           
           [bookmark: pgfId-1081279]Temporary directory used by installation has reached _istmp9x. If _istmp99 is reached, no more setups can be run on this computer, they fail with error -112. 
          
  
         	[bookmark: pgfId-1081281]Temporary files that are supposed to be deleted automatically during software installations have not been deleted on your server. 
  
         	[bookmark: pgfId-1081283]Search the temporary directory on your server for subdirectories with names that include the “_istmp” string. Delete all such subdirectories. 
  
        
 
         
         	 
           
           [bookmark: pgfId-1081285]Windows cannot find 'C:\Documents and Settings\Administrator\WINDOWS\System32\cmd.exe'. Make sure you typed the name correctly, and then try again. To search for a file, click the Start button, and then click Search. 
          
  
         	[bookmark: pgfId-1081287]You left Terminal Services enabled during installation, even though we do not support this. See Readiness Checklist for Installation, page 4-3.
  
         	[bookmark: pgfId-1081292] 1. Disable Terminal Services. 
 [bookmark: pgfId-1081293]To learn how to do this, see the “Terminal Server Support for Windows 2000 and Windows 2003 Server” topic in Installing and Getting Started With CiscoWorks LAN Management Solution 3.1, at
 [bookmark: pgfId-1081295]http://www.cisco.com/en/US/docs/net_mgmt/ciscoworks_lan_management_solution/3.1/install/guide/IGSG31.html
 [bookmark: pgfId-1081296] 2. Try again to install Security Manager.
  
        
 
         
         	 
           
           [bookmark: pgfId-1081298]Setup has detected that unInstallShield is in use. Close unInstallShield and restart setup. Error 432. 
          
  
         	[bookmark: pgfId-1081300]The installation program checks the Windows account permissions during installation. If the Windows account that you are installing CiscoWorks Common Services under does not have local administrator privileges, InstallShield displays this error message. 
  
         	[bookmark: pgfId-1081302] 1. Verify that you have appropriate permissions to write to %WINDIR%. Installation or uninstallation has to be done by a member of local administrators group. 
 [bookmark: pgfId-1081303] 2. Click OK to close the error message, log out of Windows, and log back in to Windows using an account that has local administrator privileges.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1081306]Q. [bookmark: marker-1081305]What should I do if the server installer suspends operation (hangs)? 
 
     [bookmark: pgfId-1081307]Reboot and try again.
 
     [bookmark: pgfId-1046221]Q. Can I install both Cisco Security Manager and Cisco Secure Access Control Server on one system?
 
     [bookmark: pgfId-1046226]We recommend that you do not. We do not support the coexistence of Security Manager on the same server with Cisco Secure ACS for Windows.
 
     [bookmark: pgfId-1076050]Q. Why does the Security Manager database backup fail?
 
     [bookmark: pgfId-1081312]If network management applications, such as Tivoli, were used to install Cygwin on the same system where a Security Manager server was installed, backup of the Security Manager database fails. Uninstall Cygwin.[bookmark: marker-1081313]
 
    
 
     
      [bookmark: pgfId-1081316][bookmark: 59065]Server Problems After Installation[bookmark: marker-1082625]
 
     [bookmark: pgfId-1081320]Q. [bookmark: marker-1081317][bookmark: marker-1081318][bookmark: 78047]The Security Manager interface does not appear, or is not displayed correctly, or certain interface elements are missing. What happened? 
 
     [bookmark: pgfId-1026962]There are several possible explanations. Investigate the scenarios in this list to understand and work around simple problems that might affect the interface:
 
      
      	 [bookmark: pgfId-1026972]Some required services are not running on your server. Restart the server daemon manager, wait for all services to start completely, then restart Security Manager Client and try again to connect. 
 
      	 [bookmark: pgfId-1035243]Your server does not have enough free disk space. Confirm that the Security Manager partition on your server has at least 500 MB free.
 
      	 [bookmark: pgfId-1034041]Your base license file is corrupted. See  Getting Help with Licensing, page 2-8 . 
 
      	 [bookmark: pgfId-1050681]Your server uses the wrong Windows language. Only English, on US-English versions of Windows, and Japanese, on Japanese versions of Windows, are supported. (See  Server Requirements and Recommendations, page 3-4 .) Any other language can corrupt the installed version of Security Manager, and missing GUI elements are one possible symptom. If you are using an unsupported language, you must select a supported language, then uninstall and re-install Security Manager. See  Uninstalling Server Applications, page 5-19 .
 
      	 [bookmark: pgfId-1031249]You ran the Security Manager installation utility over a network connection, but we do not support this use case (see  Installing Security Manager Server, Common Services, and AUS, page 5-3 ). You must uninstall and re-install the server software. See  Uninstalling Server Applications, page 5-19 .
 
      	 [bookmark: pgfId-1034163]Your client system does not meet the minimum requirements. See  Client Requirements, page 3-10 . 
 
      	 [bookmark: pgfId-1034943]You tried to use HTTP, but the required protocol is HTTPS.
 
      	 [bookmark: pgfId-1034931]Buttons are the only missing element. You opened the Display Properties control panel on the client system, then changed one or more settings under the Appearance tab while you were simultaneously using Security Manager Client. To work around this problem, exit Security Manager Client, then restart it.
 
      	 [bookmark: pgfId-1034272]The wrong graphics card driver software is installed on your client system. See  Client Requirements, page 3-10 .
 
     
 
     [bookmark: pgfId-1074706]Problem When trying to open web interface to Security Manager using a web browser, a message indicates that I do not have permission to access /cwhp/LiaisonServlet on the Security Manager server. What does this mean?[bookmark: marker-1075047]
 
     [bookmark: pgfId-1074710]Solution The following table describes common causes and suggested workarounds for this problem.
 
     [bookmark: pgfId-1074743]
 
      
       
        
        [bookmark: pgfId-1074717]Table A-3 [bookmark: 11235]Causes and Workarounds for LiaisonServlet Error 
 
        
        
         
         	 
           
           [bookmark: pgfId-1074721]Cause 
          
  
         	 
           
           [bookmark: pgfId-1074723]Workaround 
          
  
        
 
         
         	[bookmark: pgfId-1074725]Anti-virus application installed on server
  
         	[bookmark: pgfId-1074727]Uninstall the anti-virus application.
  
        
 
         
         	[bookmark: pgfId-1074729]IIS installed on server
  
         	[bookmark: pgfId-1074731]IIS is not compatible with Security Manager and must be uninstalled.
  
        
 
         
         	[bookmark: pgfId-1074733]Services required by Security Manager do not start in proper order
  
         	[bookmark: pgfId-1074735]The only service that should be set to Automatic is the Cisco Security Manager Daemon Manager. All other CiscoWorks services should be set to Manual. Please note that it may take the Daemon Manager a few minutes to start up the other Ciscoworks services. These services must start up in the proper order; manually starting up the services can cause errors.
  
        
 
         
         	[bookmark: pgfId-1074737]casuser password
  
         	[bookmark: pgfId-1111940]The following five permissions are assigned and set, automatically, at the time of Security Manager installation:
 
           
           	 [bookmark: pgfId-1111941]Access this computer from network - casusers
 
           	 [bookmark: pgfId-1111942]Deny access to this computer from network - casuser
 
           	 [bookmark: pgfId-1111943]Deny logon locally - casuser
 
           	 [bookmark: pgfId-1111944]Log on as batch job - casuser, casusers
 
           	 [bookmark: pgfId-1111945]Log on as a service – casuser
 
          
 [bookmark: pgfId-1074739]The casuser login is equivalent to a Windows administrator and provides access to all Common Services and Security Manager tasks. Reset the casuser password as follows:
 [bookmark: pgfId-1074740] 1. Open a command prompt on the server using the Run as administrator option.
 [bookmark: pgfId-1074741] 2. Type NMSRoot\setup\support\resetCasuser.exe and then press Enter.
 [bookmark: pgfId-1108993]Note The location NMSROOT is the path to the Security Manager installation directory. The default is C:\Program Files (x86)\CSCOpx. 
 [bookmark: pgfId-1074742] 3. Of the two option displayed, choose option 2 - Enter casuser password. You will be prompted to enter a password for casuser and then to reenter the password for confirmation.
 [bookmark: pgfId-1111899] 4. If local security policy is configured, add the casuser account to the ‘Log on as a service’ operation in the local security policy.
 [bookmark: pgfId-1108785] 5. Run the following command to apply the casuser permission to NMSROOT:

C:\Windows\System32\cacls.exe “NMSROOT” /E /T /G Administrators:F casusers:F
 [bookmark: pgfId-1108788] 6. Run the following command to set the casuser to database services:

NMSROOT\bin\perl NMSROOT\bin\ChangeService2Casuser.pl "casuser" "casuserpassword"
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1027441]Q. [bookmark: marker-1027440]Security Manager sees only the local volumes, not the mapped drives, when I use it to browse directories on my server. Why?
 
     [bookmark: pgfId-1027442]Microsoft includes this feature by design in Windows to enhance server security. You must place any files you need to select in Security Manager on the server, such as license files.
 
     [bookmark: pgfId-1044369]Q. Why is Security Manager missing from the Start menu in my Japanese version of Windows?
 
     [bookmark: pgfId-1044375]You might have configured the regional and language option settings on the server to use English. We do not support English as the language in any Japanese version of Windows (see Server Requirements and Recommendations, page 3-4). Use the Control Panel to reset the language to Japanese.
 
     [bookmark: pgfId-1030040]Q. My server SSL certificate is no longer valid. Also, the DCRServer process does not start. What happened?
 
     [bookmark: pgfId-1030081]You reset the server date or time so that it is outside the range in which your SSL certificate is valid. See Readiness Checklist for Installation, page 4-3. To work around this problem, reset the server date/time settings. 
 
     [bookmark: pgfId-1056379]Q. I was not prompted for the protocol to be used for communication between the server and client. Which protocol is used by default? Do I need to configure this setting manually using any other mode?
 
     [bookmark: pgfId-1056392]HTTPS is used as the communication protocol between the server and client, by default, when you install the client during the server installation. Because the communication is secure with the default protocol, you might not need to modify this setting manually. 
 
     [bookmark: pgfId-1056488]An option to select HTTP as the protocol is available only when you run the client installer to install Security Manager client separately outside of the server installer. However, we recommend that you do not use HTTP as the communication protocol between the server and client. The client must use whatever protocol the server is configured to use.
 
     [bookmark: pgfId-1079422]Q. I am using a VMware setup, and system performance is unacceptably slow, for example, system backup takes two hours.
 
     [bookmark: pgfId-1079423]Ensure that you allocate two or more CPUs to the VM running Security Manager. Systems allocating one CPU have been found to have unacceptable performance for some system activities. 
 
     [bookmark: pgfId-1085413]Q. Validation and some other operations fail with SQL query exception in logs. What happened? 
 
     [bookmark: pgfId-1085421]It is possible that the Sybase temp directory ran out of disk space and, therefore, Sybase failed to create temp files. By default, Sybase creates temp files under the Windows temp directory. If the system variable SA_TMP is defined, then temp files are created in the directory specified by SA_TMP. Clear the disk space where the Sybase temp directory is located and then restart Security Manager. 
 
    
 
     
      [bookmark: pgfId-1048619][bookmark: 68479]Server Problems During Uninstallation[bookmark: marker-1082635]
 
     [bookmark: pgfId-1038599]Q. [bookmark: marker-1038597][bookmark: 38781]What does this uninstallation error message mean? 
 
     [bookmark: pgfId-1034987]Uninstallation error messages and explanations appear in Table A-4, where they are sorted alphabetically by their first word. For additional information about uninstallation error messages, see the Common Services documentation in your installation of Security Manager.
 
     [bookmark: pgfId-1027631]
 
      
       
        
        [bookmark: pgfId-1044298]Table A-4 [bookmark: 36446]Uninstallation Error Messages 
 
        
        
         
         	 
           
           [bookmark: pgfId-1044304]Message 
          
  
         	 
           
           [bookmark: pgfId-1044306]Reason for Message 
          
  
         	 
           
           [bookmark: pgfId-1044308]User Action 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1044310]C:\ 
            NMSROOT \MDC\msfc-backend refers to a location that is unavailable. It could be on a hard drive on this computer, or on a network. Check to make sure that the disk is properly inserted, or that you are connected to the Internet or your network, and then try again. If it still cannot be located, the information might have been moved to a different location. 
          
  
         	[bookmark: pgfId-1069425]The message might be benign, and clicking OK to dismiss it might be all that is required. Otherwise, the message might appear on servers where either or both of the following conditions apply: 
 [bookmark: pgfId-1069426]- Simple file sharing is enabled in Windows.
 [bookmark: pgfId-1044313]- Offline file synchronization is enabled in Windows.
  
         	[bookmark: pgfId-1044315]If you dismiss the message and the uninstallation fails, try either or both of these possible workarounds, then try again to uninstall:
 [bookmark: pgfId-1044316]Simple File Sharing
 [bookmark: pgfId-1044317] 1. Select Start > Settings > Control Panel > Folder Options.
 [bookmark: pgfId-1044318] 2. Click the View tab. 
 [bookmark: pgfId-1044319] 3. Scroll to the bottom of the Advanced Settings pane.
 [bookmark: pgfId-1044320] 4. Uncheck the Use simple file sharing (Recommended) check box, then click OK.
 [bookmark: pgfId-1044321]Offline File Synchronization
 [bookmark: pgfId-1044322] 1. Select Start > Settings > Control Panel > Folder Options.
 [bookmark: pgfId-1044323] 2. Click the Offline Files tab. 
 [bookmark: pgfId-1044324] 3. Uncheck the Enable Offline Files check box, then click OK.
  
        
 
         
         	 
           
           [bookmark: pgfId-1044326]C:\temp\< 
            subdirectory >\ 
           
 setup.exe - Access is denied. 
          
 
           
           [bookmark: pgfId-1044327] 
          
 
           
           [bookmark: pgfId-1044328]The process cannot access the file because it is being used by another process. 
          
 
           
           [bookmark: pgfId-1044329] 
          
 
           
           [bookmark: pgfId-1044330]0 file(s) copied. 
           
 1 file(s) copied. 
          
  
         	[bookmark: pgfId-1044332]Uninstallation failed.
  
         	[bookmark: pgfId-1044334]Reboot the server, then complete the procedure described in Uninstalling Server Applications, page 5-19.
  
        
 
         
         	 
           
           [bookmark: pgfId-1044339]Windows Management Instrumentation (WMI) is running. 
          
 
           
           [bookmark: pgfId-1044340] 
          
 
           
           [bookmark: pgfId-1044341]The setup program has detected Windows Management Instrumentation (WMI) services running. This will lock some Cisco Security Manager processes and may abort uninstallation abruptly. To avoid this, uninstallation will stop and start the WMI services. 
          
 
           
           [bookmark: pgfId-1044342] 
          
 
           
           [bookmark: pgfId-1044343]Do you want to proceed? 
          
 
           
           [bookmark: pgfId-1044344] 
          
 
           
           [bookmark: pgfId-1044345]Click Yes to proceed with this uninstallation. Click No to exit uninstallation. 
          
  
         	[bookmark: pgfId-1044347]Either your organization uses WMI or someone enabled the WMI service accidentally on your server.
  
         	[bookmark: pgfId-1044349]Click Yes.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1027634]Q. [bookmark: marker-1027632][bookmark: 19873]What should I do if the uninstaller hangs? 
 
     [bookmark: pgfId-1027635]Reboot, then try again.
 
     [bookmark: pgfId-1033625]Q. What should I do if the uninstaller displays a message to say that the crmdmgtd service is not responding and asks “Do you want to keep waiting?”
 
     [bookmark: pgfId-1033676]The uninstallation script includes an instruction to stop the crmdmgtd service, which did not respond to that instruction before the script timed out. Click Yes. In most cases, the crmdmgtd service then stops as expected.
 
    
 
   
 
    
     [bookmark: pgfId-1022812][bookmark: 50872]Troubleshooting the Security Manager Client
 
    [bookmark: pgfId-1049187]This section answers questions that you might have about:
 
     
     	 [bookmark: pgfId-1049198]Client Problems During Installation
 
     	 [bookmark: pgfId-1049206]Client Problems After Installation
 
    
 
     
      [bookmark: pgfId-1049191][bookmark: 36049]Client Problems During Installation[bookmark: marker-1082644]
 
     [bookmark: pgfId-1026870]Q. [bookmark: marker-1026560]When I install the client software, what does this installation error message mean?
 
     [bookmark: pgfId-1022818]Client software installation error messages and explanations appear in Table A-5, where they are sorted alphabetically by their first word.
 
     [bookmark: pgfId-1022823]
 
      
       
        
        [bookmark: pgfId-1022831]Table A-5 [bookmark: 45136]Installation Error Messages (Client) 
 
        
        
         
         	 
           
           [bookmark: pgfId-1022837]Message 
          
  
         	 
           
           [bookmark: pgfId-1022839]Reason for Message 
          
  
         	 
           
           [bookmark: pgfId-1022841]User Action 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1046865] 
            Could not install engine jar 
          
  
         	[bookmark: pgfId-1046867]Previous software installations and uninstallations caused InstallShield to run incorrectly.
  
         	[bookmark: pgfId-1046869] 1. Navigate to: 
C:\Program Files (x86)\
Common Files\
InstallShield\Universal\
common\Gen1.
 [bookmark: pgfId-1046870] 2. Rename the Gen1 folder, then try again to install Security Manager Client.
 [bookmark: pgfId-1046871]If Gen1 is not present, rename common instead.
  
        
 
         
         	 
           
           [bookmark: pgfId-1042656]Error - Cannot Connect to Server 
          
 
           
           [bookmark: pgfId-1042677] 
          
 
           
           [bookmark: pgfId-1042697]The client cannot connect to the server. This can be caused by one of the following reasons: 
          
 
           
           [bookmark: pgfId-1042730]The server name is incorrect. 
          
 
           
           [bookmark: pgfId-1042889]The protocol (http, https) is incorrect. 
          
 
           
           [bookmark: pgfId-1042946]The server is not running. 
          
 
           
           [bookmark: pgfId-1042955]Network access issues. Please confirm that the server name and protocol are correct. 
          
 
           
           [bookmark: pgfId-1080217]The server is running and you are not experiencing network connectivity issues by loading the CS Manager home page in your browser. 
          
  
         	[bookmark: pgfId-1042658]Most likely, the server is misconfigured for HTTPS traffic.
  
         	[bookmark: pgfId-1042660] 1. From a browser, log in to the Cisco Security Management Suite desktop at https://<server>/CSCOnm/servlet/login/login.jsp.
 [bookmark: pgfId-1043070] 2. Click Server Administration.
 [bookmark: pgfId-1044822] 3. In the Admin window, select Server > Security.
 [bookmark: pgfId-1044879] 4. From the TOC, select Single Server Management > Browser-Server Security Mode Setup, then confirm that the Enable radio button is selected.
 [bookmark: pgfId-1045153]If the radio button is not selected, select it now, then click Apply.
 [bookmark: pgfId-1044939] 5. When prompted, restart the Cisco Security Manager Daemon Manager.
 [bookmark: pgfId-1045346] 6. Wait 5 minutes, then try again to use Security Manager Client.
 [bookmark: pgfId-1045434]If you still cannot connect, consider the other possible problems that the error message describes.
  
        
 
         
         	 
           
           [bookmark: pgfId-1056358]Error - Cisco Security Agent Running 
          
 
           
           [bookmark: pgfId-1056207] 
          
 
           
           [bookmark: pgfId-1056200]Installation cannot proceed while the Cisco Security Agent is running 
          
 
           
           [bookmark: pgfId-1056208] 
          
 
           
           [bookmark: pgfId-1056201]Do you want to disable the Cisco Security Agent and continue with the installation? 
          
  
         	[bookmark: pgfId-1056197]Cisco Security Agent needs to be stopped during the client installation. 
  
         	 
           
           	 [bookmark: pgfId-1056199]Click  Yes to disable the Cisco Security Agent.
 
           	 [bookmark: pgfId-1056248]Click  No to cancel the operation and stop the Cisco Security Agent manually.
 
           	 [bookmark: pgfId-1056310]Click  Help to access online help for Security Manager client.
 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1056312]Error - Cisco Security Agent not Stopped 
          
 
           
           [bookmark: pgfId-1056321] 
          
 
           
           [bookmark: pgfId-1056324]The installation will be aborted because the Cisco Security Agent could not be stopped. 
          
 
           
           [bookmark: pgfId-1056329] 
          
 
           
           [bookmark: pgfId-1056330]Please attempt to disable Cisco Security Agent before repeating the installation process. 
          
  
         	[bookmark: pgfId-1056314]Security Manager client was unable to stop the Cisco Security Agent. 
  
         	[bookmark: pgfId-1056316]Click OK to close this error message and abort the installation. Manually disable the Cisco Security Agent before retrying the installation.
  
        
 
         
         	 
           
           [bookmark: pgfId-1035082] 
            Error occurred during the installation: null. 
          
  
         	[bookmark: pgfId-1035084]Previous software installations and uninstallations caused InstallShield to run incorrectly.
  
         	[bookmark: pgfId-1080257] 1. Navigate to C:\Program Files (x86)\Common Files\InstallShield\Universal\common\Gen1.
 [bookmark: pgfId-1035087] 2. Rename the Gen1 folder, then try again to install Security Manager Client.
 [bookmark: pgfId-1035118]If Gen1 is not present, rename common instead.
  
        
 
         
         	 
           
           [bookmark: pgfId-1028984] 
            Errors occurred during the installation. 
          
 
           
           	 [bookmark: pgfId-1028985] null 
 
          
  
         	[bookmark: pgfId-1028987]Only a Windows user whose login account has administrative privileges can install Security Manager Client. 
  
         	[bookmark: pgfId-1028989]Log in as a Windows administrator, then try again to install Security Manager Client.
  
        
 
         
         	 
           
           [bookmark: pgfId-1026767] 
            Internet Explorer cannot download CSMClientSetup.exe from  < 
             
            server 
             > 
            . Internet Explorer was not able to open this Internet site. The requested site is either unavailable or cannot be found. Please try again later. 
          
  
         	[bookmark: pgfId-1026769]If the OS on your client system is Windows 2008, its Internet Explorer Enhanced Security default settings might stop you from downloading the client software installation utility from your server.
  
         	[bookmark: pgfId-1026771] 1. Select Start > Control Panel > Add or Remove Programs.
 [bookmark: pgfId-1026798] 2. Click Add/Remove Windows Components.
 [bookmark: pgfId-1026803] 3. When the Windows Component Wizard window opens, uncheck the Internet Explorer Enhanced Security Configuration check box, click Next, then click Finish.
  
        
 
         
         	 
           
           [bookmark: pgfId-1039265]Please read the information below. 
          
 
           
           [bookmark: pgfId-1039266] 
          
 
           
           [bookmark: pgfId-1039267]The following errors were generated: 
          
 
           
           [bookmark: pgfId-1039268] 
          
 
           
           	 [bookmark: pgfId-1039269] WARNING: The <  drive  > partition has insufficient space to install the items selected. 
 
          
  
         	[bookmark: pgfId-1039271]You tried to install Security Manager Client on a drive or partition that does not have enough free space.
  
         	[bookmark: pgfId-1039273]Click Back, then select a different location in which to install Security Manager Client.
  
        
 
         
         	 
           
           [bookmark: pgfId-1029559] 
            Unable to Get Data 
          
 
           
           [bookmark: pgfId-1030905] 
          
 
           
           [bookmark: pgfId-1029800] 
            A database failure prevented successful completion of this operation.  
          
  
         	[bookmark: pgfId-1029789]You tried to use the client to connect to the server before the server database was completely up and running.
  
         	[bookmark: pgfId-1029563]Wait a few minutes, then try again to log in. If the problem persists, verify that all required services are running.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1035944]Q. [bookmark: marker-1026561][bookmark: 78029]What should I do if the client installer suspends operation (hangs)? 
 
     [bookmark: pgfId-1008091]Try the following. Any one of them might solve the problem:
 
      
      	 [bookmark: pgfId-1033287]If antivirus software is installed on your client system, disable it, then try again to run the installer. 
 
      	 [bookmark: pgfId-1033297]Reboot the client system, then try again to run the installer.
 
      	 [bookmark: pgfId-1033304]Use a browser on the client system to log in to the Security Manager server at  http:// < server_name > :1741 . If you see an error message that says “Forbidden” or “Internal Server Error,” the required Tomcat service is not running. Unless you rebooted your server recently and Tomcat has not had enough time yet to start running, you might have to review server logs or take other steps to investigate why Tomcat is not running.
 
     
 
     [bookmark: pgfId-1075166]Q. The installer says that a previous version of the client is installed and that it will be uninstalled. However, I do not have a previous version of the client installed. Is this a problem?[bookmark: marker-1075310]
 
     [bookmark: pgfId-1075167]During installation or re-installation of the client, the installer might detect a previously installed client, even if no such client exists, and display an incorrect message that it will be uninstalled. This message is displayed because of the presence of certain old registry entries in your system. Although client installation proceeds normally when this message appears, use the Registry Editor to delete the following key to prevent this message from being displayed during subsequent installations: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows\CurrentVersion\Uninstall\Cisco Security Manager Client. (To open the Registry Editor, select Start > Run and enter regedit.) Also, rename the C:\Program Files (x86)\Zero G Registry\.com.zerog.registry.xml file (any name will do).
 
    
 
     
      [bookmark: pgfId-1049207][bookmark: 11433]Client Problems After Installation[bookmark: marker-1082655]
 
     [bookmark: pgfId-1044433]Q. Why does the interface not look right?
 
     [bookmark: pgfId-1076984]An older video (graphics) card might fail to display the Security Manager GUI correctly until you upgrade its driver software. To test whether this problem might affect your client system, right-click My Computer, select Properties, select Hardware, click Device Manager, then expand the Display adapters entry. Double-click the entry for your adapter to learn what driver version it uses. You can then do one of the following: 
 
     [bookmark: pgfId-1076985] – If your client system uses an ATI MOBILITY FireGL video card, you might have to obtain a video driver other than the driver that came with your card. The driver that you use must be one that allows you to configure Direct 3D settings manually. Any driver lacking that capability might stop your client system from displaying elements in the Security Manager GUI. 
 
     [bookmark: pgfId-1076986] – For any video card, go to the web sites of the PC manufacturer and the card manufacturer to check for incompatibilities with the display of modern Java2 graphics libraries. In most cases where a known incompatibility exists, at least one of the two manufacturers provides a method for obtaining and installing a compatible driver. 
 
     [bookmark: pgfId-1076975]Q. Why is the Security Manager Client missing from the Start menu in my Japanese version of Windows?
 
     [bookmark: pgfId-1044434]You might have configured the regional and language option settings to use English on the client system. We do not support English as the language in any Japanese version of Windows. Use the Control Panel to reset the language to Japanese.
 
     [bookmark: pgfId-1046408]Q. Why is the Security Manager Client missing from the Start menu for some or all the users on a workstation on which it is installed?
 
     [bookmark: pgfId-1075597]When you install the client, you select whether shortcuts will be created for just the user installing the product, for all users, or for no users. If you want to change your election after installation, you can do so manually by copying the Cisco Security Manager Client folder from Documents and Settings\<user>\Start Menu\Programs\Cisco Security Manager to Documents and Settings\All Users\Start Menu\Programs\Cisco Security Manager. If you elected to not create shortcuts, you need to manually create the shortcut in the indicated All Users folder.
 
     [bookmark: pgfId-1075735]Q. What can I do if my connections from a client system to the server seem unusually slow, or if I see DNS errors when I try to log in?
 
     [bookmark: pgfId-1046409]You might have to create an entry for your Security Manager server in the hosts file on your client system. Such an entry can help you to establish connections to your server if it is not registered with the DNS server for your network. To create this helpful entry on your client system, use Notepad or any other plain text editor to open C:\WINDOWS\system32\drivers\etc\hosts. (The host file itself contains detailed instructions for how to add an entry.) 
 
      
       
     
 
     
 
     [bookmark: pgfId-1096252]Note You might have to create an entry for your DNS additional entry which will point to the same IP address (which will be used in the Security Manager client application's “Server Name” field) in the httpd.conf configuration file under NMSROOT~/MDC/Apache/conf/ and restart the Daemon Manager. Such an entry can help you establish connections to your server. Examples: ServerName, foo.example.com. [Tip: The location NMSROOT is the path to the Security Manager installation directory. The default is C:\Program Files (x86)\CSCOpx.]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1046956]Q. What is wrong with my authentication setup if my login credentials are accepted without any error message when I try to log in with Security Manager Client, but the Security Manager desktop is blank and unusable? (Furthermore, does the same problem explain why, in my web browser, Common Services on my Security Manager server accepts my login credentials but then fails to load the Cisco Security Management Suite desktop?)
 
     [bookmark: pgfId-1046959]You did not finish all the required steps for Cisco Secure ACS to provide login authentication services for Security Manager and Common Services. Although you entered login credentials in ACS, you did not define the Security Manager server as a AAA client. You must do so, or you cannot log in. See the ACS documentation for detailed instructions.
 
     [bookmark: pgfId-1031671]Q. What should I do if I cannot use Security Manager Client to log in to the server and a message says...?
 
     [bookmark: pgfId-1055354]
 
      
       
        
         
         	[bookmark: pgfId-1047021]... repeatedly that the server is checking its license.
  
         	[bookmark: pgfId-1047023]Verify that your server meets the minimum hardware and software requirements. See Server Requirements and Recommendations, page 3-4.
  
        
 
         
         	 
           
           [bookmark: pgfId-1047035]Synchronizing with DCR. 
          
  
         	[bookmark: pgfId-1047037]There are two possible explanations:
 
           
           	 [bookmark: pgfId-1047038]You started Security Manager Client shortly after your server restarted. If so, allow a few more minutes for the server to become fully available, then try again to use Security Manager Client.
 
           	 [bookmark: pgfId-1047039]Your CiscoWorks administrative password contains special characters, such as ampersands (&). As a result, the Security Manager installation failed to create a comUser.dat file in the  NMSROOT \lib\classpath subdirectory on your server, where  NMSROOT is the directory in which you installed Common Services (the default is C:\Program Files (x86)\CSCOpx): 
 
          
 [bookmark: pgfId-1047040] a. Either contact Cisco TAC for assistance in replacing comUser.dat or re-install Security Manager. 
 [bookmark: pgfId-1047041] b. Create a Common Services password that does not use special characters.
  
        
 
         
         	 
           
           [bookmark: pgfId-1055704]Error - Unable to Check License on Server. 
          
 
           
           [bookmark: pgfId-1047044] 
          
 
           
           [bookmark: pgfId-1047045]An attempt to check the license file on the Security Manager server has failed. 
          
 
           
           [bookmark: pgfId-1047046] 
          
 
           
           [bookmark: pgfId-1047047]Please confirm that the server is running. If the server is running, please contact the Cisco Technical Assistance Center. 
          
  
         	[bookmark: pgfId-1047051]At least one of the following services did not start correctly. On the server, select Start > Programs > Administrative Tools > Services, right-click each service named below, then select Restart from the shortcut menu:
 
           
           	 [bookmark: pgfId-1047052]Cisco Security Manager Daemon Manager
 
           	 [bookmark: pgfId-1047053]Cisco Security Manager database engine
 
           	 [bookmark: pgfId-1047054]Cisco Security Manager Tomcat Servlet Engine
 
           	 [bookmark: pgfId-1047055]Cisco Security Manager VisiBroker Smart Agent
 
           	 [bookmark: pgfId-1047056]Cisco Security Manager Web Engine
 
          
 [bookmark: pgfId-1048107]Wait 5 minutes, then try again to start Security Manager Client.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1052146]Q. Why is the Activity Report not displayed when I use Internet Explorer as my default browser?
 
     [bookmark: pgfId-1052178]This problem occurs because of invalid registry key values or inaccuracies with the location of some of the dll files associated with Internet Explorer. For information on how to work around this problem, refer to the Microsoft Knowledge Base article 281679, which is available at this URL: http://support.microsoft.com/kb/281679/EN-US.
 
     [bookmark: pgfId-1075059]Q. How can I clear the server list from the Server Name field in the Login window?[bookmark: marker-1075058]
 
     [bookmark: pgfId-1075060]Edit csmserver.txt to remove unwanted entries. The file is in the directory in which you installed the Security Manager client. The default location is C:\Program Files (x86)\Cisco Systems\Cisco Security Manager Client.
 
     [bookmark: pgfId-1075062]Q. The Security Manager client did not load because of a version mismatch. What does this mean?[bookmark: marker-1075061]
 
     [bookmark: pgfId-1075063]The Security Manager server version does not match the client version. To fix this, download and install the most recent client installer from the server. 
 
     [bookmark: pgfId-1075065]Q. Where are the client log files located?[bookmark: marker-1075064] 
 
     [bookmark: pgfId-1075066]The client log files are located in C:\Program Files (x86)\Cisco Systems\Cisco Security Manager Client\logs. Each GUI session has its own log file.
 
     [bookmark: pgfId-1075068]Q. How do I know if Security Manager is running in HTTPS mode?[bookmark: marker-1075067]
 
     [bookmark: pgfId-1075069]Do one of the following:
 
      
      	 [bookmark: pgfId-1075070]After you log in to the server using a browser, look at the URL in the address field. If the URL starts with https, Security Manager is running in HTTPS mode. 
 
      	 [bookmark: pgfId-1075071]Go to Common Services > Server > Security > Single Server Management > Browser-Server Security Mode Setup. If you see Current Setting: Enabled, Security Manager is running in HTTPS mode. If the setting is Disabled, use HTTP.
 
      	 [bookmark: pgfId-1079191]When logging in using the client, first try HTTPS mode (check the HTTPS checkbox). If you get the message “Login URL access is forbidden; Please make sure your protocol (HTTP, HTTPS) is correct,” the server is probably running in HTTP mode. Uncheck the HTTPS checkbox and try again.
 
     
 
     [bookmark: pgfId-1075072]Q. How can I enable the Client Debug log level?
 
     [bookmark: pgfId-1075073]In the file client.info, which is located by default in C:\Program Files (x86)\Cisco Systems\Cisco Security Manager Client\jars, modify the DEBUG_LEVEL parameters to include DEBUG_LEVEL=ALL and then restart the Security Manager client. 
 
     [bookmark: pgfId-1075127]Q. When working with a dual-screen setup, certain windows and popup messages always appear on the primary screen, even when the Security Manager client is running on the secondary screen. For example, with the client running on the secondary screen, windows such as the Policy Object Manager always open in the primary screen. Can I fix this?[bookmark: marker-1075163]
 
     [bookmark: pgfId-1075128]This is a known issue with the way dual-screen support is implemented in certain operating systems. We recommend running the Security Manager client on the primary screen. You should launch the client after configuring the dual-screen setup. 
 
     [bookmark: pgfId-1075129]If a window opens on the other screen, you can move it by pressing Alt+spacebar, followed by M; you can then use the arrow keys to move the window.
 
     [bookmark: pgfId-1049290]Q. [bookmark: marker-1049289]I cannot install or uninstall any software on a client system. Why?
 
     [bookmark: pgfId-1049291]If you run an installation and an uninstallation simultaneously on the client system, even if they are for different applications, you corrupt the client system InstallShield database engine and are prevented from installing or uninstalling any software. For more information, log in to your Cisco.com account, then use Bug Toolkit to view CSCsd21722 and CSCsc91430.
 
    
 
   
 
    
     [bookmark: pgfId-1027948][bookmark: 69768]Running a Server Self-Test[bookmark: marker-1082670]
 
    [bookmark: pgfId-1027949]To run a self-test that confirms whether your Security Manager server is operating correctly:
 
    
 
    [bookmark: pgfId-1027950]Step 1 From a system on which Security Manager Client is connected to your Security Manager server, select Tools > Security Manager Administration.
 
    [bookmark: pgfId-1058663]Step 2 In the Administration window, click Server Security, then click any button. A new browser opens, displaying one of the security settings pages in the Common Services GUI, corresponding to the button you clicked.
 
    [bookmark: pgfId-1027954]Step 3 From the Common Services page, select Admin under the Server tab.
 
    [bookmark: pgfId-1027956]Step 4 In the Admin page TOC, click Selftest.
 
    [bookmark: pgfId-1027957]Step 5 Click Create.
 
    [bookmark: pgfId-1027958]Step 6 Click the SelfTest Information at <MM-DD-YYYY HH:MM:SS> link, where:
 
     
      
      	 [bookmark: pgfId-1027959] MM-DD-YYYY is the current month, day, and year.
 
      	 [bookmark: pgfId-1027960] HH:MM:SS is a timestamp that specifies the hour, minute, and second when you clicked Selftest.
 
     
 
    
 
    [bookmark: pgfId-1027961]Step 7 Read the entries in the Server Info page.
 
    [bookmark: pgfId-1027962]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1027965][bookmark: 28161]Collecting Server Troubleshooting Information[bookmark: marker-1082694]
 
    [bookmark: pgfId-1074155]If you are experiencing problems with Security Manager, and you cannot resolve the problem after trying all the recommendations listed in the error message and reviewing this guide for a possible solution, use the Security Manager Diagnostics utility to collect server information. 
 
    [bookmark: pgfId-1034609]The Security Manager Diagnostics utility collects server diagnostic information in a ZIP file, CSMDiagnostics.zip. You overwrite the file with new information each time you run Security Manager Diagnostics, unless you rename the file. The information in your CSMDiagnostics.zip file can help a Cisco technical support engineer to troubleshoot any problems that you might have with Security Manager or its related applications on your server. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1074200]Tip Security Manager also includes an advanced debugging option that collects information about the configuration changes that have been made with the application. To activate this option, select Tools > Security Manager Administration > Debug Options, then check the Capture Discovery/Deployment Debugging Snapshots to File check box. Bear in mind that although the additional information saved to the diagnostics file may aid the troubleshooting effort, the file may contain sensitive information, such as passwords. You should change debugging levels only if the Cisco Technical Assistance Center (TAC) asks you to change them.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1034610]You can run Security Manager Diagnostics in either of two ways.
 
    [bookmark: pgfId-1034453]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1034444]From a Security Manager client system: 
         
  
        	 
          
          [bookmark: pgfId-1034446]From a Security Manager server: 
         
  
       
 
        
        	[bookmark: pgfId-1034448] 1. After you establish a Security Manager Client session to your server, click Tools > Security Manager Diagnostics, then click OK.
 [bookmark: pgfId-1034594]The CSMDiagnostics.zip file is saved on your server in the NMSROOT\MDC\etc\ directory, where NMSROOT is the directory in which you installed Common Services (C:\Program Files (x86)\CSCOpx, for example). 
 [bookmark: pgfId-1034529] 2. Click Close. 
 [bookmark: pgfId-1074272]Note We recommend that you rename this file so it does not get overwritten each time you run this utility.
  
        	[bookmark: pgfId-1034451] 1. Open a Windows command window, for example, by selecting Start > Run, then enter command.
 [bookmark: pgfId-1034452] 2. Enter C:\Program Files (x86)\CSCOpx\MDC\
bin\CSMDiagnostics. Alternatively, to save the ZIP file in a different location than NMSROOT\MDC\etc\, enter CSMDiagnostics drive:\path. For example, CSMDiagnostics D:\temp.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1010548][bookmark: 39824]Viewing and Changing Server Process Status[bookmark: marker-1082718]
 
    [bookmark: pgfId-1014304]To verify that the server processes for Security Manager are running correctly: 
 
    
 
    [bookmark: pgfId-1016931]Step 1 From the CiscoWorks home page, select Common Services > Server > Admin.
 
    [bookmark: pgfId-1020741]Step 2 In the Admin page TOC, click Processes.
 
    [bookmark: pgfId-1020766]The Process Management table lists all server processes. Entries in the ProcessState column indicate whether a process is running normally.
 
    [bookmark: pgfId-1013826]Step 3 If a required process is not running, restart it. See Restarting All Processes on Your Server.
 
     
      
    
 
    
 
    [bookmark: pgfId-1017040]Note Only users with local administrator privileges can start and stop the server processes. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1017073]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1007773][bookmark: 29458]Restarting All Processes on Your Server[bookmark: marker-1082736]
 
     
      
    
 
    
 
    [bookmark: pgfId-1014337]Note You must stop all processes, then restart them all, or this method does not work. 
 
     
     
 
    
 
    
 
    
 
    [bookmark: pgfId-1008237]Step 1 At the command prompt, enter net stop crmdmgtd to stop all processes. 
 
    [bookmark: pgfId-1020940]Step 2 Enter net start crmdmgtd to restart all processes.
 
     
      
    
 
    
 
    [bookmark: pgfId-1029103]Tip Alternatively, you can select Start > Settings > Control Panel > Administrative Tools > Services, then restart Cisco Security Manager Daemon Manager.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1020941]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1008320][bookmark: 66545]Reviewing the Server Installation Log File[bookmark: marker-1082749]
 
    [bookmark: pgfId-1024642]If responses from the server differ from the responses that you expect, you can review error and warning messages in the server installation log file. 
 
    [bookmark: pgfId-1094502]Use a text editor to open Cisco_Prime_install_*.log. 
 
    [bookmark: pgfId-1024779]In most cases, the log file to review is the one that has either the highest number appended to its filename or has the most recent creation date.
 
    [bookmark: pgfId-1024737]For example, you might see log file error and warning entries that say:
 
     
     [bookmark: pgfId-1024738]ERROR: Cannot Open C:\PROGRA~1\CSCOpx/lib/classpath/ssl.properties at C:\PROGRA~1\CSCOpx\MDC\Apache\ConfigSSL.pl line 259. 
    
 
     
     [bookmark: pgfId-1024739]INFO: Enabling SSL.... 
    
 
     
     [bookmark: pgfId-1024740]WARNING: Unable to enable SSL. Please try later.... 
    
 
     
     [bookmark: pgfId-1094661] 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1094664]Note In the event of a severe problem, you can send the log file to Cisco TAC. See Obtain Documentation and Submit a Service Request, page xi.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1094667][bookmark: 84690]Symantec Co-existence Issues
 
    [bookmark: pgfId-1089696]If you are using Symantec Antivirus Corporate Edition 10.1.5.5000 and Security Manager on the same system and observe any issues during Security Manager startup, follow this procedure: 
 
    [bookmark: pgfId-1089697]Procedure 
 
    
 
    [bookmark: pgfId-1089698]Step 1 Disable Symantec Antivirus services completely. 
 
    [bookmark: pgfId-1089699]Step 2 Restart Security Manager services. (See Restarting All Processes on Your Server.) 
 
    [bookmark: pgfId-1089693]Step 3 Restart the set of Symantec services (Symantec Antivirus, Symantec Antivirus Definition Watcher, Symantec Settings Manager, and Symantec Event Manager) in such a way that Symantec Event Manager is started last.
 
    [bookmark: pgfId-1089706]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1090033][bookmark: 85886]Problems after Installing Windows Updates
 
    [bookmark: pgfId-1090037]Problems can occur with the Security Manager Daemon Manager after installing Microsoft Windows updates. The reason is that installing Windows updates may update *.dll files that affect the functionality of Common Services and other applications that depend on them. 
 
    [bookmark: pgfId-1090048]This problem can be recognized by the following symptoms: After a Windows update, Security Manager will start all processes; however, Security Manager will be unreachable over HTTPS and therefore from the Security Manager client, which uses HTTPS. 
 
    [bookmark: pgfId-1090061]This problem occurs because Common Services relies on files and associations within Windows. These files can be altered to correct vulnerabilities and protect Windows from exploits. However, as an unintended side effect, these changes can cause the Security Manager server to act abnormally when it is restarted. 
 
    [bookmark: pgfId-1090076]This problem can occur any time that Windows Update, or any other application, makes changes to Windows that affect *.dll files, executables, startup processes, Windows components, or partition sizes. 
 
    [bookmark: pgfId-1090082]To resolve this problem in cases where changes in Windows have been made and Security Manager acts abnormally when it is restarted, Security Manager must be re-installed. 
 
    [bookmark: pgfId-1090086]Cisco recommends backing up your Security Manager server regularly. In particular, if regular backups have not been made, or if many changes have been made to your Security Manager installation, you should back up your Security Manager server before running Windows Update or any other installer package. 
 
   
 
    
     [bookmark: pgfId-1090370][bookmark: 29057]Problem Connecting to an ASA Device with Higher Encryption
 
    [bookmark: pgfId-1090393]This troubleshooting topic may help you if you are unable to add and discover an ASA device with higher encryption. In particular, if you want to use AES-256, you must download and install the Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files. Security Manager does not include this extension, but it does support it. 
 
    [bookmark: pgfId-1090394]Problem The problem occurs when the certificate contains a key longer than 1024 bits. The cryptography strength limitations placed by the default policy files included with Java Runtime Environment (JRE) give the highest strength cryptography algorithms and key lengths which are allowed for import to all countries. 
 
    [bookmark: pgfId-1090381]Solution If your country does not place restrictions on the import of cryptography, you can download the unlimited strength policy files: 
 
    
 
    [bookmark: pgfId-1090419]Step 1 Go to http://java.sun.com/javase/downloads/index.jsp. 
 
    [bookmark: pgfId-1090413]Step 2 Download the “Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files 6.” 
 
    [bookmark: pgfId-1090432]Step 3 Follow the instructions in the README.txt file in the downloaded package. 
 
    [bookmark: pgfId-1091828]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1091788][bookmark: 86506]Pop-up Showing Activation.jar in Use During the Time of Installation 
 
    [bookmark: pgfId-1091803]This troubleshooting topic may help you if, during installation, a pop-up window appears with the message “Activation.jar being used by some other service.” 
 
     
      
    
 
    
 
    [bookmark: pgfId-1091809]Tip This problem is extremely rare. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1091842]Before You Begin
 
    [bookmark: pgfId-1092159]Any anti-virus or monitoring agent process in the server should be shut down before the installation. For more information, refer to Readiness Checklist for Installation. 
 
    [bookmark: pgfId-1092168]Problem 
 
    [bookmark: pgfId-1092178]A pop-up window appears with the message “Activation.jar being used by some other service.” 
 
    [bookmark: pgfId-1092169]Solution 
 
    [bookmark: pgfId-1092179]Use the following procedure. 
 
    
 
    [bookmark: pgfId-1092170]Step 1 Click OK on the pop-up and complete the installation. 
 
    [bookmark: pgfId-1092047]Step 2 Uninstall Security Manager and restart the server. 
 
    [bookmark: pgfId-1091874]Step 3 Install Security Manager again. 
 
    [bookmark: pgfId-1091875]Step 4 Immediately after the start of the installation, enter “services.msc” at a command prompt and press Enter. 
 
    [bookmark: pgfId-1091876]Step 5 When the Services menu opens, keep refreshing it until “Cisco Security Manager Daemon Manager” appears. 
 
    [bookmark: pgfId-1091877]Step 6 Right-click CSM Daemon Manager > Properties > Startup type and then click Disabled. 
 
    [bookmark: pgfId-1092014]Step 7 Right-click CWCS syslog service > Properties > Startup type and click Disabled. 
 
    [bookmark: pgfId-1094035]Step 8 After the installation is complete, and at the time of server restart, change the startup type of both of the above services from “Disabled” to “Automatic” mode. 
 
    [bookmark: pgfId-1094036]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1094053][bookmark: 56302]How to Set the Locale for the Windows Default User Template to U.S. English 
 
    [bookmark: pgfId-1094108]If you normally use a non-U.S. English Windows locale, you must change the default system locale to U.S. English before installing Security Manager; changing the default system locale and rebooting the server does not change the default profile. It is not sufficient for the current user only to have the proper settings; this is because Security Manager creates a new account (“casuser”) that runs all Security Manager server processes. 
 
    [bookmark: pgfId-1094109]This section explains how to configure region and language settings on the Security Manager server, especially if you normally use a non-U.S. English Windows locale. The specific details apply to Microsoft Windows Server 2008 R2 with SP1 Enterprise—64-bit, but they are very similar for the other supported server operating systems, namely the following ones: 
 
     
     	 [bookmark: pgfId-1096508]Microsoft Windows Server 2012 Standard—64-bit 
 
     	 [bookmark: pgfId-1096496]Microsoft Windows Server 2012 Datacenter—64-bit 
 
    
 
    [bookmark: pgfId-1094079]To ensure that all newly created users have the same settings as the current user, you need to copy the settings for the current user to new user accounts. This can be done as shown below. 
 
    [bookmark: pgfId-1094171]Ensure that the current user has proper U.S. English locale settingsin the Region and Language dialog box. (The navigation path to this dialog box is Start > Control Panel > Region and Language.)
 
    [bookmark: pgfId-1094172]Figure A-1 Windows Region and Language dialog box
 
    [bookmark: pgfId-1094176]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1094141]
 
    [bookmark: pgfId-1094397]Click the Administrative tab. Find the Copy Settings... button.
 
    [bookmark: pgfId-1094412]Figure A-2 Administrative tab
 
    [bookmark: pgfId-1094406]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1094420]Click the Copy settings... button. The Welcome screen and new user account settings dialog box will appear. 
 
    [bookmark: pgfId-1094425]Under “Copy your current settings to:” check the “New user accounts” box. This will ensure that all newly created users have the same configuration as the current settings. 
 
    [bookmark: pgfId-1094426]Finally, install (or re-install) Cisco Security Manager server. In the new installation, the new account (“casuser”) that runs all Security Manager server processes will have a U.S. English default profile. 
 
   
 
    
     [bookmark: pgfId-1113497][bookmark: 39925]How to disable the RMI Registry Port
 
    [bookmark: pgfId-1113498]In a typical CSM configuration the RMI registry port is open by default. You may need to disable this in a typical CSM configuration. Follow the steps below, to disable the RMI Registry Port:
 
    [bookmark: pgfId-1113499]Problem 
 
    [bookmark: pgfId-1113500]Disable the RMI Registry Port
 
    [bookmark: pgfId-1113501]Solution 
 
    [bookmark: pgfId-1113502]Use the following procedure. 
 
    
 
    [bookmark: pgfId-1113503]Step 1 Stop Cisco Security Manager Server. 
 
    [bookmark: pgfId-1113504]Step 2 Export the ESS registry entry from the following Windows registry path in CSM Server.
 
    [bookmark: pgfId-1113505]HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Cisco\Resource Manager\CurrentVersion\Daemons\ESS 
 
     
      
    
 
    
 
    [bookmark: pgfId-1113506]Note This is recommended, to create a backup. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1113507]Step 3 Run the ESS_Reg_Edit.bat file. This file is available in Bug Search Kit (Attached in the defect CSCvc21327). The file will update the ESS registry entry by removing the JMX remote monitoring parameter in the Arguments Key. 
 
    [bookmark: pgfId-1113508]Step 4 Locate the activemq.xml file at this location ~CSCOpx\objects\ess\conf\activemq.xml
 
    [bookmark: pgfId-1113509]Step 5 Modify the "createConnector" value as false as follows:
 
    [bookmark: pgfId-1113510] <managementContext>
 
    [bookmark: pgfId-1113511] <managementContext createConnector="false"/>
 
    [bookmark: pgfId-1113512] </managementContext> 
 
    [bookmark: pgfId-1113513]Step 6 Save activemq.xml. 
 
    [bookmark: pgfId-1113514]Step 7 Restart Cisco Security Manager.
 
    [bookmark: pgfId-1113515]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1113493]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1073331][bookmark: 63145]Permissions Matrix for Image Manager[bookmark: marker-1082577] 
      
      
 
     
 
 
    [bookmark: pgfId-1088309]The RBAC (role-based access control) permissions matrix for Image Manager is shown in the following series of tables: 
 
     
     	 [bookmark: pgfId-1073556] Table B-1 ,  Other Actions  
 
     	 [bookmark: pgfId-1076081] Table B-2 ,  Image View  
 
     	 [bookmark: pgfId-1075409] Table B-3 ,  Bundles View  
 
     	 [bookmark: pgfId-1075421] Table B-4 ,  Device View  
 
     	 [bookmark: pgfId-1073564] Table B-5 ,  Jobs View  
 
    
 
    [bookmark: pgfId-1091880]More information on Image Manager and the views, actions, and permissions shown in these tables can be found in the User Guide for Cisco Security Manager 4.9 at the following URL: 
 
     
      
       
       
       
        
        	[bookmark: pgfId-1090661]YES
  
        	[bookmark: pgfId-1090663]NO
  
        	[bookmark: pgfId-1090665]NO
  
        	[bookmark: pgfId-1090667]NO
  
        	[bookmark: pgfId-1090669]NO
  
       
 
        
        	[bookmark: pgfId-1090671]View Admin
  
        	[bookmark: pgfId-1090673]NO
  
        	[bookmark: pgfId-1090675]YES
  
        	[bookmark: pgfId-1090677]NO
  
        	[bookmark: pgfId-1090679]NO
  
        	[bookmark: pgfId-1090681]NO
  
       
 
        
        	[bookmark: pgfId-1090683]View Devices
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        	[bookmark: pgfId-1090695]ViewConfig Archive
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        	[bookmark: pgfId-1090701]NO
  
        	[bookmark: pgfId-1090703]YES
  
        	[bookmark: pgfId-1090705]NO
  
       
 
        
        	[bookmark: pgfId-1090707]Modify Devices
  
        	[bookmark: pgfId-1090709]NO
  
        	[bookmark: pgfId-1090711]NO
  
        	[bookmark: pgfId-1090713]NO
  
        	[bookmark: pgfId-1090715]NO
  
        	[bookmark: pgfId-1090717]NO
  
       
 
        
        	[bookmark: pgfId-1090719]Modify Img Mgr Repository
  
        	[bookmark: pgfId-1090721]NO
  
        	[bookmark: pgfId-1090723]NO
  
        	[bookmark: pgfId-1090725]NO
  
        	[bookmark: pgfId-1090727]NO
  
        	[bookmark: pgfId-1090729]NO
  
       
 
        
        	[bookmark: pgfId-1090731]Modify admin
  
        	[bookmark: pgfId-1090733]NO
  
        	[bookmark: pgfId-1090735]NO
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        	[bookmark: pgfId-1090741]NO
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        	[bookmark: pgfId-1090745]NO
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        	[bookmark: pgfId-1090749]NO
  
        	[bookmark: pgfId-1090751]NO
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        	[bookmark: pgfId-1090767]Approve (WF) ?
  
        	[bookmark: pgfId-1090769]NO
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        	[bookmark: pgfId-1090773]NO
  
        	[bookmark: pgfId-1090775]NO
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             	[bookmark: pgfId-1090840]NO
  
             	[bookmark: pgfId-1090842]YES
  
             	[bookmark: pgfId-1092163]NO
  
             	[bookmark: pgfId-1092165]NO
  
             	[bookmark: pgfId-1092167]NO
  
             	[bookmark: pgfId-1092169]YES
  
            
 
             
             	[bookmark: pgfId-1090844]View Admin
  
             	[bookmark: pgfId-1090846]NO
  
             	[bookmark: pgfId-1090848]NO
  
             	[bookmark: pgfId-1090850]NO
  
             	[bookmark: pgfId-1090852]NO
  
             	[bookmark: pgfId-1090854]NO
  
             	[bookmark: pgfId-1092171]NO
  
             	[bookmark: pgfId-1092173]NO
  
             	[bookmark: pgfId-1092175]NO
  
             	[bookmark: pgfId-1092177]NO
  
            
 
             
             	[bookmark: pgfId-1090856]View Devices
  
             	[bookmark: pgfId-1090858]NO
  
             	[bookmark: pgfId-1090860]NO
  
             	[bookmark: pgfId-1090862]NO
  
             	[bookmark: pgfId-1090864]NO
  
             	[bookmark: pgfId-1090866]NO
  
             	[bookmark: pgfId-1092179]NO
  
             	[bookmark: pgfId-1092181]NO
  
             	[bookmark: pgfId-1092183]NO
  
             	[bookmark: pgfId-1092185]NO
  
            
 
             
             	[bookmark: pgfId-1090868]ViewConfig Archive
  
             	[bookmark: pgfId-1090870]NO
  
             	[bookmark: pgfId-1090872]NO
  
             	[bookmark: pgfId-1090874]NO
  
             	[bookmark: pgfId-1090876]NO
  
             	[bookmark: pgfId-1090878]NO
  
             	[bookmark: pgfId-1092187]NO
  
             	[bookmark: pgfId-1092189]NO
  
             	[bookmark: pgfId-1092191]NO
  
             	[bookmark: pgfId-1092193]NO
  
            
 
             
             	[bookmark: pgfId-1090880]Modify Devices
  
             	[bookmark: pgfId-1090882]NO
  
             	[bookmark: pgfId-1090884]NO
  
             	[bookmark: pgfId-1090886]NO
  
             	[bookmark: pgfId-1090888]YES
  
             	[bookmark: pgfId-1090890]NO
  
             	[bookmark: pgfId-1092195]NO
  
             	[bookmark: pgfId-1092197]NO
  
             	[bookmark: pgfId-1092199]NO
  
             	[bookmark: pgfId-1092201]NO
  
            
 
             
             	[bookmark: pgfId-1090892]Modify Img Mgr Repository
  
             	[bookmark: pgfId-1090894]YES
  
             	[bookmark: pgfId-1090896]YES
  
             	[bookmark: pgfId-1090898]YES
  
             	[bookmark: pgfId-1090900]NO
  
             	[bookmark: pgfId-1090902]NO
  
             	[bookmark: pgfId-1092203]YES
  
             	[bookmark: pgfId-1092205]YES
  
             	[bookmark: pgfId-1092207]YES
  
             	[bookmark: pgfId-1092209]YES
  
            
 
             
             	[bookmark: pgfId-1090904]Modify admin
  
             	[bookmark: pgfId-1090906]NO
  
             	[bookmark: pgfId-1090908]NO
  
             	[bookmark: pgfId-1090910]NO
  
             	[bookmark: pgfId-1090912]NO
  
             	[bookmark: pgfId-1090914]NO
  
             	[bookmark: pgfId-1092211]NO
  
             	[bookmark: pgfId-1092213]NO
  
             	[bookmark: pgfId-1092215]NO
  
             	[bookmark: pgfId-1092217]NO
  
            
 
             
             	[bookmark: pgfId-1090916]Deploy
  
             	[bookmark: pgfId-1090918]NO
  
             	[bookmark: pgfId-1090920]NO
  
             	[bookmark: pgfId-1090922]NO
  
             	[bookmark: pgfId-1090924]NO
  
             	[bookmark: pgfId-1090926]NO
  
             	[bookmark: pgfId-1092219]NO
  
             	[bookmark: pgfId-1092221]NO
  
             	[bookmark: pgfId-1092223]NO
  
             	[bookmark: pgfId-1092225]NO
  
            
 
             
             	[bookmark: pgfId-1090928]Submit (WF) ?
  
             	[bookmark: pgfId-1090930]NO
  
             	[bookmark: pgfId-1090932]NO
  
             	[bookmark: pgfId-1090934]NO
  
             	[bookmark: pgfId-1090936]NO
  
             	[bookmark: pgfId-1090938]NO
  
             	[bookmark: pgfId-1092227]NO
  
             	[bookmark: pgfId-1092229]NO
  
             	[bookmark: pgfId-1092231]NO
  
             	[bookmark: pgfId-1092233]NO
  
            
 
             
             	[bookmark: pgfId-1090940]Approve (WF) ?
  
             	[bookmark: pgfId-1090942]NO
  
             	[bookmark: pgfId-1090944]NO
  
             	[bookmark: pgfId-1090946]NO
  
             	[bookmark: pgfId-1090948]NO
  
             	[bookmark: pgfId-1090950]NO
  
             	[bookmark: pgfId-1092235]NO
  
             	[bookmark: pgfId-1092237]NO
  
             	[bookmark: pgfId-1092239]NO
  
             	 
               
                
                 
                 
                 
                  
                  	[bookmark: pgfId-1092931]YES
  
                  	[bookmark: pgfId-1092933]YES
  
                  	[bookmark: pgfId-1092935]NO
  
                  	[bookmark: pgfId-1093026]NO
  
                 
 
                  
                  	[bookmark: pgfId-1092937]View Admin
  
                  	[bookmark: pgfId-1092939]NO
  
                  	[bookmark: pgfId-1092941]NO
  
                  	[bookmark: pgfId-1092943]NO
  
                  	[bookmark: pgfId-1093028]NO
  
                 
 
                  
                  	[bookmark: pgfId-1092945]View Devices
  
                  	[bookmark: pgfId-1092947]NO
  
                  	[bookmark: pgfId-1092949]NO
  
                  	[bookmark: pgfId-1092951]NO
  
                  	[bookmark: pgfId-1093030]NO
  
                 
 
                  
                  	[bookmark: pgfId-1092953]ViewConfig Archive
  
                  	[bookmark: pgfId-1092955]NO
  
                  	[bookmark: pgfId-1092957]NO
  
                  	[bookmark: pgfId-1092959]NO
  
                  	[bookmark: pgfId-1093032]NO
  
                 
 
                  
                  	[bookmark: pgfId-1092961]Modify Devices
  
                  	[bookmark: pgfId-1092963]NO
  
                  	[bookmark: pgfId-1092965]NO
  
                  	[bookmark: pgfId-1092967]NO
  
                  	[bookmark: pgfId-1093034]NO
  
                 
 
                  
                  	[bookmark: pgfId-1092969]Modify Img Mgr Repository
  
                  	[bookmark: pgfId-1092971]YES
  
                  	[bookmark: pgfId-1092973]YES
  
                  	[bookmark: pgfId-1092975]YES
  
                  	[bookmark: pgfId-1093036]YES
  
                 
 
                  
                  	[bookmark: pgfId-1092977]Modify admin
  
                  	[bookmark: pgfId-1092979]NO
  
                  	[bookmark: pgfId-1092981]NO
  
                  	[bookmark: pgfId-1092983]NO
  
                  	[bookmark: pgfId-1093038]NO
  
                 
 
                  
                  	[bookmark: pgfId-1092985]Deploy
  
                  	[bookmark: pgfId-1092987]NO
  
                  	[bookmark: pgfId-1092989]NO
  
                  	[bookmark: pgfId-1092991]NO
  
                  	[bookmark: pgfId-1093040]NO
  
                 
 
                  
                  	[bookmark: pgfId-1092993]Submit (WF) ?
  
                  	[bookmark: pgfId-1092995]NO
  
                  	[bookmark: pgfId-1092997]NO
  
                  	[bookmark: pgfId-1092999]NO
  
                  	[bookmark: pgfId-1093042]NO
  
                 
 
                  
                  	[bookmark: pgfId-1093001]Approve (WF) ?
  
                  	[bookmark: pgfId-1093003]NO
  
                  	[bookmark: pgfId-1093005]NO
  
                  	[bookmark: pgfId-1093007]NO
  
                  	 
                    
                     
                      
                      
                      
                       
                       	[bookmark: pgfId-1091204]YES
  
                       	[bookmark: pgfId-1091206]YES
  
                       	[bookmark: pgfId-1091208]YES
  
                       	[bookmark: pgfId-1091210]NO
  
                       	[bookmark: pgfId-1091212]NO
  
                       	[bookmark: pgfId-1093292]NO
  
                       	[bookmark: pgfId-1093294]NO
  
                       	[bookmark: pgfId-1093296]NO
  
                       	[bookmark: pgfId-1093298]YES
  
                      
 
                       
                       	[bookmark: pgfId-1091214]View Admin
  
                       	[bookmark: pgfId-1091216]NO
  
                       	[bookmark: pgfId-1091218]NO
  
                       	[bookmark: pgfId-1091220]NO
  
                       	[bookmark: pgfId-1091222]NO
  
                       	[bookmark: pgfId-1091224]NO
  
                       	[bookmark: pgfId-1093300]NO
  
                       	[bookmark: pgfId-1093302]NO
  
                       	[bookmark: pgfId-1093304]NO
  
                       	[bookmark: pgfId-1093306]NO
  
                      
 
                       
                       	[bookmark: pgfId-1091226]View Devices
  
                       	[bookmark: pgfId-1091228]NO
  
                       	[bookmark: pgfId-1091230]NO
  
                       	[bookmark: pgfId-1091232]NO
  
                       	[bookmark: pgfId-1091234]NO
  
                       	[bookmark: pgfId-1091236]NO
  
                       	[bookmark: pgfId-1093308]NO
  
                       	[bookmark: pgfId-1093310]NO
  
                       	[bookmark: pgfId-1093312]NO
  
                       	[bookmark: pgfId-1093314]NO
  
                      
 
                       
                       	[bookmark: pgfId-1091238]ViewConfig Archive
  
                       	[bookmark: pgfId-1091240]NO
  
                       	[bookmark: pgfId-1091242]NO
  
                       	[bookmark: pgfId-1091244]NO
  
                       	[bookmark: pgfId-1091246]NO
  
                       	[bookmark: pgfId-1091248]NO
  
                       	[bookmark: pgfId-1093316]NO
  
                       	[bookmark: pgfId-1093318]NO
  
                       	[bookmark: pgfId-1093320]NO
  
                       	[bookmark: pgfId-1093322]NO
  
                      
 
                       
                       	[bookmark: pgfId-1091250]Modify Devices
  
                       	[bookmark: pgfId-1091252]NO
  
                       	[bookmark: pgfId-1091254]NO
  
                       	[bookmark: pgfId-1091256]NO
  
                       	[bookmark: pgfId-1091258]YES
  
                       	[bookmark: pgfId-1091260]YES
  
                       	[bookmark: pgfId-1093324]YES
  
                       	[bookmark: pgfId-1093326]YES
  
                       	[bookmark: pgfId-1093328]NO
  
                       	[bookmark: pgfId-1093330]NO
  
                      
 
                       
                       	[bookmark: pgfId-1091262]Modify Img Mgr Repository
  
                       	[bookmark: pgfId-1091264]NO
  
                       	[bookmark: pgfId-1091266]NO
  
                       	[bookmark: pgfId-1091268]NO
  
                       	[bookmark: pgfId-1091270]NO
  
                       	[bookmark: pgfId-1091272]NO
  
                       	[bookmark: pgfId-1093332]NO
  
                       	[bookmark: pgfId-1093334]NO
  
                       	[bookmark: pgfId-1093336]YES
  
                       	[bookmark: pgfId-1093338]NO
  
                      
 
                       
                       	[bookmark: pgfId-1091274]Modify admin
  
                       	[bookmark: pgfId-1091276]NO
  
                       	[bookmark: pgfId-1091278]NO
  
                       	[bookmark: pgfId-1091280]NO
  
                       	[bookmark: pgfId-1091282]NO
  
                       	[bookmark: pgfId-1091284]NO
  
                       	[bookmark: pgfId-1093340]NO
  
                       	[bookmark: pgfId-1093342]NO
  
                       	[bookmark: pgfId-1093344]NO
  
                       	[bookmark: pgfId-1093346]NO
  
                      
 
                       
                       	[bookmark: pgfId-1091286]Deploy
  
                       	[bookmark: pgfId-1091288]NO
  
                       	[bookmark: pgfId-1091290]NO
  
                       	[bookmark: pgfId-1091292]NO
  
                       	[bookmark: pgfId-1091294]NO
  
                       	[bookmark: pgfId-1091296]NO
  
                       	[bookmark: pgfId-1093348]NO
  
                       	[bookmark: pgfId-1093350]NO
  
                       	[bookmark: pgfId-1093352]NO
  
                       	[bookmark: pgfId-1093354]NO
  
                      
 
                       
                       	[bookmark: pgfId-1091298]Submit (WF) ?
  
                       	[bookmark: pgfId-1091300]NO
  
                       	[bookmark: pgfId-1091302]NO
  
                       	[bookmark: pgfId-1091304]NO
  
                       	[bookmark: pgfId-1091306]NO
  
                       	[bookmark: pgfId-1091308]NO
  
                       	[bookmark: pgfId-1093356]NO
  
                       	[bookmark: pgfId-1093358]NO
  
                       	[bookmark: pgfId-1093360]NO
  
                       	[bookmark: pgfId-1093362]NO
  
                      
 
                       
                       	[bookmark: pgfId-1091310]Approve (WF) ?
  
                       	[bookmark: pgfId-1091312]NO
  
                       	[bookmark: pgfId-1091314]NO
  
                       	[bookmark: pgfId-1091316]NO
  
                       	[bookmark: pgfId-1091318]NO
  
                       	[bookmark: pgfId-1091320]NO
  
                       	[bookmark: pgfId-1093364]NO
  
                       	[bookmark: pgfId-1093366]NO
  
                       	[bookmark: pgfId-1093368]NO
  
                       	 
                         
                          
                           
                           
                           
                            
                            	[bookmark: pgfId-1096166]YES
  
                            	[bookmark: pgfId-1096168]YES
  
                            	[bookmark: pgfId-1096170]NO
  
                            	[bookmark: pgfId-1096172]NO
  
                            	[bookmark: pgfId-1096174]NO
  
                            	[bookmark: pgfId-1096176]NO
  
                            	[bookmark: pgfId-1096178]NO
  
                            	[bookmark: pgfId-1096180]NO
  
                            	[bookmark: pgfId-1096182]NO
  
                            	[bookmark: pgfId-1096184]NO
  
                            	[bookmark: pgfId-1096186]NO
  
                           
 
                            
                            	[bookmark: pgfId-1096188]View Admin
  
                            	[bookmark: pgfId-1096190]NO
  
                            	[bookmark: pgfId-1096192]NO
  
                            	[bookmark: pgfId-1096194]NO
  
                            	[bookmark: pgfId-1096196]NO
  
                            	[bookmark: pgfId-1096198]NO
  
                            	[bookmark: pgfId-1096200]NO
  
                            	[bookmark: pgfId-1096202]NO
  
                            	[bookmark: pgfId-1096204]NO
  
                            	[bookmark: pgfId-1096206]NO
  
                            	[bookmark: pgfId-1096208]NO
  
                            	[bookmark: pgfId-1096210]NO
  
                           
 
                            
                            	[bookmark: pgfId-1096212]View Devices
  
                            	[bookmark: pgfId-1096214]NO
  
                            	[bookmark: pgfId-1096216]NO
  
                            	[bookmark: pgfId-1096218]NO
  
                            	[bookmark: pgfId-1096220]NO
  
                            	[bookmark: pgfId-1096222]NO
  
                            	[bookmark: pgfId-1096224]NO
  
                            	[bookmark: pgfId-1096226]NO
  
                            	[bookmark: pgfId-1096228]NO
  
                            	[bookmark: pgfId-1096230]NO
  
                            	[bookmark: pgfId-1096232]NO
  
                            	[bookmark: pgfId-1096234]NO
  
                           
 
                            
                            	[bookmark: pgfId-1096236]ViewConfig Archive
  
                            	[bookmark: pgfId-1096238]NO
  
                            	[bookmark: pgfId-1096240]NO
  
                            	[bookmark: pgfId-1096242]NO
  
                            	[bookmark: pgfId-1096244]NO
  
                            	[bookmark: pgfId-1096246]NO
  
                            	[bookmark: pgfId-1096248]NO
  
                            	[bookmark: pgfId-1096250]NO
  
                            	[bookmark: pgfId-1096252]NO
  
                            	[bookmark: pgfId-1096254]NO
  
                            	[bookmark: pgfId-1096256]NO
  
                            	[bookmark: pgfId-1096258]NO
  
                           
 
                            
                            	[bookmark: pgfId-1096260]Modify Devices
  
                            	[bookmark: pgfId-1096262]NO
  
                            	[bookmark: pgfId-1096264]NO
  
                            	[bookmark: pgfId-1096266]NO
  
                            	[bookmark: pgfId-1096268]NO
  
                            	[bookmark: pgfId-1096270]NO
  
                            	[bookmark: pgfId-1096272]NO
  
                            	[bookmark: pgfId-1096274]NO
  
                            	[bookmark: pgfId-1096276]NO
  
                            	[bookmark: pgfId-1096278]NO
  
                            	[bookmark: pgfId-1096280]NO
  
                            	[bookmark: pgfId-1096282]NO
  
                           
 
                            
                            	[bookmark: pgfId-1096284]Modify Img Mgr Repository
  
                            	[bookmark: pgfId-1096286]NO
  
                            	[bookmark: pgfId-1096288]NO
  
                            	[bookmark: pgfId-1096290]NO
  
                            	[bookmark: pgfId-1096292]NO
  
                            	[bookmark: pgfId-1096294]NO
  
                            	[bookmark: pgfId-1096296]NO
  
                            	[bookmark: pgfId-1096298]NO
  
                            	[bookmark: pgfId-1096300]NO
  
                            	[bookmark: pgfId-1096302]NO
  
                            	[bookmark: pgfId-1096304]NO
  
                            	[bookmark: pgfId-1096306]NO
  
                           
 
                            
                            	[bookmark: pgfId-1096308]Modify admin
  
                            	[bookmark: pgfId-1096310]NO
  
                            	[bookmark: pgfId-1096312]NO
  
                            	[bookmark: pgfId-1096314]NO
  
                            	[bookmark: pgfId-1096316]NO
  
                            	[bookmark: pgfId-1096318]NO
  
                            	[bookmark: pgfId-1096320]NO
  
                            	[bookmark: pgfId-1096322]NO
  
                            	[bookmark: pgfId-1096324]NO
  
                            	[bookmark: pgfId-1096326]NO
  
                            	[bookmark: pgfId-1096328]NO
  
                            	[bookmark: pgfId-1096330]NO
  
                           
 
                            
                            	[bookmark: pgfId-1096332]Deploy
  
                            	[bookmark: pgfId-1096334]NO
  
                            	[bookmark: pgfId-1096336]NO
  
                            	[bookmark: pgfId-1096338]YES
  
                            	[bookmark: pgfId-1096340]YES
  
                            	[bookmark: pgfId-1096342]YES
  
                            	[bookmark: pgfId-1096344]YES
  
                            	[bookmark: pgfId-1096346]YES
  
                            	[bookmark: pgfId-1096348]NO
  
                            	[bookmark: pgfId-1096350]NO
  
                            	[bookmark: pgfId-1096352]NO
  
                            	[bookmark: pgfId-1096354]YES
  
                           
 
                            
                            	[bookmark: pgfId-1096356]Submit (WF) ?
  
                            	[bookmark: pgfId-1096358]NO
  
                            	[bookmark: pgfId-1096360]YES
  
                            	[bookmark: pgfId-1096362]NO
  
                            	[bookmark: pgfId-1096364]NO
  
                            	[bookmark: pgfId-1096366]NO
  
                            	[bookmark: pgfId-1096368]NO
  
                            	[bookmark: pgfId-1096370]NO
  
                            	[bookmark: pgfId-1096372]NO
  
                            	[bookmark: pgfId-1096374]NO
  
                            	[bookmark: pgfId-1096376]YES
  
                            	[bookmark: pgfId-1096378]NO
  
                           
 
                            
                            	[bookmark: pgfId-1096380]Approve (WF) ?
  
                            	[bookmark: pgfId-1096382]NO
  
                            	[bookmark: pgfId-1096384]YES
  
                            	[bookmark: pgfId-1096386]NO
  
                            	[bookmark: pgfId-1096388]NO
  
                            	[bookmark: pgfId-1096390]NO
  
                            	[bookmark: pgfId-1096392]NO
  
                            	[bookmark: pgfId-1096394]NO
  
                            	[bookmark: pgfId-1096396]YES
  
                            	[bookmark: pgfId-1096398]YES
  
                            	[bookmark: pgfId-1096400]NO
  
                            	 
                             
  
                           
 
                           
                         
 
                        
 
                      
 
                      
                    
 
                   
 
                 
 
                 
               
 
              
 
            
 
            
          
 
         
 
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-998796]Installation Guide for Cisco Security Manager 4.9 
 
     
      [bookmark: pgfId-998801]First Published: August 5, 2015
 
    
 
     
      [bookmark: pgfId-998802]
 
    
 
     
      [bookmark: pgfId-998146]THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.
 
    
 
     
      [bookmark: pgfId-997491]THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.
 
    
 
     
      [bookmark: pgfId-997501]The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB’s public domain version of the UNIX operating system. All rights reserved. Copyright  1981, Regents of the University of California. 
 
    
 
     
      [bookmark: pgfId-997502]NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS” WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.
 
    
 
     
      [bookmark: pgfId-997503]IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
 
    
 
     
      [bookmark: pgfId-999240]Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL:  www.cisco.com/go/trademarks . Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1721R)
 
    
 
     
      [bookmark: pgfId-997508]Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.
 
    
 
     
      [bookmark: pgfId-998303] Installation Guide for Cisco Security Manager 4.9 
 
    
 
     
      [bookmark: pgfId-998312] 2015 Cisco Systems, Inc. All rights reserved.
 
    
 
   
 
  
 
  
  
 OPS/servprep-36.jpg





OPS/postinst-4.jpg





OPS/servprep-19.jpg





OPS/postinst-3.jpg





OPS/servprep-28.jpg





OPS/servprep-35.jpg





OPS/servprep-37.jpg





OPS/servprep-29.jpg





OPS/postinst-5.jpg





OPS/postinst-16.jpg





OPS/postinst-2.jpg





OPS/servprep-34.jpg





OPS/servprep-12.jpg





OPS/postinst-6.jpg





OPS/servprep-17.jpg





OPS/servprep-9.jpg





OPS/postinst-7.jpg





OPS/servprep-11.jpg





OPS/cover_page.jpg
Nme
CISCO.

— ey

Installation Guide for Cisco
Security Manager 4.9

WY





OPS/servprep-18.jpg





OPS/postinst-17.jpg





OPS/servprep-23.jpg





OPS/servprep-10.jpg





OPS/servprep-31.jpg





OPS/servprep-6.jpg





OPS/xtrouble-7.jpg





OPS/servprep-15.jpg





OPS/postinst-12.jpg





OPS/servprep-22.jpg





OPS/servprep-7.jpg





OPS/servprep-5.jpg





OPS/servprep-13.jpg





OPS/servprep-16.jpg





OPS/servprep-30.jpg





OPS/servprep-21.jpg





OPS/servprep-8.jpg





OPS/postinst-11.jpg





OPS/servprep-4.jpg





OPS/postinst-15.jpg





OPS/servprep-20.jpg





OPS/servprep-33.jpg





OPS/servprep-26.jpg





OPS/postinst-14.jpg





OPS/servprep-32.jpg





OPS/servprep-27.jpg





OPS/xtrouble-8.jpg
E—

et o

ardcopyy emaioral stinzs otz e core ceen, 5
I S0t a1 A

T

e e st tasesczourt

Lingusge for -on-Unizodspr2ga

3t Gyt o  Sn <l the nguage e whe- i g
e et d ot supzon U coce

Cumsrtiang g o nom Un cose zrograms

Eugls e
5 Sl e e o

s ocse”

o oot |_iobs






OPS/servprep-14.jpg





OPS/postinst-13.jpg





OPS/cover_page.jpg
Nme
CISCO.

— ey

Installation Guide for Cisco
Security Manager 4.9

WY





